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The following NetWare® for SAA* Administrator help topics are available. Click an icon to get
information on that topic.
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 NWSAA Administrator Overview                    

NetWare® for SAA* Administrator lets you configure NetWare for SAA resources. The 
following list of topics is helpful to new users. 
Note: If you are unfamiliar with NetWare for SAA Administrator, read the topics in the order 

they are listed.

What Is NetWare for SAA Administrator? 
NetWare for SAA Administrator Concepts 

NetWare TN3270 and TCP/IP support
AS/400 peer connections support
Data link adapter definitions
Host Connections
Host PU profiles 
Peer Connections
Peer PU profiles
Dependent LU types
Dependent LU categories
Independent LUs
Downstream PUs
User assignment
Hot Standby service
Application Subsystem

View Window 
Dialog Books 
Tasks Required for Configuring Host Connections
Tasks Required for Configuring Peer Connections
Tasks Required for Configuring AS/400 Connections
Tasks You Sometimes Do 



 NWSAA Administrator Menu Commands
Click a command for more information about that command.

 

 

 

Related Topic

NetWare for SAA Administrator Keyboard Shortcuts 



 NWSAA Administrator Keyboard Shortcuts
The following table lists the keyboard shortcuts for each NetWare® for SAA Administrator 
command, indicates which menu you choose each command from, and summarizes each 
command's function. The commands are presented in the order they appear in the menus.

Command Shortcut and Description
Object > Create <Ins> or <Alt+O+C>

Opens the Create Resource dialog box. 
Use that dialog box to create a Host PU 
profile, peer PU profile, data link adapter
definition, downstream PU definition, LU 
pool, Hot Standby configuration, or local 
LU, partner LU, mode, local TP, or 
security alias configurations for the 
Application Subsystem.

Object > Delete <Del> or <Alt+O+D>
Deletes the following resources: Host PU
profiles, peer PU profiles, data link 
adapter definitions, downstream PU 
definitions, LU pools, Hot Standby 
configurations, or security alias 
configurations for the Application 
Subsystem.

Object > Details <Enter> or <Alt+O+T>
Opens a resource's dialog book.

Object > Expand <Alt+O+E>
Displays a resource's underlying 
resources.
You can expand a NetWare for SAA 
server, the Host PU Profiles group, the 
LU Pools group, or the Application 
Subsystem.

Object > Collapse <Alt+O+O>
Hides the underlying resources of a 
NetWare for SAA server, the PU Profiles 
group, the LU Pools group, or the 
Application Subsystem.

Object > Exit <Alt+O+X>
Exits NetWare for SAA Administrator.

Functions > Assign Users <Alt+F+A>
Assigns users to a downstream PU 
available on an Ethernet or token ring 
connection, or to a dedicated LU or LU 
pool.

Functions > Copy PU 
Profile

<Alt+F+C>



Copies an existing    Host PU profile to 
create a new Host PU profile.

Functions > Log In to 
Server

<Alt+F+I>
Displays the Login dialog box, which lets
you log in to a NetWare for SAA server.

Functions > Log Out from 
Server

<Alt+F+O>
Displays a prompt that lets you confirm 
whether you want to log out from a 
NetWare for SAA server.

Window > New Window <Alt+W+N>
Displays a submenu that offers the All 
Servers and Selected Server commands.

Window > New Window > 
All Servers

<Alt+W+N+A>
Opens a new view window listing 
information about all the NetWare for 
SAA servers available on the network.

Window > New Window > 
Selected Server

<Alt+W+N+S>
Opens a new view window listing only 
information about the NetWare for SAA 
server selected in the current view 
window.

Window > Cascade <Alt+W+C>
Arranges all open view windows one in 
front of the other so their titles are 
visible at once.

Window > Tile <Alt+W+T>
Arranges all open view windows in rows 
and columns so they are all visible at 
once.

Window > Arrange Icons <Alt+W+A>
Arranges minimized view windows in the
lower left corner of NetWare for SAA 
Administrator's application window.

Window > Close All <Alt+W+L>
Closes all view windows currently open.

Help > Contents <Alt+H+C>
Opens NetWare for SAA Administrator's 
online help to a display of icons that 
represent the available categories of 
online help.

Help > Using Help <Alt+H+U>
Displays instructions for using online 
help.

Help > About NWSAA <Alt+H+A>



Admin
Displays NetWare for SAA 
Administrator's version number, date, 
and copyright notice.

 NWSAA Administrator Icons
NetWare for SAA Administrator uses icons to represent the resources displayed in a view 
window. Click an icon for more information.

Server Node Resources

 NWSAA server

 Communication Executive

 NWSAA Node

 AS/400 Node
Resource Groups 

 Data Link Adapters

 Host PU Profiles

 Peer PU Profiles 

 LU Pools

 Downstream PUs

 Hot Standby group
Individual Resources

 Data link adapter

 Host PU profile

 Peer PU profile 

 Downstream PU

 LU pool

 Hot Standby

Public Dependent LUs

 Printer LU

 Display LU

 APPC LU

 LU  x  
Dedicated Dependent LUs

 Printer LU

 Assigned to HostPrint

 Display LU

 APPC LU

 LU  x  
Mapped Dependent LUs

 Printer LU

 Display LU

 APPC LU

 LU  x  
Pooled Dependent LUs

 Printer LU

 Display LU



Application Subsystem 

 Application Subsystem 
Application Subsystem Resource 
Groups

 Local LUs 

 Partner LUs 

 Modes 

 Local TPs 

 Security aliases 

 APPC LU

 LU  x  
Application Subsystem Dependent 
LUs

 Dependent LU Assigned to 
Application Subsystem

Application Subsystem resources

 APPC session list    

 Local LU 

 Partner LU 

 Mode 

 Local TP 

 Security alias

Related Topic

View Window 



    NWSAA Administrator Procedures            

Use the following procedures to configure NetWare® for SAA with NetWare for SAA 
Administrator. The basic NetWare for SAA Administrator tasks are listed first. The tasks that 
let you create, edit, limit, or delete resources are listed next. Then the tasks pertaining to 
specific resources are listed. Click a particular procedure for details.
To jump to a particular group of procedures, click here.
Basic Tasks
Browsing Resources 
Collapsing_Resources    
Exiting NWSAA Administrator 
Expanding Resources 
Logging In
Logging Out
Opening Additional View Windows 

Resources (General)
Assigning Users to Resources 

Assigning Users to Resources (under NetWare 3.12)
Assigning Users to Resources (under NetWare 4.1)

Deleting User Assignments 
Creating Resources 
Deleting Resources 
Editing the Configuration of Existing Resources 

Server Nodes    
Configuring the Communication Executive    

Describing the Server 
Configuring Network Management Options 
Selecting Protocol Stack Support 

Configuring the NWSAA Node    
Configuring the NWSAA Node Description 
Configuring NetWare TN3270 Support 

Configuring AS/400 Connections    
Configuring AS/400 System Information

Deleting an AS/400 System Configuration 
Configuring AS/400 Users and Sessions 

Adding AS/400 Users on a NetWare 3.12 Server 



Adding AS/400 Users on a NetWare 4.1 Server
Removing an AS/400 User

Data Link Adapter Definitions    
Configuring Token Ring or Ethernet (802.2) Adapter Definitions 
Configuring Custom Adapter Definitions 
Configuring QLLC Adapter Definitions 
Configuring SDLC Adapter Definitions 

Host PU Profiles    
Configuring Host PU Profiles (Overview) 

Configuring Host PU Profile Description Information 
Configuring Default LU Information 
Making Notes About a Host PU Profile

Copying Host PU Profiles 
Configuring a Host PU Profile in Offline Test Mode

Peer PU Profiles    
Configuring the Default Peer PU Profile
Configuring a Peer PU Profile

Downstream PU Definitions    
Configuring Downstream PU Definitions (Overview) 

Defining Downstream PU Description Information 
Mapping LUs to Downstream LUs 
Unmapping LUs 

Hot Standby    
Configuring a Server for Hot Standby 

LU Pools    
Assigning LUs to an LU Pool 

Adding LUs to an LU Pool with the Select LU Dialog Box 
Dragging LUs to an LU Pool 

Configuring LU Pools
Deleting LUs from an LU Pool 

Dependent LUs          
    
    

Changing a Dependent LU's Category     
 
 



Configuring a Dependent Dedicated LU    
Configuring a Dependent Mapped LU    
Configuring a Dependent Pooled LU    

Configuring a Dependent Public LU    
Configuring a Dependent Dedicated LU for NetWare HostPrint    
Editing a Dependent LU Assigned to the Application Subsystem    

Deassigning Dedicated LUs from NetWare HostPrint    

Editing Multiple Dependent LUs     

 

 

Mapping Dependent LUs to Downstream LUs    

Unmapping LUs    
Assigning a Dependent LU to the Application Subsystem        

Application Subsystem        

Viewing the Local LU Summary
Viewing the Local Transaction Program (TP) Summary 

Local LUs    
Configuring an Independent Local LU 
Configuring a Dependent Local LU

Partner LUs    
Configuring a Partner LU 

Modes    
Configuring a Conversation Mode 

Local TPs    
Configuring a Local TP for the Attach Manager

Security Aliases    
Configuring a Conversation Security Alias 



Procedures Groups
Click a resource to jump to the procedures associated with it.

Basic tasks
Resources

Server nodes           

Data link adapter definitions    

Host PU Profiles    

Peer PU profiles    

Downstream PU Definitions    

Hot Standby    

LU Pools    

Dependent LUs                 

Application Subsystem        

Local LUs    

Partner LUs    

Modes    
Local TPs    
Security Aliases    



Trademarks

Novell, Inc. has attempted to supply trademark information about company names, 
products, and services mentioned in this online help.    The following list of trademarks was 
derived from various sources.
Novell, NetWare, the N-Design and LAN WorkPlace are registered trademarks of Novell, Inc.    
IPX/SPX, NDS, NetWare 4, NetWare Directory Services, NetWare DOS Requester, NetWare 
HostPrint, NetWare FLeX/IP, NetWare Link/X.25, NetWare Loadable Module, NetWare 
Management System, NetWare MultiProtocol Router Plus, NLM, and NMS are trademarks of 
Novell, Inc.
UNIX is a registered trademark of Novell, Inc. in the United States and other countries, 
licensed exclusively through X/Open Company, Ltd.
3Com is a registered trademark of 3Com Corporation.
AppleTalk and Macintosh are registered trademarks of Apple Computer, Inc.
DEC is a trademark of Digital Equipment Corporation.
Common User Access and CUA are trademarks of Hewlett-Packard Company.
Intel is a registered trademark of Intel Corporation.
IBM, AS/400, NetView, and OS/2 are registered trademarks and SAA and VTAM are 
trademarks of International Business Machines Corporation.
Microsoft and MS are registered trademarks of Microsoft Corporation.
NET/MASTER is a registered trademark of Sterling Software.
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Create command
Opens the Create Resource dialog box, which lets you create the resources that NetWare® 
for SAA uses.
Keyboard shortcut: <Ins> or <Alt+O+C>



Delete command
Deletes one or more of the resources NetWare for SAA uses. Select the resource or resources
you want to delete in the view window's right pane, and then invoke the command.
Keyboard shortcut: <Del> or <Alt+O+D>



Details command
Opens a resource's dialog book. You configure a resource by editing the pages in the 
resource's dialog book. Select the resource you want to configure, then invoke the 
command.
Keyboard shortcut: <Enter> or <Alt+O+T>



Expand command
Displays the underlying resources of the current server, Host PU Profiles group, LU Pools 
group, or Application Subsystem. You can expand these resources when they are displayed 
in the left pane to view their underlying resources in the same pane.    Select one of these 
resources and invoke the command.
Keyboard shortcut: <Alt+O+E>



Collapse command
Hides the underlying resources of the server, Host PU Profiles group, LU Pools group, or 
Application Subsystem. Select one of these resources and invoke the command.
Keyboard shortcut: <Alt+O+O>



Exit command
Exits NetWare for SAA Administrator.
Keyboard shortcut: <Alt+O+X>



Assign Users command
Assigns users to a dedicated LU or LU pool, or to a downstream PU running OS/2 
Communications Manager and available on an Ethernet or token ring connection.
Users assigned to a dedicated LU can access that LU. Users assigned to an LU pool or 
downstream PU can access any available LU in the pool or downstream PU.
Keyboard shortcut: <Alt+F+A>



Copy PU Profile command
Copies an existing Host PU profile to create a new Host PU profile. After copying, you can 
edit the new profile.
Keyboard shortcut: <Alt+F+C>



Log In to Server command
Displays the Login Server dialog box, which lets you log in to a NetWare for SAA server.
Keyboard shortcut: <Alt+F+I>



Log Out from Server command
Issues a prompt that lets you confirm whether you want to log out from a NetWare for SAA 
server.
Keyboard shortcut: <Alt+F+O>



New Window command
Displays a submenu that offers the following commands:

All Servers
Opens a new view window listing information about all the NetWare for SAA servers 
available on the network. 

Selected Server
Opens a new view window listing information about the NetWare for SAA server selected 
in the current view window.

Keyboard shortcut: <Alt+W+N>



All Servers command
Opens a new view window listing information about all the NetWare for SAA servers 
available on the network.
Keyboard shortcut: <Alt+W+N+A>



Selected Server command
Opens a new view window listing information about the NetWare for SAA server selected in 
the current view window.
Keyboard shortcut: <Alt+W+N+S>



Cascade command
Arranges all open view windows one in front of the other so their titles are all visible at once.
Keyboard shortcut: <Alt+W+C>



Tile command
Arranges all open view windows in rows and columns so they are all visible at once.
Keyboard shortcut: <Alt+W+T>



Arrange Icons command
Arranges minimized view windows in the lower left corner of NetWare for SAA 
Administrator's application window.
Keyboard shortcut: <Alt+W+A>



Close All command
Closes all view windows currently open.
Keyboard shortcut: <Alt+W+L>



Contents command
Opens NetWare for SAA Administrator's online help to display icons that represent the 
available categories of online help. You click an icon to access information on its category.
Keyboard shortcut: <Alt+H+C>



Using Help command
Provides instructions for using online help.
Keyboard shortcut: <Alt+H+U>



About NWSAA Admin command
Displays NetWare for SAA Administrator's version number, date, and copyright notice.
Keyboard shortcut: <Alt+H+A>



NWSAA server icon
Represents a NetWare for SAA server. The name of the NetWare for SAA server appears to 
the right of the icon in the view window.

Double-clicking a NetWare for SAA server you have not already logged in to lets you 
log in to it. After you log in, the server icon automatically expands to display its underlying 
resource groups.

Selecting a NetWare for SAA server displays its Communication Executive, NWSAA 
Node, and AS/400 node resources and related summary information.

Double-clicking a NetWare for SAA server that is already expanded collapses it.



Not logged in icon
Indicates you are not logged in to a server. 
NetWare for SAA Administrator prompts you to log in while displaying this icon. After you log 
in, the icon disappears.



Data Link Adapters group icon
Represents the Data Link Adapters group, which contains all the logical data link adapter 
definitions configured for the NetWare for SAA server.
Selecting the Data Link Adapters group displays that server's logical data link adapter 
definitions and related summary information.



Host PU Profiles group icon
Represents the server's Host PU Profiles group, which contains all the Host PU profiles 
configured for the NetWare for SAA server.

Selecting the Host PU Profiles group displays the server's Host PU profiles and related
summary information in the view window's right pane. You can double-click a Host PU profile 
displayed in the right pane if you want to edit its configuration. 

Expanding the Host PU Profiles group displays the server's Host PU profiles in the 
view window's left pane. You can then select one of these Host PU profiles to display its 
underlying LU resources and related summary information.



Peer PU profiles group icon
Represents the server's Peer PU Profiles group, which contains all the non-default Peer PU 
profiles configured for the NetWare for SAA server.
Selecting the Peer PU Profiles group displays the server's Peer PU profiles and related 
summary information in the view window's right pane. You can double-click a Peer PU profile 
displayed in the right pane if you want to edit its configuration. 



Downstream PUs group icon
Represents the server's Downstream PUs group, which contains all the downstream PU 
profiles configured for the NetWare for SAA server.
Selecting the Downstream PUs group displays the server's downstream PUs and related 
summary information. You can double-click a downstream PU resource if you want to edit its 
configuration.



LU Pools group icon
Represents the server's LU Pools group, which contains all the LU pools configured for the 
NetWare for SAA server.

Selecting the LU Pools group displays the server's LU pools and related summary 
information in the view window's right pane. You can double-click an LU pool displayed in the
right pane if you want to edit its configuration.

Expanding the LU Pools group displays the server's LU pools in the view window's left 
pane. You can select these LU pools to display their underlying LU resources and related 
summary information.



Hot Standby group icon
Represents the server's Hot Standby group, which contains all the Hot Standby resources 
defined for the NetWare for SAA server.
Selecting the Hot Standby group displays the server's Hot Standby configurations. You can 
double-click a displayed Hot Standby if you want to edit its configuration.



Application Subsystem icon
Represents the server's Application Subsystem group, which includes all the resource groups
that can be configured for the Application Subsystem.

Selecting the Application Subsystem group displays the icon for the APPC session 
summary in the view window's right pane. You can double-click the summary icon in the 
right pane if you want to view a summary of the local LUs and local transaction programs 
(TPs) configured to use the Application Subsystem.

Expanding the Application Subsystem group displays the Local LUs, Partner LUs, 
Conversation Modes, Local TPs, and Security Aliases resource groups in the view window's 
left pane. You can select these resource groups to display individual resources in the right 
pane.



Local LUs group icon
Represents the Application Subsystem's Local LUs resource group, which contains all the 
local APPC type LUs that have been configured to use the Application Subsystem. 
Selecting the Local LUs group displays the local LUs configured for the Application 
Subsystem in the view window's right pane along with related summary information. You can
double-click a local LU in the right pane to edit its configuration.



Partner LUs group icon
Represents the Application Subsystem's Partner LUs resource group, which contains all the 
partner LUs that have been assigned to local LUs through the Application Subsystem. 
Selecting the Partner LUs group displays the partner LUs configured for the Application 
Subsystem in the view window's right pane along with related summary information. You can
double-click a partner LU in the right pane to edit its configuration.



Modes group icon
Represents the Application Subsystem's Modes resource group, which contains all the 
conversation modes that have been assigned to local LU - partner LU conversations through 
the Application Subsystem. 
Selecting the Modes group displays the conversation modes configured for the Application 
Subsystem in the view window's right pane along with related summary information. You can
double-click a conversation mode in the right pane to edit its configuration.



Local TPs group icon
Represents the Application Subsystem's Local TPs resource group, which contains all the 
local transaction programs (TPs) that have been configured to use the Application 
Subsystem's Attach Manager to participate in transactions initiated by remote TPs. 
Selecting the Local TPs group displays the local TPs configured for the Application 
Subsystem's Attach Manager in the view window's right pane along with related summary 
information. You can double-click a local TP in the right pane to edit its configuration.



Security Aliases group icon
Represents the Application Subsystem's Security Aliases resource group, which contains all 
the security aliases that have been configured to authorize users of remote transaction 
programs (TPs) to initiate conversations with local TPs.    
Selecting the Security Aliases group displays the security aliases configured for the 
Application Subsystem's Attach Manager in the view window's right pane along with related 
summary information. You can double-click a security alias in the right pane to edit its 
configuration.



Data link adapter icon
Represents a logical adapter definition for an 802.2 (Ethernet or token ring), SDLC, QLLC, or 
custom link that establishes a connection between the NetWare for SAA server and a host or
another SNA node on the network.
Green indicates that the startup status of the adapter is in service. Gray indicates that the 
startup status of the adapter is out of service.
Double-clicking a data link adapter resource allows you to edit its definition. You can also 
select it and chose Object > Details.



Host PU profile icon
Represents a Host PU profile. Blue indicates that a Host PU profile is automatically enabled 
when NetWare for SAA is started. Gray indicates that a Host PU profile is disabled when 
NetWare for SAA is started.

Selecting a Host PU profile displayed in the view window's left pane displays its 
underlying LU resources and related summary data.

Double-clicking a Host PU profile displayed in the view window's right pane allows 
you to edit its configuration. You can also select it and chose Object > Details.



Peer PU profile icon
Represents a non-default Peer PU profile. Green indicates that a Peer PU profile is 
automatically enabled when NetWare for SAA is started. Gray indicates that a Peer PU profile
is disabled when NetWare for SAA is started.
Double-clicking a Peer PU profile displayed in the view window's right pane allows you to edit
its configuration. You can also select it and chose Object > Details.



Downstream PU icon
Represents a resource that defines a downstream PU.
You can double-click a downstream PU if you want to edit its definition. You can also select it 
and chose Object > Details.



LU pool icon
Represents an LU pool.

Selecting an LU pool displayed in the view window's left pane displays its assigned 
LUs and related summary information.

Double-clicking an LU pool displayed in the view window's right pane allows you to 
edit its configuration. You can also select it and chose Object > Details.



Communication Executive icon
Represents the servers Communication Executive configuration, which you configure to 
enable or disable the communications servers management options and protocol support.
To edit the server's Communication Executive resource do one of the following:

Double-click it.

Select it and chose Object > Details.



NWSAA Node icon
Represents the server's NWSAA Node resource, which you configure to specify the SNA 
network ID, and set up support for tn3270 clients.
To edit the server's NWSAA Node resource do one of the following:

Double-click it.

Select it and chose Object > Details.



Hot Standby icon
Represents a Hot Standby configuration, which identifies a critical server and the Hot 
Standby PU profiles that act as a backup for that server.
To edit a Hot Standby configuration, do one of the following:

Double-click it.

Select it and chose Object > Details.



Public printer LU icon
Represents a public LU configured for type 1 or 3 printer sessions.
To edit this public LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Public display LU icon
Represents a public LU configured for type 2 display sessions.
To edit this public LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Public APPC LU icon
Represents a public LU configured for APPC sessions.
To edit this public LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Public LUx icon
Represents a public LU configured for type 0, 1, 2, or 3 sessions.
To edit this public LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Dedicated printer LU icon
Represents a dedicated LU configured for type 1 or 3 printer sessions.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Dedicated LU assigned to NetWare HostPrint™ icon
Represents a dedicated LU configured for HostPrint sessions.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Dedicated display LU icon
Represents a dedicated LU configured for type 2 display sessions.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Dedicated APPC LU icon
Represents a dedicated LU configured for APPC sessions.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Dedicated LUx icon
Represents a user-defined dedicated LU configured for type 0, 1, 2, or 3 sessions.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Mapped printer LU icon
Represents an LU configured for type 1 or 3 printer sessions that has been assigned to a 
downstream LU.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Mapped display LU icon
Represents an LU configured for type 2 display sessions that has been assigned to a 
downstream LU.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Mapped APPC LU icon
Represents an LU configured for APPC sessions that has been assigned to a downstream LU.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Mapped LUx icon
Represents a user-defined LU configured for type 0, 1, 2, or 3 sessions that has been 
assigned to a downstream LU.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Pooled printer LU icon
Represents an LU configured for type 1 or 3 printer sessions that has been assigned to a 
pool.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Pooled display LU icon
Represents an LU configured for type 2 display sessions that has been assigned to a pool.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Pooled APPC LU icon
Represents an LU configured for APPC sessions that has been assigned to a pool.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Pooled LUx icon
Represents a user-defined LU configured for type 0, 1, 2, or 3 sessions that has been 
assigned to a pool.
To edit this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



Application Subsystem dependent LU icon
Represents an dedicated dependent LU assigned to the Application Subsystem supplied by 
NetWare for SAA.    Clicking this icon allows you to edit some of the detailed information of 
the dependent LU assigned to the Application Subsystem.    
To view or edit detailed information on this LU, do one of the following:

Double-click it.

Select it and chose Object > Details.



APPC session list icon
Represents a summary of local LUs and local transaction programs (TPs) configured for the 
Application Subsystem.
To view this icon's summary information of the sessions and local TPS configured for the    
Application Subsystem and Attach Manager, do one of the following:

Double-click it.

Select it and chose Object > Details.



Local LU icon
Represents a local APPC type LU configured for the Application Subsystem.
To edit this LU's Application Subsystem configuration, do one of the following:

Double-click it.

Select it and chose Object > Details.



Partner LU icon
Represents a remote LU configured to converse with one or more local LUs through 
Application Subsystem.
To edit this remote LU's Application Subsystem configuration, do one of the following:

Double-click it.

Select it and chose Object > Details.



Mode icon
Represents a conversation mode configured for one or more local-LU-to-partner-LU 
conversations through the Application Subsystem.
To edit this conversation mode configuration, do one of the following:

Double-click it.

Select it and chose Object > Details.



Local TP icon
Represents a local transaction program (TP) configured to participate in conversations 
initiated by partner LUs through the Application Subsystem's Attach Manager.
To edit this local TP configuration, do one of the following:

Double-click it.

Select it and chose Object > Details.



Security alias icon
Represents a conversation security alias configured to authorize users of partner transaction
programs to initiate conversations with local transaction programs through the Application 
Subsystem's Attach Manager.
To edit this conversation security alias, do one of the following:

Double-click it.

Select it and chose Object > Details.



AS/400 Node icon
Represents the servers AS/400 System configuration, which you configure to enable the 
communications servers support for AS/400 connections.
To edit the server's AS/400 connections configuration, do one of the following:

Double-click it.

Select it and chose Object > Details.



Browsing the NWSAA Server

Browsing the NWSAA server displays its underlying Communication Executive, NWSAA Node,
and AS/400 Node resources.



Browsing the Data Link Adapters group

Browsing the Data Link Adapters group displays the logical adapter definitions configured for
the selected NWSAA server.



Browsing the Host PU Profiles group

Browsing the Host PU Profiles group displays all the Host PU profiles configured for the 
selected NWSAA server.



Browsing a Host PU profile

Browsing a Host PU profile displays its underlying dependent LUs.



Browsing the Peer PU Profiles group

Browsing the Peer PU Profiles group displays all the Peer PU profiles that have been 
configured in addition to the Default Peer PU profile for the selected NWSAA server.



Browsing the Downstream PUs group

Browsing the Downstream PUs group displays the downstream PUs that have been 
configured for mapping dependent LUs to.



Browsing the LU Pools group

Browsing the LU Pools group displays all the LU pools that have been configured for the 
selected NWSAA server.



Browsing an LU pool

Browsing an LU pool displays all the LUs that have been assigned to it.



Browsing the Hot Standby group

Browsing the Hot Standby group displays all the NWSAA servers that the selected server has
been configured to provide Hot Standby support for.



Browsing the Application Subsystem 

Browsing the NetWare for SAA Application Subsystem displays the icon containing the 
Application Subsystems Local LUs and Local TPs summaries.



Browsing the Local LUs group

Browsing the Local LUs group displays all the local LUs that have been configured for peer 
connections through the selected NWSAA server's Application Subsytem.



Browsing the Partner LUs group

Browsing the Partner LUs group displays the partner LUs that have been assigned peer 
connections to the local LUs through the Application Subsystem.



Browsing the Modes group

Browsing the Modes group displays the conversation modes that been assigned to the peer 
connections between the local LUs and partner LUs through the Application Subsystem.



Browsing the Local TPs group

Browsing the Local TPs group displays the local transaction programs (TPs) that can be 
remotely initiated by a partner TP through the Application Subsystem's Attach Manager.



Browsing the Security Aliases group

Browsing the Security Aliases group displays the conversation security aliases that can be 
assigned to Local TPs that require user security IDs and passwords before responding to 
initiation from a partner TP.



Logging In    
Before you can configure resources with NetWare for SAA Administrator, you must log in to 
the NetWare for SAA server associated with those resources.
To log in to a server, take the following steps:
1. Locate the server on which you want to log in.

If necessary, scroll until you locate the desired server.
2. Perform one of the following operations:

Double-click the server on which you want to log in.

Select the server on which you want to log in. Then choose Functions > Log In to 
Server.

NetWare for SAA Administrator usually displays a Login dialog box.
Note: NetWare for SAA Administrator will automatically log you in and not display the 

Login dialog box before starting NetWare for SAA Administrator if you are already 
logged in to the selected server under an username with supervisor-level rights, 
or if you are already authenticated by NetWare Directory Services™ (NDS™) to 
supervise this server.

3. In the Username text box, enter the username you want to log in under.
If the server is running NDS software, include any necessary context. The NetWare for 
SAA server's context is the default.

4. In the Password text box, enter the password. 
5. Click OK.

Related Topic

Logging Out



Logging Out    
To log out from a server, take the following steps:
1. Select the server from which you want to log out.

If necessary, scroll until you locate the desired server.
2. Choose Functions > Log Out from Server.

NetWare for SAA Administrator prompts you to confirm that you want to log out from the 
server.

3. Click OK.

Note: If before starting NetWare for SAA Administrator, you logged in to the selected server
under a username with supervisory-level rights, or you were authenticated by NDS to 
supervise this server, NetWare for SAA Administrator does not truly log you out from 
the server.    To protect against unauthorized access to this server from this 
workstation, you must exit NetWare for SAA Administrator and log out from the 
network.

Related Topic

Logging In 



Expanding Resources    
To expand the NWSAA server,    PU Profiles group,    LU Pools group, or Application Subsystem,
double-click it.
Expanding these resources and groups allows you to view and browse their underlying 
resources to survey the resources they contain.

Expand the Host PU Profiles group 

to display the current server's    configured Host PU profiles in the left pane of the view 
window. You can then browse these Host PU profiles to survey the LU resources they 
contain.

Expand the LU Pools group 

to display the current server's configured LU pools in the left pane of the view window. 
You can then browse these LU pools to survey the LU resources they contain.

Expand the Application Subsystem 

to display the groups of resources (Local LUs, Partner LUs, Conversation Modes, Local 
Transaction Programs, and Coversation Security Aliases) in the left pane of the view 
window.    You can then browse these resource groups to review the resources configured 
to use the NetWare for SAA Application Subsystem.

Expand a Collapsed NWSAA server 

to redisplay its resource groups in the left pane of the view window.    You can then 
browse or expand these groups. 

Note: When you log in to a server, NetWare for SAA Administrator automatically expands 
the NWSAA server resource. 

Related Topics

Browsing Resources 
Collapsing Resources 



Browsing Resources    
You can click any resource displayed in the left pane of the view window to quickly view that 
resource's underlying resources and related summary information in the right pane of the 
view window. 
To view detailed information about an underlying resource that appears in the right pane, 
double-click it.
The following left pane resources can be browsed.    Click any resource below for an example 
and explanation of its underlying resources and related summary information.

Browsable
Resource Name

NWSAA server

Data Link Adapters group

Host PU Profiles group

Host PU profile
Peer PU Profiles group

Downstream PUs     group  

LU Pools group

LU pool 
Hot Standby group

Application Subsytem

Local LUs group
Partner LUs group
Modes group
Local TPs group
Security Aliases group

Related Topics

Collapsing Resources 
Expanding Resources 



Collapsing Resources    
To collapse a resource that has been expanded, double-click it. Doing so hides the resource's
underlying resources in the left pane. Any resource that can be expanded can also be 
collapsed.

Related Topics

Browsing Resources 
Expanding Resources 



Creating Resources    
You can create the following resources on the NetWare for SAA server:

Data link adapter definitions Application Subsystem resources:

Host PU profiles Local LUs 

Peer PU profiles Partner LUs 

Downstream PU definitions Conversation modes 

LU pools Local transaction programs (TPs) 

Hot Standby Conversation security aliases

A NetWare for SAA server's Communication Executive and NWSAA Node resources are 
automatically available for you to edit. 
To create a resource, take the following steps:
1. If you have not already done so, open the Create Resource dialog box as follows:

1a. If you have not already done so, log in to the server on which you want to create a 
resource.

1b. Select the server you want to create the resource on, or select a resource on that 
server.

1c. Choose Object > Create or press <Ins> to open the Create Resource dialog box.
2. With the Create Resource dialog box open, select the resource you want to create.
3. Click OK.

NetWare for SAA Administrator displays the selected resource's dialog book.
4. Configure the new resource by editing its dialog book.

For details on configuring a resource, click that resource in the following lists:
Host PU profile 
LU pool 
Downstream PU 
definition 
Hot Standby 
resource 
802.2 adapter 
definition 
QLLC adapter 
definition 
SDLC adapter 
definition 

Custom adapter 
definition 
For the Application 
Subsystem

Local LU 
configuration 
Partner LU 
configuration
Mode configuration
Local Transaction 
Program (TP) 
configuration



Security alias 
configuration

Related Topics

Deleting Resources 
Editing the Configuration of Existing Resources 



Editing the Configuration of Existing Resources    
Edit a resource to change its configuration. To edit a resource, take the following steps:
1. If you have not already done so, log in to the server associated with the resource you 

want to edit.
2. Locate the resource you want to edit.
3. Open the dialog book that lets you configure the desired resource by doing one of the 

following:

If the resource you want to edit is in the right pane of the view window, double-click 
it.

Select the resource you want to edit and press <Enter>.

Select the resource you want to edit and choose 
Object > Details.
4. Edit the resource's dialog book and then click OK.

After you edit a resource, NetWare for SAA Administrator updates your view windows to 
reflect any configuration changes that affect the summary information displayed about 
the modified resource.
For details on changing the configuration of a resource, click that resource in the 
following list:

Communication 
Executive
NWSAA Node 
AS/400 Node
802.2 adapter 
definition 
SDLC adapter 
definition 
QLLC adapter 
definition 
Custom adapter 
definition 
Host PU profile 
Peer PU profile
Downstream PU 
definition 
Public LU 
Mapped LU 

LU pool 
Hot Standby resource 
Pooled LU 
Dedicated LU 
For the Application 
Subsystem

Local LU 
configuration 
Partner LU 
configuration
Mode configuration
Local Transaction 
Program (TP) 
configuration
Security alias 
configuration



Related Topics

Creating Resources 
Deleting Resources 
Editing Multiple LUs



Deleting Resources    
You can delete the following resources:

Data link adapter definitions Application Subsystem resources:

Host PU profiles Local LUs 

Peer PU profiles Partner LUs 

Downstream PU definitions Conversation modes 

LU pools Local transaction programs (TPs) 

Hot Standby Conversation security aliases

To delete resources, take the following steps:
1. If you have not already done so, log in to the server on which you want to delete 

resources.
2. Locate the resources you want to delete.
3. Select the resources you want to delete.

If you want to delete more than one resource, hold down <Ctrl> while selecting each of 
those resources.

4. Press <Del> or choose Object > Delete.
NetWare for SAA Administrator prompts you to confirm that you want to delete the 
selected resources.

5. Click OK.
NetWare for SAA Administrator no longer displays the deleted resources.

Related Topics

Creating Resources 
Editing the Configuration of Existing Resources 



Configuring the Communication Executive     

Configure a NetWare for SAA server's Communication Executive if you want to perform one 
or more of the following operations:

Describe the NetWare for SAA server. 
For details on this task, click here.

Configure the NetWare for SAA server's network management options. 
For details on this task, click here.

Select the protocol stacks that the NetWare for SAA server supports. 
For details on this task, click here.



Describing the Server     

To describe a server, take the following steps:
1. If you have not already done so, locate the Communication Executive of the server you 

want to manage and open the Description page of the Communication Executive 
Information dialog book. 

2. Edit the Description page as instructed in the following table and click OK.    
To jump to instructions for a particular field, click here. 

Field Instruction
Communication 
Executive version

You cannot edit this field, which 
indicates the version number of the 
Communication Executive software 
running on the NetWare for SAA 
server.

Installation date and 
time

You cannot edit this field, which 
indicates when the Communication 
Executive was installed.

Server model number This field is optional, and it applies 
only to NetView* support. The model 
number must contain numeric (0 to 9) 
and uppercase alaphabetic (A to Z) 
characters only. NetView does not 
support lowercase or special 
characters in the model number.
If your server is not an IBM product 
and your server's model number does 
not conform to the IBM defined 
format, you can either create an 
alternate model number that 
approximates your server's actual 
model number or leave this field 
blank.

Server serial number This field is optional and applies only 
to NetView support. The serial number
must contain numeric (0 to 9) and 
uppercase alaphabetic (A to Z) 
characters only. NetView does not 
support lowercase or special 
characters in the serial number.
If your server is not an IBM product 
and your server's serial number does 



not conform to the IBM defined 
format, you can either create an 
alternate serial number that 
approximates your server's actual 
serial number or leave this field blank.

Server description Type a description of the NetWare for 
SAA server. The description can 
consist of up to 127 alphanumeric or 
special characters.

Installation location Type a description of the location of 
the server on which you have installed
the Communication Executive. You can
type up to 127 alphanumeric or 
special characters in this field.

Miscellaneous Type up to 127 alphanumeric or 
special characters in this field.

Related Topics

Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 
Configuring Management Options 
Selecting Protocol Stack Support 



Server Description Fields
Click the field you want described.

Communication Executive version
Installation date and time
Server model number
Server serial number
Server description
Installation location
Miscellaneous



Configuring NetWork Management Options     

Configure a server's management options if you want to perform any of the following tasks:

Specify whether the server maintains an audit trail

Specify whether the server maintains an event log 

Enable or disable the trace facility

Enable or disable NetWare Communication Services security

Set NetView support options
To configure a server's network management options, take the following steps:
1. If you have not already done so, display the Management Options page of the NetWare 

for SAA server's Communication Executive resource as follows:
1a. Locate the Communication Executive of the server that you want to configure and 

Open the Communication Executive Information dialog book.
1b. Click the Management Options page icon.

2. Edit the Management Options page as in the following table and click OK.
To jump to instructions for a particular field, click here.

Field Instruction

Enable trace
Select this check box to enable 

the trace facility.

Clear this check box to disable 
the trace facility. This is the default.

Enable security
Select this check box to enable 

NetWare Communication Services 
security.

When this security is enabled, 
users must be explicitly authorized
to use a session they have 
selected.

Clear this check box to disable 
the NetWare Communication Services 
security so that any user can use any 
session. This is the default.

Disabling this security does not 



disable NetWare security.

Log local events
Select this check box (enable) 

if you want to have the 
Communication Executive save server 
events in an event log.

Clear this check box if you do 
not want to maintain an event log. 
This is the default.

Enable audit trail
Select this check box if you 

want the Communication Executive to 
save an audit trail of user actions.

When the audit trail is enabled, the
audit trail file is backed up each 
day at the specified archive hour 
to a file in the archive directory. 
The archived files are ASCII files 
that you can view with any text 
editor.

Clear this check box if you do 
not want to maintain an audit trail. 
This is the default.

Hour to start Select the hour at which the archive 
file will be saved. You can specify any 
hour between 12:00 a.m. and 11:00 
p.m.

Audits retained Type the number of files that are 
stored in the archive directory 
(specified in the Directory field). If the 
number of files stored exceeds the 
number you specify here, the oldest 
file is deleted.

Directory Name the directory where the audit 
trail files are stored. The default 
directory is SYS:\SYSTEM\COMMEXEC\
SECAUDIT.

NetView 
management Select this check box to enable 

NetView management.
When this check box is selected, 
the NetView management fields 



(Generate alerts, Process 
commands, Enable NetView 
security, and Upstream 
management node) become 
available.

Clear this check box to disable 
NetView management. If you do so, 
the NetView management fields are 
unavailable. This is the default.

Generate alerts This field is available if NetView 
management is selected.

Select this check box if you 
want NetView alert support. When you
select this check box, the server sends
alerts to the IBM NetView facility. This 
is the default.

Clear this check box if you do 
not want NetView alert support. 

Process commands This field is available if NetView 
management is selected.

Select this check box to enable 
NetView run command (RUNCMD) 
support. When you select this check 
box, the communications server 
accepts run commands from the IBM 
NetView facility.

Clear this check box to disable 
NetView run command support. This is
the default choice.

Enable NetView 
security

This field is available if NetView 
management is selected.

Select this check box to enable 
NetView security.

If you select this check box, you 
must specify a valid NetWare user 
ID with the OP= parameter in each
NetView command. For run 
commands that require supervisor 
equivalence, the user ID must 
have supervisor equivalence on 
the target server. On a NetWare 
4TM server, the user ID must have 
security equivalence to the file 



server object.

Clear this check box to disable 
NetView security. This is the default.

Upstream 
management node

This field is available if NetView 
management is selected.
Select one of the following options to 
specify the NetView node directly 
upstream from the current NetWare 
for SAA server.    This is the node to 
which the current server will forward 
the NetView alerts and from which the
current server will receive forwarded 
run commands.

NetView Host
Select this option if the upstream 
NetView link is directly to the 
NetView host.
The Host PU profile name field is 
displayed if you select this option.

NWSAA Collection Point 
Select this option if the upstream 
link to NetView is a NetWare for 
SAA collection point server.
The Collection point server name 
field is displayed if you select this 
option.

OS/2 NetView Host
Select this option if the upstream 
link to NetView is an OS/2 
machine.

Collection point 
server name

This field is available if the NWSAA 
Collection point option is selected in 
the Upstream management node field.
Type the name of the NetWare for SAA
server that will serve as the collection 
point server.

Host PU profile name This field is available if the NetView 
Host option is selected in the 
Upstream management node field. It 
is a required field for that option.
Type the name of a Host PU profile on 
the current NetWare for SAA server 



that uses the logical adapter and link 
type to the NetView host.
You can type an asterisk ( * ) in this 
field if you want NetWare for SAA to 
use the first Host PU profile it finds.

Related Topics

Describing the Server 
Selecting Protocol Stack Support 



Network Management Options Fields
Click the field you want described.

Enable trace
Enable security
Log local events
Enable audit trail
Hour to start
Audits retained
Directory

NetView Management
Generate alerts
Process commands
Enable NetView security
Upstream management 
node
Collection point server
Host PU profile name



Selecting Protocol Stack Support     

To select the protocols that a NetWare for SAA server supports, take the following steps:

1. If you have not already done so, display the Protocol Options page of the NetWare for 
SAA server's Communication Executive resource as follows. If that page is already open, 
go to Step 2.
1a. Locate the Communication Executive of the server you want to configure and open 

the Communication Executive Information dialog book.
1b. Click the Protocol Options page icon.

2. With the Protocol Options page open, perform the following operations:

Select the check boxes of the protocol stacks you want the server to support.
The default selection, IPX/SPXTM, supports connections to DOS and MS Windows 
workstations. You cannot change this selection.
Select Enable AppleTalk* for Macintosh* clients, and Enable TCP/IP for UNIX® clients. 
To fully configure TN3270 support you must also configure the TN3270 page for the 
NetWare for SAA node.

Clear the check boxes of the protocol stacks you do not want the server to support.    
You cannot clear the Enable IPX/SPX check box.
3. Click OK to save your changes.

Related Topics

Configuring Management Options 
Describing the Server 



Configuring the NWSAA Node Resource     

Configure the NWSAA node resource to

Configure the NWSAA node description information.

Provide the NetWare for SAA server with the SNA network ID. You must always 
provide this value.    

Specify default Peer PU profile settings to support peer-to-peer communications.
For details on these tasks, click here.

Support tn3270 connections between clients and the NetWare for SAA 
server.    

For details, click here.



Configuring the NWSAA Node Description     

To define the SNA network ID and configure default peer PU profile settings, take the 
following steps:
1. If you have not already done so, locate the NWSAA Node of the server you want to 

manage and open the NWSAA Node Information dialog book. If that book is already open,
skip this step.

2. Edit the Description page as instructed in the following table and then click OK.
To jump to instructions for a particular field, click here .

Field Instruction
NetWare for SAA 
version

You cannot edit this field.    It 
identifies the version of NetWare for 
SAA installed on the current server.

Number of installed 
dependent session 
licenses

You cannot edit this field.    It displays 
the number of dependent NetWare 
for SAA LU sessions licensed for this 
computer.

Number of installed 
independent session 
licenses

You cannot edit this field.    It displays 
the number of independent NetWare 
for SAA LU sessions licensed for the 
current server.

SNA network ID Type an SNA network ID you obtain 
from the host system programmer, or
leave the default (NETSNA).
For an AS/400* network, the SNA 
network ID is APPN. 

Peripheral node 
control point name

This is the control point name of the 
NetWare for SAA server.    In an SNA 
network, each PU2.1 node must have 
a unique peripheral node control 
point name.
NetWare for SAA sends the control 
point name to the partner node 
durnig the exchange identification 
(XID) process to identify itself.
The default peripheral node control 
point name is CPNAME.



Node ID
(block/PU ID)

Type the Node ID.
The node ID is a combination of the 
block ID and PU ID.
The three-digit hexadecimal block ID 
number is an IBM product-specific 
number.    The block ID also matches 
the IDBLK value in the host definition.
The block ID for 3274 nodes is 017 
hex.
The PU ID is a binary station within an
SNA network.
NetWare for SAA sends the node ID to
the partner node during the 
exchange identification (XID) process 
to identify itself to the partner node.

Local/Partner SAP for 
independent LUs

This field provides the local and 
remote service access point (SAP) 
values that are used by NetWare for 
SAA whan an APPC/PC ATTACH_LU 
verb does not explicitly specify its 
own SAP values.
The default is 04 hex.
This field is not used for CPI-C TPs.    
Its primary purpose is to provide 
backward compatibility for APPC/PC 
TPs that were written to the NetWare 
for SAA 1.3 APPC/PC API.

Related Topics

Configuring the NWSAA Node Resource
Configuring NetWare TN3270 support 
Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 



NWSAA Node Description Fields
Click the field you want described.

NetWare for SAA 
version
Number of 
installed 
dependent session 
licenses
Number of 
installed 
independent 
session licenses

SNA network ID
Peripheral node control 
point name
Node ID (block/PU ID)
Local/Partner SAP for 
independent LUs

Configuring NetWare TN3270 Support     

To configure support for NetWare TN3270 connectivity, take the following steps:
1. If you have not already done so, locate the NWSAA Node of the server you want to 

manage and open the NWSAA Node Information dialog book.    If that book is already 
open, skip this step.

2. Double-click the TN3270 page icon.
3. Edit the TN3270 page as instructed in the following table and then click OK.

To jump directly to a particular field description, click here.

Field Instruction
PUs Available for 
TN3270

Identify the Host PU profiles that you 
want tn3270 clients to use.

To make no Host PU profiles 
available to the tn3270 client select 
None.

To make all Host PU profiles 
on the current server available to the
tn3270 client, select All.

To make specific Host PU 
profiles available to the tn3270 
client, select Selected.    Then select 
the Host PU profiles from the list box 
underneath.

Connections/Client Specify the maximum number of 
TELNET connections you want to 
allow to each tn3270 client.



To set no limit on the number 
of TELNET connections per client, 
select the Unlimited button.

To set a maximum on the 
number of TELNET connections per 
client, select the Limit to button and 
enter that number in the connections
field.    The default value is 5.

Client Response Timer Specify the number of seconds that 
NetWare TN3270 waits before 
querying a tn3270 client after it has 
detected an idle condition for that 
client's connection.    If the client 
does not acknowledge the query, the 
connection is terminated.

To specify no timeout, select 
the No timeout button.

To set a client response timer 
value, select the Timeout after 
button and enter that value in the 
seconds field.    The default value is 
120.

Use client IP name Specify whether or not to use the IP 
name of each tn3270 client as the 
NetWare username.

If you want NetWare TN3270 
to use the IP name of each client as 
the NetWare username, select this 
check box.

The client IP name is the symbolic
name assigned to the TCP/IP 
address of the client workstation.  
NetWare refers to a file, named 
HOSTS, with the TCP/IP 
workstation addresses and their 
corresponding client IP names.
If you select this option, you must
use the SYSCON or NWADMIN 
utility to create NetWare 
usernames to match the client IP 
name of each tn3270 client. 
These are the names that appear 
in CSStatus screens or the User ID
column of the NetWare for SAA 
Services Manager Dependent LU 



window.
If an IP name is unavailable for a 
particular client, NetWare TN3270
uses the name specified in the 
TN3270 NetWare username field.

If you prefer to have all 
tn3270 clients use a common 
specified username, clear this check 
box. The default is cleared.

If you leave this check box 
unselected, all TN3270 Clients are
listed with the username 
specified in the TN3270 NetWare 
username field in the User ID 
column of the CSStatus and 
NetWare for SAA Services 
Manager utility and program.

TN3270 NetWare 
username

This field specifies the username that
tn3270 clients use when the Use 
client IP name check box is cleared or
when the client IP name does not 
match a valid NetWare username. 
If you selected the Use client IP name
check box, and all the tn3270 clients 
have valid IP names and matching 
usernames, you may leave this field 
blank. Otherwise, do one of the 
following:

Type a valid NetWare 
username in the TN3270 NetWare 
username field. If the selected server
runs NetWare 4.1, include the full 
context string.

Click the User List... button, 
browse the listed usernames or 
context trees, and select one of the 
available usernames.

Related Topics

Configuring the NWSAA Node Resource 
Configuring the NWSAA Node Description 
Host Connection Configuration Task Summary 



NetWare TN3270 Fields
Click the field you want described.

PUs avaialble for TN3270
Connections/Client
Client response timer
Use client IP name
TN3270 NetWare user name



NetWare User Dialog Box ( for NetWare 3.12)    
Edit the NetWare User dialog box as follows.
1. In the Select authorized user list box, select the user you want to authorize.    

Note: In addition to using your mouse, you can also select a user by using your arrow keys 
to highlight a username.
2. Click OK. 

NetWare for SAA closes the NetWare User dialog box and returns to the TN3270 page.    
The selected username is displayed in the TN3270 NetWare username field.

Related Topics

Configuring NetWare TN3270 support 
Configuring the NWSAA Node Resource 
Configuring the NWSAA Node Description 



NetWare User Dialog Box (for NetWare 4.1)    
On a NetWare 4.1 server, edit the NetWare User dialog box as follows. 
1. Specify the context of the user to assign.

To specify the next higher context level in the Current context list box, click the up 
arrow that appears in the context navigation box.

To specify the next lower context level in the Current context list box, click one of the 
listed Organization (O) or Organizational Unit (OU) names listed beneath the up arrow.
2. In the Select authorized user list box, select the user you want to authorize.

For a NetWare for SAA server running NetWare 4.1, the list box includes the users    
located in the context selected in the Current context list box.

Note: In addition to using your mouse, you can also select users by using your arrow keys 
to highlight a username.
3. Click OK. 

NetWare for SAA closes the NetWare User dialog box and returns to the TN3270 page. 
The selected username is displayed in the TN3270 NetWare username field.

Related Topics

Configuring NetWare TN3270 support 
Configuring the NWSAA Node Resource 
Configuring the NWSAA Node Description 



Configuring AS/400 Connections
For detailed information about configuring AS/400 connections, select one of the following 
topics:

Configuring AS/400 System Information 
Deleting an AS/400 System Configuration 

Configuring AS/400 Users and Sessions 
Adding AS/400 Users on a NetWare 3.12 Server 
Adding AS/400 Users on a NetWare 4.1 Server 
Removing an AS/400 User 



Configuring AS/400 System Information
To configure AS/400 System information, take the following steps:
1. If you have not already done so, locate the AS/400 Node of the server you want to 

manage and open the AS/400 Node dialog book.    If that book is already open, skip this 
step.

2. Double-click the System page icon.    The AS/400 Systems list box appears.
3. Edit an existing AS/400 system name, create a new AS/400 system name, or delete an 

existing As/400 system name.

To delete an existing system name, select that name and click the Delete button 
and click OK.

To edit an existing system name, select that name and click the Update button.    
The Configure AS/400 System dialog book appears.

To create a new AS/400 system name, click the Add button. The Configure 
AS/400 System dialog book appears.
4. If you clicked Add or Update, edit the Configure AS/400 System dialog book    as 

instructed in the following table and then click OK.
To jump directly to a particular field, click here.

Field Instruction
AS/400 system name If you are adding    a new AS/400 

system configuration, enter the new 
AS/400 system name here.
The system name entered must 
correspond to the TRLI, SDLI, QLLI, 
orCLLI identifier contained in the 
CONFIG.PCS file.    Refer to the 
NetWare for SAA for AS/400 
Connections manual for more 
information.

Logical adapter name Select a logical adapter name from 
the drop-down list box. This list box 
lists the logical adapter name of each
data link adapter definition on the 
current NetWare for SAA server.
The logical adapter name you select 
triggers the display of additional 
adapter-related fields on the page.

802.2 remote node 
address
(802.2 connections 
only)

This field appears if you specified an 
Ehthernet or token ring data link 
adapter.
Type the remote node address noted 
on your configuration worksheets.



The default is 4000 00000000 hex.

802.2 remote service 
access point
(802.2 connections 
only)

This field appears if you specified an 
Ehthernet or token ring data link 
adapter.
Type the remote service access point 
noted on your configuration 
worksheets.
The default is 04 hex.

802.2 local service 
access point
(802.2 connections 
only)

This field appears if you specified an 
Ehthernet or token ring data link 
adapter.
Type the local service access point 
noted on your configuration 
worksheets.
The default is 04 hex.
The maximum value in this field is 
determined by the number of local 
SAPs configured in the 802.2 adapter
definition's dialog book.

Local station address 
for multipoint link
(SDLC connections 
only)

This field appears only if you 
specified an SDLC data link adapter 
and the Capable of multiple station 
addresses check box is selected in 
the SDLC adapter definition's dialog 
book.
Type the NetWare for SAA local 
station address for an SDLC 
multipoint configuration in which a    
Host PU profile or peer-to-peer link is 
one of the secondary stations on the 
multipoint link.
When you are connecting to a host, 
this address must match the value in 
the host configuration.
The default value is C1 hex.

QLLC call support layer
target name
(QLLC connections 
only)

This field appears if you specified a 
QLLC data link adapter. Type the CSL 
target name as configured in the CSL
database. The name can be up to 16 
characters in length.
The target name contains    the 
destination address and the X.25 



parameters for the virtual circuit.
If you are using the NetWare 
MultiProtocol Router PlusTM 2.1 or 3.0 
drivers, or the NetWare Link/X.25TM 
2.1 or 3.0 drivers, the QLLC call 
support layer target name field must 
match the Call Destination field in 
the INETCFG utility Internetworking 
Configuration > WAN Call Directory >
Configured WAN Call Destinations 
menu.

Related Topics

Configuring AS/400 Connections 
Configuring AS/400 Users and Sessions 
Deleting an AS/400 System Configuration 
AS/400 Systems Connections Configuration Task Summary 



AS/400 System Fields
Click the field you want described.

AS/400 system name
Logical adapter name
802.2 remote node address
802.2 remote service access point
802.2 local service access point
Local station address for multipoint link
QLLC call support layer target name



Configure AS/400 System Dialog Box
Edit the AS/400 System dialog box    as instructed in the following table and then click OK.

Field Instruction
AS/400 system name If you are adding    a new AS/400 

system configuration, enter the new 
AS/400 system name here.
The system name entered must 
correspond to the TRLI, SDLI, QLLI, 
orCLLI identifier contained in the 
CONFIG.PCS file.    Refer to the 
NetWare for SAA for AS/400 
Connections manual for more 
information.

Logical adapter name Select a logical adapter name from 
the drop-down list box. This list box 
lists the logical adapter name of each
data link adapter definition on the 
current NetWare for SAA server.
The logical adapter name you select 
triggers the display of additional 
adapter-related fields on the page.

802.2 remote node 
address
(802.2 connections 
only)

This field appears if you specified an 
Ehthernet or token ring data link 
adapter.
Type the remote node address noted 
on your configuration worksheets.
The default is 4000 00000000 hex.

802.2 remote service 
access point
(802.2 connections 
only)

This field appears if you specified an 
Ehthernet or token ring data link 
adapter.
Type the remote service access point 
noted on your configuration 
worksheets.
The default is 04 hex.

802.2 local service 
access point
(802.2 connections 
only)

This field appears if you specified an 
Ehthernet or token ring data link 
adapter.
Type the local service access point 
noted on your configuration 
worksheets.
The default is 04 hex.
The maximum value in this field is 



determined by the number of local 
SAPs configured in the 802.2 adapter
definition's dialog book.

Local station address 
for multipoint link
(SDLC connections 
only)

This field appears only if you 
specified an SDLC data link adapter 
and the Capable of multiple station 
addresses check box is selected in 
the SDLC adapter definition's dialog 
book.
Type the NetWare for SAA local 
station address for an SDLC 
multipoint configuration in which a    
Host PU profile or peer-to-peer link is 
one of the secondary stations on the 
multipoint link.
When you are connecting to a host, 
this address must match the value in 
the host configuration.
The default value is C1 hex.

QLLC call support layer
target name
(QLLC connections 
only)

This field appears if you specified a 
QLLC data link adapter. Type the CSL 
target name as configured in the CSL
database. The name can be up to 16 
characters in length.
The target name contains    the 
destination address and the X.25 
parameters for the virtual circuit.
If you are using the NetWare 
MultiProtocol Router PlusTM 2.1 or 3.0 
drivers, or the NetWare Link/X.25TM 
2.1 or 3.0 drivers, the QLLC call 
support layer target name field must 
match the Call Destination field in 
the INETCFG utility Internetworking 
Configuration > WAN Call Directory >
Configured WAN Call Destinations 
menu.

Related Topics

Configuring AS/400 Connections 
Configuring AS/400 Users and Sessions 
Deleting an AS/400 System Configuration 
AS/400 Systems Connections Configuration Task Summary 





Deleting an AS/400 System Configuration
To delete an AS/400 system configuration, take the following steps:
1. If you have not already done so, locate the AS/400 Node of the server you want to 

manage and open the AS/400 Node dialog book.    If that book is already open, skip this 
step.

2. Double-click the System page icon.    The AS/400 Systems list box appears.
3. Select the AS/400 system configuration that you want to delete and click the Delete 

button.

Related Topics

Configuring AS/400 Connections 
Configuring AS/400 Users and Sessions 
Configuring AS/400 System Information 



Configuring AS/400 Users and Sessions
To configure your AS/400 users and their session limits, take the following steps:
1. If you have not already done so, locate the AS/400 Node of the server you want to 

manage and open the AS/400 Information dialog book.    If that book is already open, skip
this step.

2. Double-click the User page icon.    The AS/400 users list box appears.

To edit the session limit of an existing user, select the name of the AS/400 user 
whose session limit you want to edit and click the Update button.

In the Session limit field, enter the new session limit and click OK.

To add new AS/400 users, click the Add button and edit the Add AS/400 Users 
dialog box.    For more information, see "Related Topics," below.

To delete an existing user, select an AS/400 user and click the Delete button.

Related Topics

Configuring AS/400 System Information 
Adding AS/400 Users on a NetWare 3.12 Server 
Adding AS/400 Users on a NetWare 4.1 Server 
Removing AS/400 Users 
AS/400 Systems Connections Configuration Task Summary 



Configure AS/400 User and Session Dialog Box
To edit the Configure AS/400 User and Session dialog box, enter the new session limit in the 
Session limit field and click OK.



Adding AS/400 Users on a NetWare 3.12 Server
To add a new user to the AS/400 users list on a    NetWare for SAA server running under 
NetWare 3.12, take the following steps:
1. If you have not already done so, locate the AS/400 Node of the server you want to 

manage and open the AS/400 Information dialog book.    If that book is already open, skip
this step.

2. Double-click the User page icon.    The AS/400 users list box appears.
3. Click Add to open the Add AS/400 Users dialog box.
4. In the Select authorized users list box, select any users and groups you want to assign to 

the resource.    
To select more than one user, hold down the <Ctrl> key while clicking the users you 
want to assign.    To select a block of users, hold down the <Shift> key while clicking the 
first and last users in the block.

Note: In addition to using your mouse, you can also select users by using your arrow 
keys to highlight usernames and pressing the spacebar to mark them.

5. In the Session limit field, enter the session limit.    
This limit applies to all the users that you are adding to the AS/400 users list.    The 
maximum number of sessions is 32.    Setting a user's session to zero disables that user.   
The default value is 32.

6. Click OK. 
NetWare for SAA closes the Configure AS/400 User and Session dialog box and returns to 
the AS/400 Information dialog book. The user and group names selected in the Add Users
dialog box are added to the AS/400 users list box.

7. Close the AS/400 Information dialog book by clicking OK.



Related Topics

Configuring AS/400 System Information 
Configuring AS/400 Users and Sessions 
Adding AS/400 Users on a NetWare 4.1 Server 
Removing AS/400 Users 
AS/400 Systems Connections Configuration Task Summary 



Add AS/400 Users Dialog Box (on a NetWare 3.12 Server)
Edit the Add AS/400 Users dialog box as follows.
1. In the Select authorized users list box, select any users and groups you want to assign to 

the resource.    
To select more than one user, hold down the <Ctrl> key while clicking the users you 
want to assign.    To select a block of users, hold down the <Shift> key while clicking the 
first and last users in the block.

Note: In addition to using your mouse, you can also select users by using your arrow keys 
to highlight usernames and pressing the spacebar to mark them.
2. In the Session limit field, enter the session limit.    

This limit applies to all the users that you are adding to the AS/400 users list.    The 
maximum number of sessions is 32.    Setting a user's session to zero disables that user.   
The default value is 32.

3. Click OK. 
NetWare for SAA closes the Configure AS/400 User and Session dialog box and returns to 
the AS/400 Information dialog book. The user and group names selected in the Add Users
dialog box are added to the AS/400 users list box.

Related Topics

Configuring AS/400 System Information 
Configuring AS/400 Users and Sessions 
Adding AS/400 Users on a NetWare 4.1 Server 
Removing AS/400 Users 
AS/400 Systems Connections Configuration Task Summary 



Adding AS/400 Users on a NetWare 4.1 Server
To add a new user to the AS/400 users list on a    NetWare for SAA server running under 
NetWare 4.1, take the following steps:
1. If you have not already done so, locate the AS/400 Node of the server you want to 

manage and open the AS/400 Information dialog book.    If that book is already open, skip
this step.

2. Double-click the User page icon.    The AS/400 users list box appears.
3. Click Add to open the Configure AS/400 User and Session dialog box.
4. If you are configuring NetWare for SAA on a server running NetWare 4.1, specify the 

context of users or groups you want to assign.

To specify the next higher context level in the Current context list box, click the up 
arrow that appears in the context navigation box.

To specify the next lower context level in the Current context list box, click one of the 
listed Organization (O) or Organizational Unit (OU) names listed beneath the up arrow.
5. In the Select authorized users list box, select any users and groups you want to assign to 

the resource.
For a NetWare for SAA server running NetWare 4.1, the list box includes the users and 
groups located in the context selected in the Current context list box.
To select more than one user, hold down the <Ctrl> key while clicking the users you 
want to assign.    To select a block of users, hold down the <Shift> key while clicking the 
first and last users in the block.

Note: In addition to using your mouse, you can also select users by using your arrow keys 
to highlight usernames and pressing the spacebar to mark their checkbox.
6. In the Session limit field, enter the session limit.    

This limit applies to all the users that you are adding to the AS/400 users list.    The 



maximum number of sessions is 32.    Setting a user's session to zero disables that user.   
The default value is 32.

7. Click OK. 
NetWare for SAA closes the Configure AS/400 User and Session dialog box and returns to 
the AS/400 Information dialog book. The user and group names selected in the Add Users
dialog box are added to the AS/400 users list box.

8. Close the AS/400 Information dialog book by clicking OK.

Related Topics

Configuring AS/400 System Information 
Configuring AS/400 Users and Sessions 
Adding AS/400 Users on a NetWare 3.12 Server 
Removing AS/400 Users 
AS/400 Systems Connections Configuration Task Summary 



Add AS/400 Users Dialog Box (on a NetWare 4.1 Server)
On a NetWare 4.1 server, edit the Add AS/400 Users dialog box as follows. 
1. Specify the context of users or groups you want to assign.

To specify the next higher context level in the Current context list box, click the up 
arrow that appears in the context navigation box.

To specify the next lower context level in the Current context list box, click one of the 
listed Organization (O) or Organizational Unit (OU) names listed beneath the up arrow.
2. In the Select authorized users list box, select any users and groups you want to assign to 

the resource.
For a NetWare for SAA server running NetWare 4.1, the list box includes the users and 
groups located in the context selected in the Current context list box.
To select more than one user, hold down the <Ctrl> key while clicking the users you 
want to assign.    To select a block of users, hold down the <Shift> key while clicking the 
first and last users in the block.

Note: In addition to using your mouse, you can also select users by using your arrow keys 
to highlight usernames and pressing the spacebar to mark their checkbox.
6. In the Session limit field, enter the session limit.    

This limit applies to all the users that you are adding to the AS/400 users list.    The 
maximum number of sessions is 32.    Setting a user's session to zero disables that user.   
The default value is 32.

7. Click OK. 
NetWare for SAA closes the Configure AS/400 User and Session dialog box and returns to 
the AS/400 Information dialog book. The user and group names selected in the Add 
AS/400 Users dialog box are added to the AS/400 users list box.

Related Topics

Configuring AS/400 System Information 
Configuring AS/400 Users and Sessions 
Adding AS/400 Users on a NetWare 3.12 Server 
Removing AS/400 Users 
AS/400 Systems Connections Configuration Task Summary 



Removing an AS/400 User
To remove an AS/400 user from the NetWare for SAA server, take the following steps:
1. If you have not already done so, locate the AS/400 Node of the server you want to 

manage and open the AS/400 Information dialog book.    If that book is already open, skip
this step.

2. Double-click the User page icon.    The AS/400 users list box appears.
3. Select the user you want to remove from the AS/400 users list and click the Delete 

button.
4. Close the AS/400 Information dialog book by clicking OK.

Related Topics

Configuring AS/400 System Information 
Configuring AS/400 Users and Sessions 
Adding AS/400 Users on a NetWare 3.12 Server 
Adding AS/400 Users on a NetWare 4.1 Server 



Configuring Token Ring or Ethernet (802.2) Adapter Definitions
Define Ethernet or token ring data link adapters to configure NetWare for SAA for an 802.2 
connection between a NetWare for SAA server and a host or another SNA node on the 
network.
Configure new or existing 802.2 adapter definitions by taking the following steps:
1. If you have not already done so, either create the 802.2 data link adapter you want to 

configure, or locate and open an existing data link adapter.
Doing so will display the Description page of the Data Link Adapter Information dialog 
book.

2. With the Description    page displayed, edit as instructed in the following table and then 
click OK.
To jump to a particular field description, click here.

Field Instruction
Logical adapter name Type a logical adapter name that 

matches one of the adapter names 
entered in the AUTOEXEC.NCF file.

Adapter type You cannot edit this field, which 
indicates that the adapter describes 
an Ethernet or token ring (802.2) 
data link adapter.

Terminate peer link if 
no active APPC 
sessions

Select this check box to 
instruct NetWare for SAA to terminate
the 802.2 link to the peer node if 
there are no active sessions. This is 
the default.

Clear this check box if you 
want to retain logical links to remote 
nodes even when there are no active 
sessions running.

Logical adapter 
number

This is a required field.
Type a decimal number from 1 to 3 
digits in length. You can type any 
number from 0 to 255. The logical 
adapter number must be unique 
within a link type.

Number of local 
service access points

Type the appropriate SAP count. The 
number of local SAPs defines how 
many virtual connections can be 
established using this adapter 
definition.



The default value is 2. The maximum 
value is 32.
The number of local SAPs configured 
in this field also determines the 
maximum hex value you can enter 
for the 802.2 local service access 
point field in the Host PU Profile 
Information dialog book.

Adapter startup status Select one of the following options. 
This field is provided primarily to 
allow you to disable a data link 
adapter that is malfunctioning or that
needs to be tested before going 
online.

In service
If you select this option, the 
adapter is automatically enabled 
when you load NetWare for SAA.
This is the default.

Out of service
If you select this option, the 
adapter is not enabled when you 
load NetWare for SAA, thereby 
preventing access to other SNA 
nodes through the out-of-service 
adapter.

Related Topics

Configuring Custom Adapter Definitions 
Configuring QLLC Adapter Definitions 
Configuring SDLC Adapter Definitions 
Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 



Ethernet and Token Ring Adapter Fields
Click the field you want described.
Logical adapter name
Adapter type
Terminate peer link if no active APPC sessions
Logical adapter number
Number of local service access points
Adapter startup status



Configuring SDLC Adapter Definitions     

Define SDLC data link adapters to configure NetWare for SAA for an SDLC connection 
between a NetWare for SAA server and a host or another SNA node on the network.
Configure new or existing SDLC adapter definitions by taking the following steps:
1. If you have not already done so, either create the SDLC data link adapter you want to 

configure, or locate and open an existing data link adapter.
Doing so displays the Description page of the Data Link Adapter Information dialog book.

2. With the Description    page displayed, edit as instructed in the following table and then 
click OK.
To jump to a particular field description, click here.
Note: A modified SDLC adapter definition will not take effect until you unload and reload

the SDLC driver. For details, see the NetWare for SAA 2.0 Administration Guide for
Mainframes and Peer Nodes.

Field Instruction
Logical adapter name Type a logical adapter name that 

matches one of the adapter names 
entered in the AUTOEXEC.NCF file.

Adapter type You cannot edit this field, which 
indicates that the adapter describes 
an SDLC data link adapter.

Terminate peer link if 
no active APPC 
sessions

Select this check box to 
instruct NetWare for SAA to terminate
the SDLC link to the remote node if 
there are no active sessions. This is 
the default.

Clear this check box if you 
want to retain the logical links to the 
remote node even when there are no 
active sessions running.

Logical adapter 
number

This is a required field.
Type a decimal number from 1 to 3 
digits in length. You can type any 
number from 0 to 255. The logical 
adapter number must be unique 
within a link type.

Capable of multiple 
station addresses

Indicate whether this adapter 
answers to multiple station 



addresses.

Select this check box if the 
link is a multipoint link or if the 
NetWare for SAA server will 
concurrently emulate multiple station
addresses through this adapter.

If you select this check box, 
NetWare for SAA automatically 
sets the local station role to 
Secondary and NetWare for SAA 
Administrator disables the Hold 
Request to Send (RTS) 
continuously field.

Clear this check box if the link 
is a point-to-point link or if the 
adapter is on a multipoint link in 
which NetWare for SAA emulates only
a single station address. This is the 
default.

If you are on a multipoint SDLC 
link on which NetWare for SAA has
only one station address through 
a single SDLC adapter, Novell®    
recommends that you clear the 
Capable of multiple station 
addresses check box to achieve 
better performance. Be sure to 
set the Local station role field to 
Secondary.

Default local station 
address If the Capable of multiple 

station addresses check box is 
selected, use the default value that 
NetWare for SAA Administrator 
provides for the local station address.

If the Capable of multiple 
station addresses check box is 
cleared, this field's value is the actual
local station address used for this 
SDLC link. The default value is C1 
(hex).
NetWare for SAA does not allow the 
following local station addresses: 00 
hex and FF hex.
When you connect to a host, the 
value specified in this field must 
match the value in the host 
configuration.



If the adapter establishes a peer-to-
peer connection, this address must 
be different from the partner value.

Local station role Specify whether the NetWare for SAA 
station role for this SDLC link is 
Secondary or Negotiable.
For a point-to-point configuration, 
select Negotiable or Secondary, 
depending on your topology. When 
the Capable of multiple station 
addresses check box is selected, this 
field is automatically set to 
Secondary.
Select Secondary unless you are 
certain that the remote node is set up
to negotiate the station role. If this 
adapter is to be used for a Host PU 
profile, it is usually correct to select 
Secondary. Although NetWare for 
SAA does support role negotiation on 
SDLC host connections, configuring 
for a negotiable local station role 
when the remote node is unable to 
negotiate prevents the link from 
being established.

Encoding option for 
data link adapter

Specify how you want information 
encoded by selecting either NRZ 
(nonreturn to zero) or NRZI 
(nonreturn to zero inverted). 
The default value is NRZ. When 
configuring an AS/400 computer for 
an SDLC connection, the AS/400 
default value is NRZI.

Line type
Select Switched for a switched

line.

Select Nonswitched for a 
nonswitched line.

Hold Request to Send 
(RTS) continuously

This check box is unavailable if the 
Capable of multiple station addresses
check box is selected.

Select this check box to 
instruct the SDLC driver to hold the 



RTS signal high all the time.
If you select this check box, your 
modem must be able to support 
full-duplex (FDX) data 
transmission.

Clear this check box if you are 
using a multipoint or dial-up line.

Adapter startup status Select one of the following options. 
This field is provided primarily to 
allow you to disable a data link 
adapter that is malfunctioning or that
needs to be tested before going 
online.

In service
If you select this option, the 
adapter is automatically enabled 
when you load NetWare for SAA.
This is the default.

Out of service
If you select this option, the 
adapter is not enabled when you 
load NetWare for SAA, thereby 
preventing access to other SNA 
nodes through the out-of-service 
adapter.

Related Topics

Configuring 802.2 Adapter Definitions 
Configuring Custom Adapter Definitions 
Configuring QLLC Adapter Definitions 
Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 



SDLC Adapter Fields
Click the field you want described.

Logical adapter name
Adapter type
Terminate peer link if no active APPC 
sessions
Logical adapter number
Capable of multiple station addresses
Default local station address

Local station role
Encoding option for data link adapter
Line type
Hold Request to Send (RTS) continuously
Adapter startup status



Configuring QLLC Adapter Definitions         

Define QLLC data link adapter definitions to configure NetWare for SAA for a QLLC 
connection between a NetWare for SAA server and a host or another SNA node on the 
network.
Configure new or existing QLLC adapter definitions by taking the following steps:
1. If you have not already done so, either create the QLLC data link adapter you want to 

configure, or locate and open an existing data link adapter.
Doing so displays the Description page of the Data Link Adapter Information dialog book.

2. With the Description    page displayed, edit as instructed in the following table and then 
click OK.
To jump to a particular field description, click here.

Note: A modified QLLC adapter definition will not take effect until you unload and reload
the QLLC protocol stack and X.25 driver. For details, see the NetWare for SAA 2.0 
Administration Guide for Mainframes and Peer Nodes.

Field Instruction
Logical adapter name Type a logical adapter name that 

matches one of the adapter names 
entered in the AUTOEXEC.NCF file.

Adapter type You cannot edit this field, which 
indicates that the adapter describes a
QLLC data link adapter.

Terminate peer link if 
no active APPC 
sessions

Select this check box to 
instruct NetWare for SAA to terminate
the QLLC data link to the peer node if
there are no active sessions. This is 
the default.

Clear this check box if you 
want to retain the data link to the 
peer node even when there are no 
active sessions running.

Logical adapter 
number

This is a required field.
Type a decimal number from 1 to 3 
digits in length. You can type any 
number from 0 to 255. The logical 
adapter number must be unique 
within a link type.

Local station role for Specify whether the NetWare for SAA 



peer links station role for this QLLC link is 
Secondary or Negotiable.
The default is Negotiable, which is 
the setting typically needed for QLLC 
links.

Adapter startup status Select one of the following options. 
This field is provided primarily to 
allow you to disable a data link 
adapter that is malfunctioning or that
needs to be tested before going 
online.

In service
If you select this option, the 
adapter is automatically enabled 
when you load NetWare for SAA.
This is the default.

Out of service
If you select this option, the 
adapter is not enabled when you 
load NetWare for SAA, thereby 
preventing access to other SNA 
nodes through the out-of-service 
adapter.

Related Topics

Configuring 802.2 Adapter Definitions 
Configuring Custom Adapter Definitions 
Configuring SDLC Adapter Definitions 
Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 



QLLC Adapter Fields
Click the field you want described.

Logical adapter name
Adapter type
Terminate peer link if no active APPC sessions
Logical adapter number
Local station role for peer links
Adapter startup status



Configuring Custom Adapter Definitions         

Note: Before you configure NetWare for SAA for a custom data link adapter, refer to the 
configuration settings recommended by the manufacturer in the documentation 
shipped with the custom data link product.

Define custom data link adapters to configure NetWare for SAA for connections established 
through adapters that do not implement the 802.2, SDLC, or QLLC protocols shipped with 
NetWare for SAA 2.0.
Configure new or existing custom adapter definitions by taking the following steps:
1. If you have not already done so, either create the Custom data link adapter you want to 

configure, or locate and open an existing data link adapter.
Doing so displays the Description page of the Data Link Adapter Information Dialog book.

2. With the Description page displayed, edit as instructed in the following table and then 
click OK.
To jump to instructions for a particular field, click here.

Field Instruction
Logical adapter name Type a logical adapter name that 

matches one of the adapter names 
entered in the AUTOEXEC.NCF file.

Adapter type You cannot edit this field, which 
indicates that the adapter describes a
custom data link adapter.

Terminate peer link if 
no active APPC 
sessions

Select this check box to 
instruct NetWare for SAA to terminate
the custom link to the peer node if 
there are no active sessions. This is 
the default.

Clear this check box if you 
want to retain logical links to the peer
node even when there are no active 
sessions running.

Custom link type Type a text string of letters or 
numbers with a maximum length of 
nine characters.    The name must be 
a descriptive name for your custom 
connection.

Logical adapter 
number

This is a required field.
Type a decimal number from 1 to 3 



digits in length. You can type any 
number from 0 to 255. The logical 
adapter number must be unique 
within a link type.

Local station role for 
peer links

Specify the NetWare for SAA station 
role for peer-to-peer links. If your 
custom application requires this 
information, select either Secondary 
or Negotiable.
The default is Negotiable.

Receive window size Type a number from 1 to 127. This 
number specifies the maximum 
number of information (I) frames that
the custom protocol stack can receive
from a remote station before the 
remote station must pause for 
acknowledgment of the receipt of 
data. NetWare for SAA communicates
this value to the remote station 
during exchange station ID (XID) 
negotiation.
The default value is 7.

Protocol stack name This is a required field.
Type the name of the custom protocol
stack NLM™. This name can be up to 
eight characters long. It must match 
the name provided by the third-party 
developer.

Balanced protocol 
Select this check box if your 

custom adapter uses a balanced 
protocol.

Clear this check box if your 
custom adapter does not employ a 
balanced protocol. This is the default.

Multiple logical links
Select this check box if your 

custom protocol stack supports 
multiple concurrent logical links.

Clear this check box if your 
custom protocol stack uses only a 
single logical link. This is the default



Adapter startup status Select one of the following options. 
This field is provided primarily to 
allow you to disable a data link 
adapter that is malfunctioning or that
needs to be tested before going 
online.

In service
If you select this option, the 
adapter is automatically enabled 
when you load NetWare for SAA.
This is the default.

Out of service
If you select this option, the 
adapter is not enabled when you 
load NetWare for SAA, thereby 
preventing access to other SNA 
nodes through the out-of-service 
adapter.

Related Topics

Configuring 802.2 Adapter Definitions 
Configuring QLLC Adapter Definitions 
Configuring SDLC Adapter Definitions 
Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 



Custom Adapter Fields
Click the field you want described.

Logical adapter 
name
Adapter type
Terminate peer link
if no APPC sessions
Custom link type
Logical adapter 
number

Local station role for 
peer links
Receive window size
Protocol stack name
Balanced protocol
Multiple logical links
Adapter startup status



Configuring Host PU Profiles (Overview)     

After configuring NetWare for SAA for data link adapters, configure a Host PU profile to 
describe NetWare for SAAs PU emulation and to describe the connection to the host.
You can define multiple PU emulations within a NetWare for SAA server by creating multiple 
Host PU profiles.
Note: You can create a Host PU profile only after you define the data link adapter that 

establishes the connection the Host PU profile is to describe.

You configure a Host PU profile by performing the following tasks:

Configure the Host PU profiles description information.
This task includes specifying the number of LUs, certain peripheral node parameters, and
relevant connection type information. The information you supply varies according to the
connection type of the data link adapter you assign to the PU profile. For details on 
configuring a Host PU profile Description page, click here.

Configure defaults for any dependent LUs associated with the Host PU 
profile.

For details on this task, click here.

Add notes that you want to include to further describe the PU profile.
For details on this task, click here .

For details on specifying a Host PU profile devoted to offline testing, click here.



Configuring Host PU Profile Description Information    
Note: You can specify 802.2, SDLC, QLLC, or custom connection information for a Host PU 

profile    only after you define the data link adapter that establishes the connection 
that the Host PU profile is to describe.

To configure information for a Host PU profile, take the following steps:
1. If you have not already done so, either create the Host PU profile you want to configure, 

or locate and open an existing Host PU profile. This displays the Host PU profile's 
Description page.

2. With the Host PU profile's Description page displayed, edit as instructed in the following 
table and then click OK.    Use the Configure Host PU Profile Worksheet to help you 
configure.
To jump to instructions for a particular field, click here.

Note: To set a workable starting dependent LU address, keep the number of dependent 
LUs in mind. For information about the relationship between the Number of 
dependent LUs field and the Starting dependent LU address field, click here.

Field Instruction
PU profile name Type a Host PU profile name that has 

the following characteristics:

The name must be unique 
within the NetWare for SAA server. It 
cannot be the same as an existing PU
profile name.

The maximum length is eight 
alphanumeric characters (0 through 9
and uppercase A through Z).

The name does not include 
certain special characters. For a list 
of these characters, click here.

Number of dependent 
LUs

Type the number of dependent 
sessions you want defined for this 
Host PU profile.
This number should match the 
number of LUs defined in the host 
configuration. The maximum number 
of dependent LUs that can be 
configured for a single Host PU profile
is 254.
If you set an initial number of 
dependent LUs and then increase this
number, the additional dependent 
LUs will be configured as specified in 
the PU profile's current LU Defaults 
page.



Starting dependent LU
address

Type the starting LU address for the 
dependent LUs you define for the 
current Host PU profile. The starting 
dependent LU address can range 
from 1 to 254. The default is 2.
Once you create a Host PU profile 
with a certain starting dependent LU 
address, you cannot subsequently 
modify the starting address. If you 
need to reset the starting dependent 
LU address, delete the Host PU profile
and create a new one with the 
appropriate starting LU address.

Peripheral node 
control point name

Type the name of the PU2.1 
peripheral node control point that the
NetWare for SAA server is emulating. 
Each PU2.1 node within an SNA 
network must have a unique control 
point name. 
The default is the PU profile name.

Node ID
(block/PU ID)

Type the node ID.

Offline test mode Leave this check box unselected to 
support the PU profile's 802.2 
connection.

Selecting this check box puts 
your PU profile in offline test mode.

The PU profile's    802.2 
connection settings are disabled, 
and it is used for testing purposes
only.

Clearing this check box turns 
off the offline test mode and restores 
the previous 802.2 connection 
settings.

Assign only LUs 
activated by the host Select this check box when 

you want NetWare for SAA to assign 
only LUs that have been activated by 
the host.    Selecting this option 
prevents attaching workstations from
being assigned inactive LUs.    This 
box is selected by default.



Clear this check box to allow 
NetWare for SAA to assign LUs not 
yet activated by the host to 
workstations. Clearing this check box 
makes possible the following option--
Call host on workstation attach.

Call host on 
workstation attach Select this check box if you 

want NetWare for SAA to link to a 
host only after a workstation attaches
to NetWare for SAA. 

If this check box is selected, 
NetWare for SAA activates the link
to the host when the first 
workstation attaches to the 
current PU. After the last 
workstation detaches from the 
current PU, NetWare for SAA 
deactivates the link to the host.

Note: For this selection to work on 
dial-out SDLC lines, the 
connecting device must be 
able to respond to the RS232 
data transmission ready (DTR)
signal that is raised by 
NetWare for SAA on the first 
workstation attach.

Clear this check box if you 
want the host to be connected 
whenever    NetWare for SAA is 
loaded, whether or not a workstation 
is attached. A cleared check box is 
the default.

NetWare for SAA Administrator 
automatically clears this check 
box if you select the Assign only 
LUs activated by the host check 
box. 

Logical adapter name Select a logical adapter name from 
the drop-down list box. This list box 
lists the logical adapter name of each
data link adapter definition on the 
current NetWare for SAA server.
The logical adapter name you select 
triggers the display of additional 
adapter-related fields on the page.



Maximum frame size 
to transmit inbound

Select a value from the drop-down list
box to specify the default value 
NetWare for SAA uses if the Host PU 
profile is emulating a PU2.0 node.
The selected value is the maximum 
number of bytes to be included in 
frames sent to the host. The value

Must match the MAXDATA 
value in the host definition

Should not exceed the value 
configured for the Set maximum 
physical receive packet size 
parameter defined in your 
STARTUP.NCF file

802.2 remote node 
address
(802.2 connections 
only)

Type the remote node address noted 
on your configuration worksheets.
The default is 4000 00000000 hex.

802.2 remote service 
access point
(802.2 connections 
only)

Type the remote service access point 
noted on your configuration 
worksheets.
The default is 04 hex.

802.2 local service 
access point
(802.2 connections 
only)

Type the local service access point 
noted on your configuration 
worksheets.
The default is 04 hex.
The maximum value in this field is 
determined by the number of local 
SAPs configured in the 802.2 adapter 
definition's dialog book.

Local station address 
for multipoint link
(SDLC connections 
only)

This field is displayed only if the 
Capable of multiple station addresses
check box is selected in the SDLC 
adapter definition's dialog book.
Type the NetWare for SAA local 
station address for an SDLC 
multipoint configuration in which a    
Host PU profile or peer-to-peer link is 
one of the secondary stations on the 
multipoint link.
When you are connecting to a host, 
this address must match the value in 



the host configuration.
The default value is C1 hex.

QLLC call support 
layer target name
(QLLC connections 
only)

Type the CSL target name as 
configured in the CSL database. The 
name can be up to 16 characters in 
length.
The target name contains    the 
destination address and the X.25 
parameters for the virtual circuit.
If you are using the NetWare 
MultiProtocol Router PlusTM 2.1 or 3.0 
drivers, or the NetWare Link/X.25TM 
2.1 or 3.0 drivers, the QLLC call 
support layer target name field must 
match the Call Destination field in the
INETCFG utility Internetworking 
Configuration > WAN Call Directory >
Configured WAN Call Destinations 
menu.

Local station role
(QLLC and custom 
connections)

Select one of the following options to 
specify the NetWare for SAA station 
role for the QLLC or custom Host or 
peer link:

Negotiable
This is the default.

Secondary
This field supplements the Local 
station role for peer links field in the 
QLLC adapter definition's dialog book 
and the custom adapter definition's 
dialog book. You can configure the 
local station role uniquely for both 
host links and peer links.

Custom data link 
target name
(Custom connections 
only)

Use this field to provide a symbolic 
address for the custom link adapter 
or enter information that the custom 
data link may use to establish 
connections (for example, an address
key).
The name can be up to 16 characters
in length. See your custom data link 
documentation for details as to how it
is implemented.



The CSStatus and the NetWare for 
SAA Services Manager utilities 
display this name. For more 
information, see the NetWare for SAA 
2.0 Administration Guide for 
Mainframes and Peer Nodes and the 
NetWare for SAA Services Manager 
Guide.

PU profile startup 
status

Select one of the following options to 
specify whether the PU profile is 
activated automatically when you 
bring up NetWare for SAA:

Enabled
Select this option if you want the 
Host PU profile activated 
automatically. This is the default.

Disabled
Select this option if you do not 
want the Host PU profile activated
automatically.

Related Topics

Configuring Host PU Profiles (Overview) 
Configuring Default LU Information 
Configuring a Host PU Profile in Offline Test Mode
Copying PU Profiles 
Making Notes about a PU Profile 
Host Connection Configuration Task Summary 



Host PU Profile Description Fields
Click the field you want described.

PU profile name
Number of 
dependent LUs
Starting dependent
LU address
Peripheral node 
control point name
Node ID (Block/PU 
ID)
Offline test mode
Assign only LUs 
activated by the 
host
Call host on 
workstation attach
Logical adapter 
name

Maximum frame size to 
transmit inbound
802.2 remote node 
address
802.2 remote service 
access point
802.2 local service 
access point
Local station address for 
multipoint link
QLLC call support layer 
target name
Local station role
Custom data link target 
name
PU profile startup status



Configuring a Host PU Profile in Offline Test Mode        

Sometimes you might need to configure a "Host" PU profile with no connection to the host 
for offline testing purposes.    In that case, select the Offline test mode check box in the PU 
profile's Description page.
To configure a PU profile in offline test mode, take the following steps:
1. If you have not already done so, either create the PU profile you want to configure, or 

locate and open an existing PU profile. This displays the PU profile's Description page.
2. With the PU profile's Description page displayed, edit as instructed in the following table 

and then click OK. Use the Configure Host PU Profile Worksheet to help you configure.

Note: To set a workable starting dependent LU address, keep the number of dependent 
LUs in mind. For information about the relationship between the Number of 
dependent LUs field and the Starting dependent LU address field, click here.

Field Instruction
PU profile name Type a PU profile name that has the 

following characteristics:

The name must be unique 
within the NetWare for SAA server. It 
cannot be the same as an existing PU
profile name.

The maximum length is eight 
alphanumeric characters (0 through 9
and uppercase A through Z).

The name does not include 
certain special characters. For a list 
of these characters, click here.

Number of dependent 
LUs

Type the number of dependent 
sessions you want defined for this PU 
profile.
This number should match the 
number of LUs defined in the host 
configuration. The maximum number 
of dependent LUs that can be 
configured for a single PU profile is 
254.
If you set an initial number of 
dependent LUs and then increase this
number, the additional dependent 
LUs will be configured as specified in 
the PU profile's current LU Defaults 
page.



Starting dependent LU
address

Type the starting LU address for the 
dependent LUs you define for the 
current PU profile. The starting 
dependent LU address cannot exceed
254. The default is 2.
Once you create a PU profile with a 
certain starting dependent LU 
address, you cannot subsequently 
modify the starting address. If you 
need to reset the starting dependent 
LU address, delete the PU profile and 
create a new one with the 
appropriate starting LU address.

Peripheral node 
control point name

Type the name of the PU2.1 
peripheral node control point that the
NetWare for SAA server is emulating. 
Each PU2.1 node within an SNA 
network must have a unique control 
point name. 
The default is the PU profile name.

Node ID
(block/PU ID)

Type the node ID.

Offline test mode
Select this check box to 

enable the offline test.
When you enable this test, 
NetWare for SAA sets all the LUs 
to Display (LU type 2).

Clear this check box to turn off
the offline test.

Assign only LUs 
activated by the host Select this check box when 

you want NetWare for SAA to assign 
only LUs that have been activated by 
the host.    Selecting this option 
prevents attaching workstations from
being assigned inactive LUs.    This 
box is selected by default.

Clear this check box to allow 
NetWare for SAA to assign LUs not 
yet activated by the host to 
workstations. Clearing this check box 
makes possible the following option--



Call host on workstation attach.

Call host on 
workstation attach Select this check box if you 

want the host to be called only when 
a workstation attaches to NetWare for
SAA. 

If this check box is selected, 
NetWare for SAA activates the link
to the host when the first 
workstation attaches to the 
current PU. After the last 
workstation detaches from the 
current PU, NetWare for SAA 
deactivates the link to the host.

Clear this check box if you 
want the host to be connected 
whenever    NetWare for SAA is 
loaded, regardless of whether a 
workstation is attached or not. A 
cleared check box is the default.

NetWare for SAA Administrator 
automatically clears this check 
box if you select the Assign only 
LUs activated by the host check 
box. 

PU profile startup 
status

Select one of the following options to 
specify whether the PU profile is 
activated automatically when you 
bring up NetWare for SAA:

Enabled
Select this option if you want the 
PU profile activated automatically.
This is the default.

Disabled
Select this option if you do not 
want the PU profile activated 
automatically.

Related Topics

Configuring Host PU Profiles (Overview) 
Configuring Host PU Profile Description Information 
Configuring Default LU Information 
Copying PU Profiles 



Making Notes about a PU Profile 



Configuring Default LU Information     

Configure default attributes for the LUs of a Host PU profile if you have not previously 
configured those LUs and if the Number of dependent LUs field in the PU profile's Description
page contains a value greater than 0. 
The default attributes you set apply to the following:

LUs initially configured when you create the Host PU profile

LUs that you subsequently add to the Host PU profile
To configure default values for a PU profile's LUs, take the following steps:
1. If you have not already done so, display the PU profile's LU Defaults page as follows. If 

that page is already open, go to Step 2.
1a. Either create the Host PU profile you want to configure or locate and open an existing

Host PU profile. This opens up the Host PU profile's dialog book.
1b. Click the LU Defaults page icon.

2. Edit the LU Defaults page as instructed in the following table and then click OK.
To jump to instructions for a particular field, click here.
Although the default values you specify in the LU Defaults page might suffice, you will 
likely have to edit individual LUs to match the configuration on the host.

Field Instruction
Default LU category Select one of the following options to 

initialize the LU category for all the 
LUs in the current PU profile to either 
public or dedicated:

Public
Select this option to initialize the 
LUs as public LUs.
This is the default.

Dedicated
Select this option to initialize the 
LUs as dedicated LUs.

Default LU type Select one of the following options to 
set the default LU type:

Printer (LU type 1 or 3)

Display (LU type 2)
If you select this option, the Model
field becomes available.



APPC (LU type 6.2)

LUx (LU type 0,. 1, 2, or 3)

Model This field is available if you select 
Display (LU type 2) from the Default 
LU type drop-down list box.
Select a display session's model.

VTAM LU name prefix Customize the prefix of the VTAM* LU 
name by typing the desired prefix. 
The allowable characters for the 
prefix are as follows:

Uppercase alphabetic 
characters A through Z. The first 
character must be alphabetic.

0 through 9.

No special characters or 
spaces.
The default prefix is the first six valid 
characters in the PU profile name.

Related Topics

Configuring Host PU Profiles (Overview) 
Configuring Host PU Profile Description Information 
Configuring a PU Profile in Offline Test Mode 
Configuring Default LU Information 
Copying PU Profiles 
Making Notes about a PU Profile 
Host Connection Configuration Task Summary 



Host PU Profile Default LU Fields 
Click the field that you want instructions on.

Default LU category
Default LU host
Model host
VTAM LU name prefix



Making Notes about a Host PU Profile     

Make notes about a Host PU profile    if you want to provide more information than that 
specified in the profile's Description and LU Defaults pages. To further describe a Host PU 
profile, take the following steps:
1. If you have not already done so, display the Host PU profile's LU Defaults page as follows.

If that page is already open, go to Step 2.
1a. Either create the Host PU profile you want to configure or locate and open an existing

Host PU profile. This opens up the Host PU profile's dialog book.
1b. Click the Profile Notes page icon.

2. Edit the Profile Notes page as instructed in the following table and then click OK:

Field Instruction
PU profile name You cannot edit this field, which 

contains the name of the PU profile 
you are configuring.

Profile creation date 
and time

NetWare for SAA Administrator 
displays this field only after the PU 
profile is created.
You cannot edit this field, which 
indicates when the PU profile was 
created.

Installation location Type information about the location 
of the server upon which the selected
PU profile resides. Novell 
recommends that you include the 
name and phone number of the 
person to contact, as well as the 
location of manuals and worksheets.
You can type up to 127 characters.

Profile notes Type vital information regarding the 
PU profile.
You can type up to 127 characters.

Related Topics

Configuring Host PU Profiles (Overview) 
Configuring Host PU Profile Description Information 
Configuring Default LU Information 
Copying PU Profiles 



Host Connection Configuration Task Summary 



Profile Notes Fields
Click the field that you want instructions on.

PU profile name
Profile creation date and time
Installation location notes
Profile notes



Copying Host PU Profiles     

Copy a Host PU profile    if you want to create another Host PU profile by duplicating an 
existing one and then modifying the new profile.
To copy a PU profile, take the following steps:
1. Open the Copy PU Profile dialog box as follows. If that dialog box is currently open, go to 

Step 2.
1a. If you have not already done so, log in to the server associated with the PU profile 

you want to copy.
1b. Locate and select the Host PU profile you want to copy.
1c. Choose Functions > Copy PU Profile.

2. In the New PU profile name text box, type a name for the new Host PU profile.
Make sure the name you enter meets Host PU profile name requirements .

3. Click OK.
NetWare for SAA Administrator adds the new Host PU profile to the list of resources for 
the server.
LUs in the original PU profile are copied to the new Host PU profile. NetWare for SAA 
Administrator automatically sets the category of all the LUs in the new Host PU profile to 
Public and assigns those LUs a VTAM LU name prefix based on the new Host PU profile's 
name. The other LU attributes (such as LU type and LU address) remain as configured in 
the original LUs.

After you copy a Host PU profile, configure the new Host PU profile.

Related Topics

Configuring Host PU Profiles (Overview) 
Configuring Host PU Profile Description Information 
Configuring a PU Profile in Offline Test Mode 
Configuring Default LU Information 
Making Notes about a Host PU Profile 



Configuring a Peer PU Profile     

Use the NetWare for SAA Administrator Peer PU Profile dialog book to configure the profile. 
Follow these steps to bring up the Configure Peer PU Profile dialog book:
To configure a Peer PU profile, take the following steps:
1. If you have not already done so, either create the Peer PU profile you want to configure, 

or locate and open an existing Peer PU profile. This displays the Peer PU profile's 
Description page.

2. With the Peer PU profile's Description page displayed, edit as instructed in the following 
table and then click OK. 
To jump to instructions for a particular field, click here.

Field Instruction
Peer PU profile name If you have not already done so, type 

a PU profile name that has the 
following characteristics:

The name must be unique 
within the NetWare for SAA server. It 
cannot be the same as an existing PU
profile name.

The maximum length is eight 
alphanumeric characters (0 through 9
and uppercase A through Z).

The name does not include 
certain special characters. For a list 
of these characters, click here.

Peripheral node 
control point name

Type the name of the PU2.1 
peripheral node control point that the
NetWare for SAA server is emulating. 
Each PU2.1 node within an SNA 
network must have a unique control 
point name. 
The default is the PU profile name.

Node ID
(block/PU ID)

Type the Node ID.
The node ID is a combination of the 
block ID and PU ID.
The three-digit hexadecimal blick ID 
number is an IBM product-specific 
number.    The block ID also matches 
the IDBLK value in the host definition.
The block ID for 3274 nodes is 017 
hex.



The PU ID is a binary station within an
SNA network.

Logical adapter name Select a logical adapter name from 
the drop-down list box. This list box 
lists the logical adapter name of each
data link adapter definition on the 
current NetWare for SAA server.
The logical adapter name you select 
triggers the display of additional 
adapter-related fields on the page.

802.2 service access 
point

This field is displayed when you 
select an Ethernet or a token ring 
adapter. 
Type the local service access point 
noted on your configuration 
worksheets.
The default is 04 hex.
NetWare for SAA uses the same 
service access point (SAP) for both 
remote and local nodes. 
The maximum value in this field is 
determined by the number of local 
SAPs configured in the 802.2 adapter 
definition's dialog book.

Local station address 
for multipoint link

This field is displayed only when the 
Peer PU profile is configured for an 
SDLC adapter and the Capable of 
multiple station addresses option is 
selected in the SDLC adapter 
configuration.
This field determines the NetWare for 
SAA local station addrress for an 
SDLC multipoint configuration in 
which a NetWare for SAA Host PU 
profile or peer-to-peer link is one of 
the secondary stations on the 
multipoint link.
This two-digit hexadecimal address 
must match the ADDR filed in the 
NCP customization file on the 
mainframe host.
The default value is C1 hex or the 
value you configure for the Default 
local station address field in the 
configuration for the SDLC adapter.



PU profile startup 
status

Select one of the following options to 
specify whether the Peer PU profile is 
activated automatically when you 
bring up NetWare for SAA:

Enabled
Select this option if you want the 
Peer PU profile activated 
automatically. This is the default.

Disabled
Select this option if you do not 
want the Peer PU profile activated
automatically.

Related Topics

Peer Connection Configuration Task Summary 
Peer PU Profile Description 
Peer PU Profiles 
Peer Connections 
Configuring the NWSAA Node Description 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 



Peer PU Profile Fields
Click the field that you want instructions on.

Peer PU profile name
Peripheral node control point name
Node ID (Block ID)
Logical adapter name
802.2 service access point
Location address for multipoint link
PU profile startup status



Configuring Downstream PU Definitions (Overview)     

Before traffic can be passed between a NetWare for SAA server and a downstream PU, you 
must define the downstream PU.
You configure a downstream PU definition by performing both of the following tasks:

Describe the downstream PU and connecting data link adapter information.
The data link information you specify depends on the type of link to the downstream PU 
you are defining. For details on configuring a downstream PU definition, click here.
Note: NetWare for SAA does not support SDLC links for downstream PUs.

Map LUs to downstream LUs. 
For details on this task, click here.



Defining Downstream PU Description Information          

To define a downstream PU connected to a NetWare for SAA server through an Ethernet, 
token ring, QLLC, or custom data link, take the following steps.    Use the Configure Host 
Downstream PU Worksheet to help you.
1. If you have not already done so, either create the downstream PU you want to configure, 

or locate and open an existing downstream PU. This displays the downstream PU's 
Description page.

2. With the downstream PU's Description page displayed, edit as instructed in the following 
table and then click OK. Use the Configure Downstream PU Worksheet to help you.
To jump to instructions for a particular field, click here.
Note: To set a reasonable starting downstream LU address, keep the number of 

downstream LUs in mind. For information about the relationship between the 
Number of downstream LUs (DLUs) field and the Starting downstream LU (DLU) 
address field, click here.

Field Instruction
Downstream PU name 
(CP name)

Type a downstream PU name. This 
name must have the following 
characteristics:

The name must be unique 
within the current NetWare for SAA 
server. The name cannot be the same
as an existing downstream PU name.

The maximum length is eight 
alphanumeric characters (0 through 9
and uppercase A through Z).

The first character is 
alphabetic.

No special characters or 
spaces are allowed.

Starting downstream 
LU (DLU) address

Type the starting LU address for the 
downstream LUs you are defining for 
the current downstream PU. The 
starting LU address cannot exceed 
254.
Once you create a downstream PU 
with a certain starting downstream 
LU address, you cannot subsequently 
modify the starting address. If you 
need to reset the starting 
downstream LU address, you must 
delete the downstream PU definition 



and create a new one with the 
appropriate starting LU address.
The default is 2.

Number of 
downstream LUs 
(DLUs)

Type the number of downstream LUs 
associated with the downstream PU.
The downstream LUs can be mapped 
to LUs associated with multiple Host 
PU profiles. You must specify at least 
one downstream LU.
The default is 1.

Logical adapter name Select a logical adapter name from 
the drop-down list box. This list box 
lists the logical adapter name of each
data link adapter definition on the 
current NetWare for SAA server.
After you make your selection in this 
key field, NetWare for SAA 
Administrator displays additional 
adapter-related fields.

Maximum frame size 
to transmit outbound

Specify the maximum number of 
bytes to be included in frames sent 
from the NetWare for SAA server to 
the downstream PU. To do so, select 
the appropriate value for the 
downstream PU you are defining.    
The values included in the drop-down
list depend on the adapter's link type.

Identify downstream 
PU using
(802.2 connections 
only)

Select one of the following options to 
specify the method you want 
NetWare for SAA to use to identify 
the downstream PU. When NetWare 
for SAA is connected to a 
downstream PU through a token ring 
or Ethernet 802.2 link, NetWare for 
SAA can recognize a downstream PU 
in any one of three ways:

CP name
Select this option if you want to 
identify the downstream PU 
through its CP name. This is the 
default.

MAC address



Select this option if you want to 
identify the downstream PU 
through its MAC address.
If you select this option, NetWare 
for SAA Administrator displays the
802.2 remote node address, 
802.2 remote service access 
point, and 802.2 local service 
access point fields.

Node ID
Select this option if you want to 
identify the downstream PU 
through its node ID.
If you select this option, NetWare 
for SAA Administrator displays the
Node ID (block/PU ID) field.

802.2 remote node 
address
(802.2 connections 
only)

This field appears if you select MAC 
address from the Identify 
downstream PU using drop-down list 
box.
Type the remote node address .

802.2 remote service 
access point
(802.2 connections 
only)

This field appears if you select MAC 
address from the Identify 
downstream PU using drop-down list 
box.
Type the remote SAP.
The default is 04 hex.

802.2 local service 
access point
(802.2 connections 
only)

This field appears if you select MAC 
address from the Identify 
downstream PU using drop-down list 
box.
Type the local SAP.
The default is 04 hex.

Node ID
(block/PU ID)
(802.2 connections 
only)

This field appears if you select Node 
ID from the Identify downstream PU 
using drop-down list box.
Type the downstream PU's node ID.

QLLC call support 
layer target name

Type the CSL target name as 
configured in the CSL database.
This field can be up to 16 characters 



(QLLC connections 
only)

in length. The target name contains    
the destination address and the X.25 
parameters for the virtual circuit.
If you are using the NetWare 
MultiProtocol Router Plus 2.1 or 3.0 
drivers, or the NetWare Link/X.25 2.1 
or 3.0 drivers, the QLLC call support 
layer target name field must match 
the Call Destination field in the 
INETCFG utility Internetworking 
Configuration > WAN Call Directory >
Configured WAN Call Destinations 
menu.

Custom data link 
target name
(Custom connections 
only)

Type information that the custom 
data link can use to establish 
connections (for example, a symbolic 
address or address key).
See your custom data link 
documentation for details as to how 
this information is implemented.

Related Topics

Configuring Downstream PUs (Overview) 
Assigning Users to Resources 
Mapping LUs to Downstream LUs 
Unmapping LUs 



Downstream PU Fields
Click the field that you want instructions on.

Downstream PU 
name
Starting 
downstream LU 
(DLU) address
Number of 
downstream LUs 
(DLUs)
Logical adapter 
name
Maximum frame 
size to transmit 
outbound
Identify 
downstream PU 
using

802.2 remote node 
address
802.2 remote service 
access point
802.2 local service 
access point
Node ID (Block/PU ID)
QLLC call support layer 
target name
Custom data link target 
name



Mapping LUs to Downstream LUs     

You can map a public LUs in a configured Host PU profile to a downstream LUs residing on a   
downstream PU. For information you need to know before assigning LUs to a downstream 
PU, click here.
Mapping an LU establishes a relationship between the mapped LU and a downstream LU. 
This relationship permits downstream PU users to access host sessions through a NetWare 
for SAA server.
To map    LUs to    downstream LUs ,take the following steps:

1. Display the Downstream LUs page of the downstream PU to which you want to assign 
LUs, as follows. If that page is already open, go to Step 2.
1a. If you have not already done so, either create and configure the downstream PU you 

require, or locate and open an existing downstream PU. 
1b. Click the Downstream LUs page icon.
The Downstream LUs page lists each downstream LU and provides information about LUs 
currently mapped to a downstream LU.

2. Select one or more unassigned downstream LUs to which you want to map an LU.    To 
select more that one downstream LU for assignment, hold down <Ctrl> and click the 
downstream LUs you want to map to.

3. Click Map.    

After you click Map, NetWare for SAA Administrator displays the Mapping of DLU dialog 
box.

4. Map an LU to the downstream LU you selected in Step 2 as follows:



4a. From the Current profile drop-down list box, select the PU profile associated with the 
public LUs you want to assign.
NetWare for SAA Administrator displays the selected PU profile's public LUs in the 
Available LUs list box.

4b. In the Available LUs list box, click the public LU you want to assign. 
If you have selected more than one downstream LU for assignment, click the first 
available public LU that you want mapped downstream.    
The public LU that you select will be assigned to the lowest numbered downstream LU
you selected for assignment.    Thereafter, the next higher-numbered available public 
LU will be assigned to the next higher-numbered    selected downstream LU until 
every downstream LU that was selected for assignment has an availble public LU 
mapped to it.

4c. Click OK.

NetWare for SAA Administrator assigns the LUs to the downstream PU and closes the 
Mapping of DLU dialog box. The LU category of the LUs you mapped is automatically 
changed from Public to Mapped.

5. Save the LU assignments and close the Downstream PU Information dialog book by 
clicking OK.

Related Topics

Configuring Downstream PU Definitions (Overview) 
Defining Downstream PU Description Information 
Unmapping LUs 
Host Connection Configuration Task Summary 



Mapping of DLU Dialog Box    
After you click Map, NetWare for SAA Administrator displays the Mapping of DLU dialog box. 
Map an LU to the selected downstream LU as follows:
1. From the Current profile drop-down list box, select the PU profile associated with the 

public LUs you want to assign.
NetWare for SAA Administrator displays the selected PU profile's public LUs in the 
Available LUs list box.

2. In the Available LUs list box, select the public LU you want to assign.
3. Click OK.

NetWare for SAA Administrator assigns the LU to the downstream PU and closes the 
Mapping of DLU dialog box. The LU category of the LU you mapped is automatically 
changed from Public to Mapped.

Related Topics

Configuring Downstream PU Definitions (Overview) 
Defining Downstream PU Description Information 
Unmapping LUs 
Host Connection Configuration Task Summary 



Unmappping LUs
Unmap a mapped LU to remove its assignment to a downstream PU because you no longer 
want the LU available to users who have access to the downstream device.
To unmap a mapped LU, take the following steps:
1. Locate and open the downstream PU associated with the LUs you want to unmap.    This 

displays the Downstream PU Information dialog book.
2. Click the Downstream LUs page icon to open the Downstream LUs page.
3. Select the LUs you want to unmap.

To select multiple LUs, hold down <Ctrl> while making your selections.
4. Click Unmap.

NetWare for SAA Administrator removes the downstream PU assignments from the 
unmapped LUs.

5. Click OK to save your changes and close the Downstream PU Information dialog book.

Related Topics

Configuring Downstream PU Definitions (Overview) 
Defining Downstream PU Description Information 
Mapping LUs to Downstream LUs 



Configuring LU Pools          

Configure an LU pool when you want to assign a block of LUs to specific users or user 
groups. For example, you can create one LU pool to assign a block of 15 LUs to a marketing 
department, and another LU pool to assign a block of 20 LUs to an engineering department.
To configure LU pools, take the following steps. Use the Configure LU Pools Worksheet to help
you.
1. If you have not already done so, either create a new LU pool, or locate and open an 

existing LU pool. This displays the LU pool's Description page.
2. If you have not already done so, enter the name of the LU pool in the LU pool name text 

box.
The LU pool name must be unique from other LU pool names on the server. It must begin 
with a letter, contain of a maximum of eight alphanumeric characters, and contain no 
special characters, lowercase letters, or spaces.

3. Click Add to display the Select LU dialog box.
4. From the Current profile drop-down list box, select the Host PU profile    associated with 

the public LUs you want to add.
NetWare for SAA Administrator displays the LUs associated with the selected Host PU 
profile.

5. In the Available LUs list box, select the check boxes of the public LUs you want to assign 
to this pool.
For information you need to know before making your selections, click here.

6. Click OK. 
NetWare for SAA Administrator assigns the selected LUs to the LU pool, changes the 
category of those LUs from Public to Pooled, closes the Select LU dialog box, and returns 
to the LU Pool Information dialog book.

7. Close the LU Pool Information dialog book by clicking OK.

Related Topics

Adding LUs to an LU Pool with the Select LU Dialog Box 
Assigning Users to Resources 
Configuring a Pooled LU 
Deleting LUs from an LU Pool 
Dragging LUs to an LU Pool 
Host Connection Configuration Task Summary 



Assigning LUs to an LU Pool     

Assign public LUs to an LU pool if you want those LUs to be used only by specific users or 
groups.
For information you need to know before assigning LUs to an LU pool, click here.
You can use either of the following methods to assign LUs to an LU pool:

Add LUs to the LU pool with the Select LU dialog box.

Drag the LUs to the LU pool.
Use the Configure LU Pools Worksheet to help you.

Related Topics

Adding LUs to an LU Pool with the Select LU Dialog Box 
Deleting LUs from an LU Pool 
Dragging LUs to an LU Pool 
Host Connection Configuration Task Summary 



Adding LUs to an LU Pool with the Select LU Dialog Box     

To use the Select LU dialog box to add LUs to an LU pool, take the following steps. Use the 
Configure LU Pools Worksheet to help you.
1. If you have not already done so, click Add in the LU pool's Description page to display the

Select LU dialog box.
2. From the Current profile drop-down list box, select the Host PU profile    associated with 

the public LUs you want to assign to this pool.
NetWare for SAA Administrator displays the LUs associated with the selected Host PU 
profile.

3. In the Available LUs list box, select the public LUs you want to assign to this LU pool.
For information you need to know before making your selections, click here.

4. Click OK. 
NetWare for SAA Administrator assigns the selected LUs to the LU pool, changes the 
category of those LUs from Public to Pooled, closes the Select LU dialog box, and returns 
to the LU Pool Information dialog book.

5. Close the LU Pool Information dialog book by clicking OK.

Related Topics

Configuring LU Pools 
Deleting LUs from an LU Pool 
Dragging LUs to an LU Pool 
Host Connection Configuration Task Summary 



Dragging LUs to an LU Pool     

You can quickly assign public LUs to an existing    LU pool by dragging them to that pool.
When assigning LUs through this method, you select the LUs in a view window and then drag
them to the desired LU pool. For information you need to know before making your 
selections, click here.
For details on dragging LUs to an LU pool, see the following figure. Use the Configure LU 
Pools Worksheet to help you.
Note: You cannot scroll while dragging. If the LU pool and the LUs you want to assign cannot

be viewed at the same time in a single view window, display the pool and the LUs in 
separate view windows.

Related Topics

Adding LUs to an LU Pool with the Select LU Dialog Box 
Configuring LU Pools 
Deleting LUs from an LU Pool 
Host Connection Configuration Task Summary 



Deleting LUs from an LU Pool     

Delete LUs from an LU pool if you no longer want those LUs to be included in the LU pool.
To delete LUs from an LU pool, take the following steps:
1. Open the dialog book of the LU pool from which you want to delete LUs.
2. In the table titled LUs assigned to this pool, select the LUs you want to delete from the 

pool.
To select multiple LUs, hold down <Ctrl> while making your selections.

3. Click Delete.
NetWare for SAA Administrator removes the selected LUs from the LU pool. The LUs are 
still available on the NetWare for SAA server as public LUs. 

4. Click OK to save your changes.

Related Topics

Adding LUs to an LU Pool with the Select LU Dialog Box 
Configuring LU Pools 
Dragging LUs to an LU Pool 



Configuring a Server for Hot Standby     

Configure a server for Hot Standby to establish that server as a Hot Standby server.
When configuring a server for Hot Standby, you define a Hot Standby configuration to 
specify the following:

The name of a critical server the Hot Standby server is to monitor.

Host PU profiles    designated for Hot Standby. These Host PU profiles can act as a 
backup for the critical server and can be activated by the Hot Standby server under certain 
conditions. For details on these conditions, click here.
To configure a NetWare for SAA server for Hot Standby, take the following steps:
1. If you have not already done so, either create a new Hot Standby configuration, or locate

and open an existing Hot Standby configuration. This displays the Hot Standby 
Description page.

2. If you are creating a new Hot Standby configuration, select the name of the server you 
want to designate as a critical server.
You can make a selection from the Critical server drop-down list box only when you 
initially define the Hot Standby configuration.

3. Designate which Host PU profiles are to act as    a backup for the critical server.

3a. Select the check box of each Host PU profile you want to designate for Hot Standby.

3b. If necessary, clear the check box of any Host PU profiles that are not to act as a 
backup for the critical server.

4. Click OK to save your configuration.

Related Topic

Hot Standby Service 
Host Connection Configuration Task Summary 



Configuring a Public LU     

To configure a dependent public LU, take the following steps:
1. Locate and double-click the public LU that you want to configure.    This opens    the LU 

Information dialog book.    If that book is already open, skip this step.
2. Edit the dialog book's Description page as instructed in the following table, and then click

OK. 
To jump to instructions for a particular field, click here.

Note: A public LU's dialog book includes the HostPrint page icon. The icon is available, 
however, only after you change the LU's category to Dedicated.

Field Instruction
PU profile You cannot edit this field, which 

identifies the Host PU profile the LU 
belongs to.

LU address You cannot edit this field, which 
identifies the LU address of the LU 
you are configuring.

VTAM LU name Either leave the default VTAM LU 
name, or type another name.
The name can be up to eight 
characters long. The allowable 
characters for the prefix of the VTAM 
LU name are as follows:

Uppercase alphabetic 
characters A through Z. 

The first character must be 
alphabetic.

0 through 9 -- except for the 
first character.

No special characters or 
spaces.

LU type Select one of the following options to 
specify the type of session the LU will
support.

Printer (LU type 1 or 3)

Display (LU type 2)



If you select this option, the Model
field becomes available.

APPC (LU type 6.2)

LUx (LU type 0, 1, 2, or 3)

Model This field is available only if you 
select Display (LU type 2) from the LU
type drop-down list box.
Select a display session's model.

Session lock Use this check box to lock a session 
so that the LU cannot be used.

Select this check box when 
the LU is not performing properly and
you want to ensure that no users can 
access the LU.

Clear this check box if you do 
not want to lock the session.

Preserve host session 
after disconnected Select this check box if you 

want a host session preserved for the
user when his or her connection to 
the NetWare for SAA server 
terminates for any reason.

When this check box is selected, 
any user who obtains the LU 
corresponding to the preserved 
host session will be able to view 
the preserved screen.

Clear this check box if you do 
not want to preserve a host session 
after a connection terminates.

LU category Indicates that the LU is a public LU.
You can use this drop-down list box to
change the category from Public to 
Dedicated.

Related Topics

Configuring a Dedicated LU 
Configuring a Mapped LU 
Configuring a Pooled LU 



Editing Multiple LUs 
Changing Public LUs to Dedicated LUs 



Public LU Fields
Click the field that you want instructions on.

PU profile
LU address
VTAM LU name
LU type

Model
Session lock
Preserve host session 
after disconnect
LU category



Configuring a Dedicated LU     

To configure a dedicated LU, take the following steps:
1. Locate and double-click the dedicated LU that you want to configure.    This opens the LU 

Information dialog book.    If that book is already open, skip this step.
2. Edit the dialog book's Description page as instructed in the following table, and then click

OK. 
To jump to instructions for a particular field, click here.

Field Instruction
PU profile You cannot edit this field, which 

identifies the PU profile that the LU 
belongs to.

LU address You cannot edit this field, which 
identifies the LU address of the LU 
you are configuring.

VTAM LU name Either leave the default VTAM LU 
name, or type another name.
The name can be up to eight 
characters long. The allowable 
characters for the prefix of the VTAM 
LU name are as follows:

Uppercase alphabetic 
characters A through Z. 

The first character must be 
alphabetic.

0 through 9 -- except for the 
first character.

No special characters or 
spaces.

LU type Select one of the following options to 
specify the type of session the LU will
support:

Printer (LU type 1 or 3)
If you select this option, the 
Assign to HostPrint field becomes 
available.



Display (LU type 2)
If you select this option, the Model
field becomes available.

APPC (LU type 6.2)

LUx (LU type 0, 1, 2, or 3)

Model This field is available only if you 
select Display (LU type 2) from the LU
type drop-down list box.
Select a display session's model.

Session lock Use this check box to lock a session 
so that the LU cannot be used.

Select this check box when 
the LU is not performing properly and
you want to ensure that no users can 
access the LU.

Clear this check box if you do 
not want to lock the session.

Preserve host session 
after disconnected Select this check box if you 

want a host session preserved for the
user when his or her connection to 
the NetWare for SAA server 
terminates for any reason.

When this check box is selected, 
any user who obtains the LU 
corresponding to the preserved 
host session will be able to view 
the preserved screen.

Clear this check box if you do 
not want to preserve a host session 
after a connection terminates.

LU category Indicates that the LU is a dedicated 
LU.
You can use this drop-down list box to
change the category from Dedicated 
to Public.

Dedicated LU name Type a unique name that you want to 
assign to the dedicated LU. This 



name

Must be alphanumeric 
(uppercase A to Z and 0 to 9)

Must begin with a letter

Can be up to eight characters 
in length

Assign to HostPrint This field is available if you selected 
Printer (LU type 1 or 3) from the LU 
type drop-down list box.
Select this check box if you plan to 
assign the dedicated LU to the 
NetWare HostPrint ™ utility.

Related Topics

Configuring a Mapped LU 
Configuring a Pooled LU 
Configuring a Public LU 
Configuring a Dedicated LU for NetWare HostPrint 
Editing Multiple LUs 
Changing Dedicated LUs to Public LUs 
Mapping Public LUs to Downstream LUs 
Assigning Public LUs to an LU pool 



Dedicated LU Fields
Click the field that you want instructions on.

PU profile
LU address
VTAM LU name
LU type
Model

Session lock
Preserve host session 
after disconnect
LU category
Dedicated LU name
Assign to HostPrint



Configuring a Mapped LU     

NetWare for SAA Administrator automatically changes an LU's category from Public to 
Mapped when you assign the LU to a downstream PU. 
You can edit the mapped LU's attributes by taking the following steps:
1. Locate and double-click the public LU that you want to configure.    This opens the LU 

Information dialog book.    If that book is already open, skip this step.
2. Edit the dialog book's Description page as instructed in the following table, and then click

OK. 
To jump to instructions for a particular field, click here.

Field Instruction
PU profile You cannot edit this field, which 

identifies the Host PU profile that the 
LU belongs to.

LU address You cannot edit this field, which 
identifies the LU address of the LU 
you are configuring.

VTAM LU name Either leave the default VTAM LU 
name or type another name.
The name can be up to eight 
characters long. The allowable 
characters for the prefix of the VTAM 
LU name are as follows:

Uppercase alphabetic 
characters A through Z. 

The first character must be 
alphabetic.

0 through 9 -- except for the 
first character.

No special characters or 
spaces.

LU type Select one of the following options to 
specify the type of session the LU will
support:

Printer (LU type 1 or 3)

Display (LU type 2)



If you select this option, the Model
field becomes available.

APPC (LU type 6.2)

LUx (LU type 0, 1, 2, or 3)

Model This field is available only if you 
select Display (LU type 2) from the LU
type drop-down list box.
Select a display session's model.

Session lock Use this check box to lock a session 
so that the LU cannot be used.

Select this check box when 
the LU is not performing properly and
you want to ensure that no users can 
access the LU.

Clear this check box if you do 
not want to lock the session.

Preserve host session 
after disconnected Select this check box if you 

want a host session preserved for the
user when his or her connection to 
the NetWare for SAA server 
terminates for any reason.

When this check box is selected, 
any user who obtains the LU 
corresponding to the preserved 
host session will be able to view 
the preserved screen.

Clear this check box if you do 
not want to preserve a host session 
after a connection terminates.

LU category You cannot edit this field, which 
indicates the LU is a mapped LU.

Downstream PU name You cannot edit this field, which 
identifies the downstream PU to 
which the mapped LU is assigned. 
The LU is mapped to a downstream 
LU on this downstream PU.

Downstream LU name You cannot edit this field, which 



identifies the downstream LU that the
LU is mapped to.

Related Topics

Configuring a Dedicated LU 
Configuring a Pooled LU 
Configuring a Public LU 
Configuring Downstream PU Definitions 
Unmapping LUs 
Editing Multiple LUs 



Mapped LU Fields
Click the field that you need instructions on.

PU profile
LU address
VTAM LU name
LU type
Model

Session lock
Preserve host session 
after disconnect
LU category
Downstream PU name
Downstream LU

Configuring a Pooled LU     

NetWare for SAA Administrator automatically changes an LU's category from Public to Pooled
when you assign the LU to an LU pool. 
To configure a pooled LU, take the following steps:
1. Locate and double-click the LU Information dialog book for the pooled LU you want to 

configure. If that book is already open, skip this step.
2. Edit the dialog book's Description page as instructed in the following table, and then click

OK. 
To jump to instructions for a particular field, click here.

Field Instruction
PU profile You cannot edit this field, which 

identifies the Host PU profile that the 
LU belongs to.

LU address You cannot edit this field, which 
identifies the LU address of the LU 
you are configuring.

VTAM LU name Either leave the default VTAM LU 
name or type another name.
The name can be up to eight 
characters long. The allowable 
characters for the prefix of the VTAM 
LU name are as follows:

Uppercase alphabetic 
characters A through Z. 

The first character must be 
alphabetic.

0 through 9 -- except for the 



first character.

No special characters or 
spaces.

LU type Select one of the following options to 
specify the type of sessions the LU 
will support:

Printer (LU type 1 or 3)

Display (LU type 2)
If you select this option, the Model
field becomes available.

APPC (LU type 6.2)

LUx (LU type 0,. 1, 2, or 3)

Model This field is available only if you 
select Display (LU type 2) from the LU
type drop-down list box.
Select a display session's model.

Session lock Use this check box to lock a session 
so that the LU cannot be used.

Select this check box when 
the LU is not performing properly and
you want to ensure that no users can 
access the LU.

Clear this check box if you do 
not want to lock the session.

Preserve host session 
after disconnected Select this check box if you 

want a host session preserved for the
user when his or her connection to 
the NetWare for SAA server 
terminates for any reason.

When this check box is selected, 
any user who obtains the LU 
corresponding to the preserved 
host session will be able to view 
the preserved screen.

Clear this check box if you do 
not want to preserve a host session 
after a connection terminates.



LU category You cannot edit this field, which 
indicates the LU is a pooled LU.

LU Pool name You cannot edit this field, which 
identifies the LU pool that the LU is 
assigned to.

Related Topics

Configuring a Dedicated LU 
Configuring a Mapped LU 
Configuring a Public LU 
Configuring LU Pools
Deleting LUs from an LU Pool 
Editing Multiple LUs 



Pooled LU Fields
Click the field that you need instructions on.

PU profile
LU address
VTAM LU name
LU type
Model

Session lock
Preserve host session 
after disconnect
LU category
PU pool name

Configuring a Dependent LU Assigned to the Application Subsystem        

The icon in the title bar represents an existing dependent APPC LU that was assigned to the 
NetWare for SAA Application Subsystem through the Local LU Information dialog book.    To 
edit the VTAM LU name, Session lock, or Preserve host session after disconnected 
parameters,    take the following steps:
1. If you have not already done so, locate and double-click the LU assigned to the 

Application Subsystem that you want to configure.    This opens    the LU Information 
dialog book.    If that book is already open, skip this step.

2. Edit the dialog book's Description page as instructed in the following table, and then click
OK. 
To jump to instructions for a particular field, click here.
Note: A public LU's dialog book includes the HostPrint page icon. The icon is available, 

however, only after you change the LU's category to Dedicated.

Field Instruction
PU profile You cannot edit this field, which 

identifies the Host PU profile the LU 
belongs to.

LU address You cannot edit this field, which 
identifies the LU address of the LU 
you are configuring.

VTAM LU name Either leave the default VTAM LU 
name, or type another name.
The name can be up to eight 
characters long. The allowable 
characters for the prefix of the VTAM 
LU name are as follows:

Uppercase alphabetic 
characters A through Z. 



The first character must be 
alphabetic.

0 through 9 -- except for the 
first character.

No special characters or 
spaces.

LU type You cannot edit this field.    Only APPC
LUs (LU Type 6.2) can be assigned to 
the Application Subsystem.

Session lock Use this check box to lock a session 
so that the LU cannot be used.

Select this check box when 
the LU is not performing properly and
you want to ensure that no users can 
access the LU.

Clear this check box if you do 
not want to lock the session.

Preserve host session 
after disconnected Select this check box if you 

want a host session preserved for the
user when his or her connection to 
the NetWare for SAA server 
terminates for any reason.

When this check box is selected, 
any user who obtains the LU 
corresponding to the preserved 
host session will be able to view 
the preserved screen.

Clear this check box if you do 
not want to preserve a host session 
after a connection terminates.

LU category You cannot edit this field.    The value 
in this field (Application Subsystem) 
indicates that the LU is an APPC LU    
assigned the the NetWare for SAA 
Application Subsystem.

Related Topics

Configuring a Dependent Local LU 



Configuring a Dedicated LU 
Configuring a Mapped LU 
Configuring a Pooled LU 
Editing Multiple LUs 



Application Subsystem Dependent LU Fields
Click the field that you need instructions on.

PU profile
LU address
VTAM LU name
LU type

Session lock
Preserve host session 
after disconnect
LU category



Changing an LU's Category  

    

When creating a PU profile, you define all the LUs associated with that PU profile as either 
public or dedicated LUs. After you create the PU profile you can change an LU's category 
from

Public to Dedicated
For details on this task, click here.

Dedicated to Public
For details on this task, click here.

Public to Mapped
NetWare for SAA Administrator makes this change automatically when you map the LU to
assign it to a downstream PU.

Public to Pooled
NetWare for SAA Administrator makes this change automatically when you assign the LU 
to an LU pool.



Changing Public LUs to Dedicated LUs
To change a public LU to a dedicated LU take the following steps:
1. Locate and double-click the LU you want to change.

After you double-click the LU, NetWare for SAA Administrator opens an LU Information 
dialog book.

2. Change the LU's category by selecting Dedicated from the LU category drop-down list 
box.
NetWare for SAA Administrator changes the LU's category from Public to Dedicated. The 
options that let you configure the dedicated LU become available in the dialog book's 
Description page.

3. Edit the Description page as necessary and then click OK.

Related Topic

Configuring a Dedicated LU 



Changing Dedicated LUs to Public LUs        

To change a dedicated LU to a public LU take the following steps:
1. Locate and double-click the LU you want to change.

After you double-click the LU, NetWare for SAA Administrator opens an LU Information 
dialog book.

2. Change the LU's category by selecting Public from the LU category drop-down list box.
NetWare for SAA Administrator changes the LU's category from Dedicated to Public. The 
options that let you configure the public LU become available in the dialog book's 
Description page.

3. Edit the Description page as necessary and then click OK.

Related Topic

Configuring a Public LU



Editing Multiple LUs     

 

 

      

Note: The LUs you edit with this method must be associated with the same PU profile.

You can select multiple LUs to edit simultaneously, assigning one or more common attributes
to the selected LUs.
To edit multiple LUs, take the following steps:
1. Locate and display the LUs you want to edit in the view window.
2. Hold down <Ctrl> while selecting each LU you want to edit.
3. Choose Object > Details.

NetWare for SAA Administrator prompts you to confirm that you want to configure all the 
selected LUs to have the same attributes.

4. Click OK.
NetWare for SAA Administrator opens the Multiple LU Information dialog book.

5. Edit the Description page as instructed in the following table, and then click OK.
To jump to instructions for a particular field, click here.

Field Instruction
PU profile You cannot edit this field, which 

identifies the Host PU profile 
associated with the selected LUs.

(Selected LUs) You cannot edit this display box, 
which displays each selected LU's 
icon, LU address, and VTAM LU name.

LU type This field specifies the type of LU 
session the selected LUs will support.

Leave this field unset or select
As is to allow each selected LU to 
mainain its individual current LU type 
setting.

Otherwise, specify that the 
selected LUs support either Printer 
(LU type 1 or type 3), Display (LU 
type 2), APPC (LU type 6.2), or LUx 



(LU type 0, 1, 2, or 3) sessions.

Model If you specify an LU type 2 (display), 
this field is activated and specifies 
the model number of the monitor 
supported by the selected LUs.    The 
model number determines the 
number of rows and columns 
displayed on the workstation screen.

Leave this field unset or select
As is to allow each selected LU to 
mainain its individual current model 
setting.

Otherwise, specify that the 
selected LUs support either Model 2 
(24 x 80), Model 3 (32 x 80), Model 4 
(43 x 80), or Model 5 (27 x 132).

Session lock This field enables or disables session 
locking on the selected LUs. Locking 
their sessions makes the selected LUs
unavailable for use. You may want to 
enable this field when the selected 
LUs are not acting properly and you 
want to ensure that no users can 
access them. 

Leave this field unset, or 
select As Is to allow each selected LU 
to maintain its individual current 
session lock setting.

Select Enabled to lock 
sessions on all the selected LUs. 

Select Disabled to unlock the 
sessions on all the selected LUs.

Preserve host session 
after disconnect

This field preserves or clears the host
sessions of the selected LUs when the
users connection to the NetWare for 
SAA server terminates for any 
reason. When this field is enabled, 
any user who obtains an LU 
corresponding to the preserved host 
session can view the preserved 
screen.

Leave this field blank or select
As Is to allow each selected LU to 



maintain its individual current 
setting.

Select Enabled to preserve the
users host session for all the selected
LUs after a connection terminates. 

Select Disabled to clear the 
users host session for all the selected
LUs after a connection terminates.

Deassign from 
HostPrint Select this check box if you 

want to deassign your selected LUs 
from NetWare HostPrint.

If you select this check box, any 
selected LU that was assigned to 
NetWare HostPrint is deassigned.

Clear this check box if you 
want any selected LU already 
assigned to NetWare HostPrint to 
remain so.

Related Topic

Deassigning Multiple LUs from NetWare HostPrint 



Multiple LU Fields
Click the field that you need instructions on.

PU profile
(Selected LUs)
LU type
Model

Session lock
Preserve host session 
after disconnect
Deassign from HostPrint

Configuring a Dedicated LU for NetWare HostPrint        

Dedicated LUs can be configured to support the NetWare HostPrint utility. When you 
configure a dedicated LU for NetWare HostPrint, you first configure the LU to support printer 
(type 1 or 3) sessions. Then you configure NetWare HostPrint options for the dedicated LU.
To configure a dedicated LU for NetWare HostPrint, take the following steps:
1. Locate and double-click the dedicated LU you want to configure.

After you double-click the LU, NetWare for SAA Administrator opens that LU's dialog book.
2. If you have not already done so, select Printer (LU type 1 or 3) from the LU type drop-

down list box included in the LU's Description page.
3. If you have not already done so, select the Assign to HostPrint check box in the LU's 

Description page.
4. Click the HostPrint page icon.

NetWare for SAA Administrator displays a HostPrint page.
5. Configure the LU for NetWare HostPrint by editing the HostPrint page as instructed in the 

following table. Then click OK.
To jump to instructions for a particular field, click here.

Field Instruction
PU profile name You cannot edit this field, which 

identifies the Host PU profile 
associated with the LU.

LU address You cannot edit this field, which 
identifies the address assigned to the
LU when it was configured.

VTAM LU name You cannot edit this field, which 
identifies the VTAM LU name 
assigned to the LU when it was 
configured.

Dedicated LU name You cannot edit this field, which 
identifies the name assigned to the 



LU when it was configured.

Print job name Select a print job name from the 
drop-down list box.

Print job timeout value Type the number of seconds you want
the host session to wait without 
receiving data before it closes a print 
job.
After the specified time has elapsed, 
NetWare HostPrint closes the current 
print job being spooled to the 
NetWare print queue so it can be 
printed. If the timeout value is 0 
(zero), the current print job remains 
open.

EBCDIC code page ID Type the ID number of the EBCDIC 
code page for the data being sent by 
your host printer application.
The number 037, used by most U.S. 
applications, is the default.

Start printer session 
automatically Select this check box if you 

want the host printer session to start 
automatically when NetWare 
HostPrint is loaded. 

If you clear this check box, 
you must use NetWare HPCONSOL to 
manually instruct the host session to 
start the printer session.

Return an OP check 
for invalid code errors Select this check box to 

specify that NetWare HostPrint is to 
reject invalid data received from the 
host (with Sense Code 1003 hex). 

If you clear this check box, 
invalid data is printed as a hyphen 
(-).

Return an OP check 
for LU1 null code 
errors

Select this check box to 
specify that NetWare HostPrint is to 
reject null codes received from the 
host on an LU1 session (with Sense 



Code 1003 hex). 

If you clear this check box, the
value specified for the Hex value to 
send to printer for LU1 null field will 
be sent to the printer.

Close print job when 
end bracket received Select this check box if you 

want NetWare HostPrint to 
automatically close the current print 
job whenever an SNA end-bracket 
flag is received from the host.

If you clear this check box, a 
print job being spooled to a NetWare 
print queue will continue to 
accumulate and will not print until 
one of the following occurs:

An Unbind command is 
received to terminate the host 
session.

The timeout expires.

You manually turn off (stop) 
the printer session using either 
HPCONSOL or NetWare for SAA 
Services Manager.

Translate LU1 
transparent data from 
EBCDIC to ASCII

Select this check box to 
translate transparent data received in
an LU1 printer session from EBCDIC 
to ASCII (just like normal, printable 
data). 

If you clear this check box, 
LU1 transparent data is sent to the 
printer untranslated (that is, exactly 
as received from the host).

Allow print lines longer
than 132 characters 
for LU3

Select this check box to allow 
an LU3 session to print more than 
132 characters per line (MPP). 

If you clear this check box, 
LU3 sessions will use an MPP value of 
132 even if a larger MPP value is 
specified. The default value can be 
overridden by HPCONSOL, or 



NetWare for SAA Services Manager, 
or in an LU1 data stream from the 
host.

Hex value to send to 
printer for LU1 null

This field is available only when the 
Return an Op Check for LU1 null code
errors check box is clear.
Type a two-digit hex value to be sent 
to the printer when a null code is 
received. Typical values are 00 (null), 
20 (blank), and 2D (hyphen).

Lines per inch (LPI) Type a numeric value that represents 
the number of lines to be printed per 
inch.
Standard LPI values are 3, 4, 6, and 
8.

Lines per page (MPL) Type a numeric value that represents 
the height of the print page (MPL).
This value is used at the start of each
print job that is spooled to the 
NetWare print queue. The height of 
66 lines for standard 11inch-long 
paper at 6 LPI is automatically 
inserted.

Chars per line (MPP) Select a numeric value that 
represents the width in characters of 
the print line (MPP). 
This value is used at the start of each
print job that is spooled to the 
NetWare print queue. The value 132 
is automatically inserted.

Related Topics

Assigning Users to Resources 
Configuring a Dedicated LU 
Deassigning Dedicated LUs from NetWare HostPrint



HostPrint LU Fields
Click the field that you need instructions on.

PU profile
LU address
VTAM LU name
Dedicated LU 
name
Print job name
Print job timeout 
value
EBCDIC code page 
ID
Start printer 
session 
automatically
Return an OP 
check for invalid 
code errors
Return an OP 
check for LU1 null 
code errors

Close print job when end
bracket received
Translate LU1 
transparent data from 
EBCDIC to ASCII
Allow print lines longer 
than 132 characters for 
LU3
Hex balue to send to 
printer for LU1 null
Lines per inch (LPI)
Lines per page (MPL)
Chars per line (MPP)
PU profile

Deassigning Dedicated LUs from NetWare HostPrint        

After you assign a dedicated LU to NetWare HostPrint, you can deassign it.

For details on deassigning a single dedicated LU, click here.

For details on deassigning multiple dedicated LUs, click here.

Related Topic

Configuring a Dedicated LU for NetWare HostPrint 



Deassigning a Single LU from NetWare HostPrint        

To deassign a single dedicated LU from NetWare HostPrint, take the following steps:
1. Locate and double-click the LU that you want to deassign from NetWare HostPrint.

After you double-click the LU, NetWare for SAA Administrator opens that LU's dialog book.
2. Clear the Assign to HostPrint check box.
3. Click OK.
The printer that was previously assigned to NetWare HostPrint is now deassigned.

Related Topic

Deassigning Multiple LUs from NetWare HostPrint 



Deassigning Multiple LUs from NetWare HostPrint        

You can deassign more than one dedicated LU from NetWare HostPrint at a time. To deassign
multiple LUs from NetWare HostPrint at the same time, take the following steps:
1. Holding down <Ctrl>, select two or more dedicated LUs assigned to NetWare HostPrint 

that you now want to deassign. 
2. Choose Object > Details.

NetWare for SAA Administrator displays the Multiple LU Information dialog book.
3. Select the Deassign from HostPrint check box.
4. Click OK.

Any selected printer LU that was previously assigned to NetWare HostPrint is now 
deassigned.

Related Topics

Deassigning a Single LU from NetWare HostPrint 
Editing Multiple LUs 



Assigning Users to Resources        

 
 

    

Assign users to a resource if you want to limit who can access that resource. You can assign 
users to the following resources:

Dedicated LUs

LU pools

Downstream PUs available on an Ethernet or token ring (802.2) data link
Users assigned to a dedicated LU can access that LU. Users assigned to an LU pool or 
downstream PU can access any available LU in the pool or downstream PU to which the 
users are assigned.
Note: If you do not assign specific users to a resource, all the NetWare for SAA server's 

users are automatically granted access to the resource.

For details on assigning users to resources on a serving running:

NetWare 3.12, click here. 

NetWare 4.1, click here. 



Assigning Users to Resources (under NetWare 3.12)     

 

 

    

You assign users to a resource by selecting the names of any users and groups to which you 
want to grant access. To do so, take the following steps:
1. Open the Assign Users dialog box as follows. If that dialog box is currently open, go to 

Step 2.
1a. In the view window, locate and select the server resource (dedicated LU, LU pool, or 

downstream PU) to which you wan to assign users.
1b. Choose Functions > Assign Users.

The Assign Users dialog box identifies the resource you are assigning users to and 
lists the users and groups currently authorized to use that resource.

Note: An empty Authorized users list box indicates that all the NetWare for SAA 
server's users and groups have access to the resource.

2. Click Add to open the Add Users dialog box.
3. In the Select authorized users list box, select any users and groups you want to assign to 

the resource.
To select more than one user, hold down the <Ctrl> key while clicking the users you 
want to assign.    To select a block of users, hold down the <Shift> key while clicking the 
first and last users in the block.



Note: In addition to using your mouse, you can also select users by using your arrow keys 
to highlight usernames and pressing the spacebar.
4. Click OK. 

NetWare for SAA closes the Add Users dialog box and returns to the Assign Users dialog 
box. The user and group names selected in the Add Users dialog box are added to the 
Authorized users list box.

5. If the Authorized users list box includes a user or group that you do not want to grant 
access to, select the user or group name in the Authorized users list box and click Delete.

6. Close the Assign Users dialog box by clicking OK.

Related Topics

Deleting User Assignments 
Assigning Users to Resources (under NetWare 4.1)



Assigning Users to Resources (under NetWare 4.1)        

 

 

    

You assign users to a resource by selecting the names of any users and groups to which you 
want to grant access. To do so, take the following steps:
1. Open the Assign Users dialog box as follows. If that dialog box is currently open, go to 

Step 2.
1a. In the view window, locate and select the server resource (dedicated LU, LU pool, or 

downstream PU) to which you wan to assign users.
1b. Choose Functions > Assign Users.

The Assign Users dialog box identifies the resource you are assigning users to and 
lists the users and groups currently authorized to use that resource.

Note: An empty Authorized users list box indicates that all the NetWare for SAA 
server's users and groups have access to the resource.

2. Click Add to open the Add Users dialog box.
3. If you are configuring NetWare for SAA on a server running NetWare 4.1, specify the 

context of users or groups you want to assign.

To specify the next higher context level in the Current context list box, click the up 
arrow that appears in the context navigation box.

To specify the next lower context level in the Current context list box, click one of the 
listed Organization (O) or Organizational Unit (OU) names listed beneath the up arrow.
4. In the Select authorized users and groups list box, select any users and groups you want 



to assign to the resource.
To select more than one user, hold down the <Ctrl> key while clicking the users you 
want to assign.    To select a block of users, hold down the <Shift> key while clicking the 
first and last users in the block.
For a NetWare for SAA server running NetWare 4.1, the list box includes the users and 
groups located in the context selected in the Current context list box.

Note: In addition to using your mouse, you can also select users by using your arrow keys 
to highlight usernames and pressing the spacebar to mark their checkbox.
5. Click OK. 

NetWare for SAA closes the Add Users dialog box and returns to the Assign Users dialog 
box. The user and group names selected in the Add Users dialog box are added to the 
Authorized users list box.

6. If the Authorized users list box includes a user or group that you do not want to grant 
access to, select the user or group name in the Authorized users list box and click Delete.

7. Close the Assign Users dialog box by clicking OK.

Related Topics

Deleting User Assignments 
Assigning Users to Resources (under NetWare 3.12)



Adding Users
The Add Users dialog box lets you specify the names of the users and groups you want to 
assign to a resource. To use this dialog box, take the following steps:
1. If you are configuring NetWare for SAA on a server running NetWare 4.1 and configured 

for NetWare Directory Services (NDS), specify the context of users or groups you want to 
assign.

Note: If your server is not running NetWare 4.1, skip this step.

To specify the next higher context level in the Current context list box, click the up 
arrow that appears in the box.

To specify the next lower context level in the Current context list box, click one of the 
listed Organization (O) or Organizational Unit (OU) names listed beneath the up arrow.
2. In the Select authorized users list box, select any users and groups you want to assign to 

the resource.
The contents of the Select authorized users and groups list box depend on the version of 
NetWare running on the server you are configuring.

For a NetWare for SAA server running NetWare 4.1, the list box includes the users and
groups located in the context selected in the Current context list box.

For a NetWare for SAA server running NetWare 3.12, the list box includes all the users
and groups that have access to the server.
3. Click OK. 

NetWare for SAA closes the Add Users dialog box and returns to the Assign Users dialog 
box. The user and group names selected in the Add Users dialog box are added to the 
Authorized users and groups list box.

Related Topics

Assigning Users to Resources 
Deleting User Assignments 



Deleting User Assignments    
If you give users or groups access to a resource and later want to prevent them from using 
the resource, delete their names in the Assign Users dialog box. To do so, take the following 
steps:
1. If you have not already done so, log in to the server associated with the resource from 

which you want to remove user assignments.
2. Locate and select the resource from which you want to assign users.
3. Choose Functions > Assign Users.

NetWare for SAA Administrator displays an Assign Users dialog box.
4. In the Authorized users and groups list box, select the names you want to remove.

To select multiple names, hold down <Ctrl> while making your selections.
Note: Deleting all the names in the Authorized users and groups list box will give all 

users and groups access to the resource.
5. Click Delete.
6. Click OK.

Related Topic

Assigning Users to Resources 



Opening Additional View Windows    
Open additional view windows when NetWare for SAA Administrator is displaying more 
servers or resources than you can easily view in a single window. You can have up to nine 
view windows open simultaneously.
When opening additional view windows, you can perform either of the following operations:

Display information about a specific NetWare for SAA server. To do so, select the 
desired server (scroll if necessary) and choose Window > New Window > Selected Server.

Display information about all the NetWare for SAA servers available on the network. 
To do so, choose Window > New Window > All Servers.



Exiting NetWare for SAA Administrator
Exit NetWare for SAA Administrator if you no longer want to configure NetWare for SAA. 
When you exit NetWare for SAA Administrator, you are automatically logged out from any 
NetWare for SAA servers on which you are currently logged in.
Note: If before starting NetWare for SAA Administrator, you logged in to the selected server

under a username with supervisory-level rights, or were authenticated by NDS to 
supervise this server, exiting NetWare for SAA Administrator does not ensure against 
unauthorized access. To ensure against unauthorized access to NetWare for SAA 
servers from this workstation, you must log out from the network after exiting 
NetWare for SAA Administrator.

You can exit NetWare for SAA Administrator by using either of the following methods:

Choose Object > Exit.

Issue the MS Windows Close command. To do so, select the Control-menu box to 
display the Control menu and then choose Close. For details on the Close command, see 
your MS Windows documentation.

Note: Double-clicking the Control-menu box also issues the Close command.



Entering adapter names in AUTOEXEC.NCF
You enter adapter names in the AUTOEXEC.NCF file with the LOAD command's NAME 
parameter as discussed in the NetWare for SAA 2.0 Administration Guide for Mainframes and
Peer Nodes.



Unacceptable characters for a PU profile name
The following special characters are not allowed in a PU profile name:

space character
comma ( , )
asterisk ( * )
equal sign ( = )
plus sign ( + )
colon ( : )
semicolon ( ; )
quotation marks ( '' )
vertical bar ( | )

question mark ( ? )
slash ( / )
backslash ( \ )
left angle bracket ( < )
right angle bracket ( > )
left square bracket ( [ )
right square bracket ( ] )
number sign ( # )

Characteristics of a PU profile name
A PU profile name must have the following characteristics:

The name must be unique within the NetWare for SAA server. It cannot be the same 
as an existing PU profile name.

The maximum length must be eight alphanumeric characters (0 through 9 and 
uppercase A through Z).

The name must not include the following special characters:

space character
comma ( , )
asterisk ( * )
equal sign ( = )
plus sign ( + )
colon ( : )
semicolon ( ; )
quotation marks 
( '' )
vertical bar ( | )

question mark ( ? )
slash ( / )
backslash ( \ )
left angle bracket ( < )
right angle bracket ( > )
left square bracket ( [ )
right square bracket ( ] )
number sign ( # )

Relationship of dependent LU fields
The relationship between the number of dependent LUs and the starting dependent LU 
address can be expressed by the following formula:
number of dependent LUs £ (254 - starting dependent LU address) + 1



Relationship of downstream LU fields
The relationship between the number of downstream LUs and the starting downstream LU 
address can be expressed by the following formula:
Number of downstream LUs £ (254 - starting downstream LU address) +1



Removal of special characters
To maintain compliance with SNA requirements, any special characters in the PU profile 
name are removed. For example, if you create a PU profile named PU_SDLC, the default 
peripheral node control point name is PUSDLC (because the underscore from the original PU 
profile name is removed). If the first six characters in the PU profile name are all special 
characters, the default peripheral node control point name is CPNAME.



Adjusting and rearranging columns
You can adjust the columns of a Downstream LU's page and rearrange the order of those 
columns.

To adjust a column's width, select the right border of the column head and then drag 
the border until the column is the desired width.

To rearrange the order of the columns, select the head of the column you want to 
move and then drag it to the desired position. For example, you can switch the positions of 
the LU Address and VTAM Name columns by selecting the LU Address column head and then
dragging it to the VTAM Name column's head.



Adjusting and rearranging columns
You can adjust the columns of an LU pool's Description page and rearrange the order of 
those columns.

To adjust a column's width, select the right border of the column's head and then 
drag the border until the column is the desired width.

To rearrange the order of the columns, select the head of the column you want to 
move and then drag it to the desired position. For example, you can switch the positions of 
the PU Profile and VTAM Name columns by selecting the PU Profile column's head and then 
dragging it to the VTAM Name column's head.



Example EBCDIC code page IDs
Some examples of valid EBCDIC code page IDs are
037 - USA, Canada
273 - Germany, Austria
274 - Belgium
277 - Denmark, Norway
278 - Finland, Sweden
280 - Italy
282 - Portugal
284 - Spain, Latin America
285 - United Kingdom
297 - France
500 - Switzerland, International



Before you assign LUs to a downstream PU
Before assigning LUs to a downstream PU, become familiar with the following information 
and complete your Configure Downstream PU Worksheet as discussed in the NetWare for 
SAA 2.0 Planning Guide for Mainframes and Peer Nodes:

You can assign only public LUs to a downstream PU.

You assign an LU to a downstream PU by mapping the LU to a downstream LU.

You can assign nonconsecutive blocks of LUs to a downstream PU. For example, you 
can assign LU numbers 1 through 7 and LU numbers 19 through 53 to one downstream PU.

You can assign LUs from different Host PU profiles to the same downstream PU.



Before you assign LUs to an LU pool
Before assigning LUs to an LU pool, become familiar with the following information and 
complete your Configure LU Pools Worksheet as discussed in the NetWare for SAA 2.0 
Planning Guide for Mainframes and Peer Nodes.

You can assign only public LUs to LU pools. These public LUs must be on the same 
server as the LU pool you are assigning them to.

You can assign LUs from different Host PU profiles to the same LU pool.

You can mix LU types and models when assigning LUs to an LU pool.

You can assign nonconsecutive blocks of LUs to an LU pool. For example, you can 
assign LU numbers 3 through 10 and LU numbers 20 through 47 to one LU pool.



Opening a resource's dialog book

To open the dialog book of an NetWare for SAA Administrator resource, do one of the 
following:

Select the resource you want to open and press <Enter>.

Select the resource you want to open and choose 
Object > Details.

If the resource you want to open is in the right pane of the view window, double-click 
it.



Viewing the Local LU Summary        

Use the APPC Summary Information dialog book to view a list of the local LU-partner LU-
mode combinations configured for the NetWare for SAA Application Subsystem.
1. If you have not already done so, locate and open the APPC sessions icon. This displays 

the Local LU Summary page.    The Local LU Summary page displays three columns:

Local LU.    This column lists the local LUs configured to use the Application 
Subsystem.

Partner LU.    This column lists the associated partner LUs configured to use the 
Application Subsystem with the listed local LUs. 

Mode.    This column lists the conversation modes configured for the listed local LU-
Partner LU pairs. 

Related Topic

Viewing the Local Transaction Program (TP) Summary 
Configuring a Local LU for the Application Subsystem 



Viewing the Local Transaction Program (TP) Summary        

Use the APPC Summary Information dialog book to view a list of the transaction program-
security alias combinations configured for the NetWare for SAA Application Subsystem.
1. If you have not already done so, locate and open the APPC sessions icon. 

2. Click the Local TP Summary page.    The Local LU Summary page displays three columns:

Local TP.    This column lists the local TPs configured to use the Application 
Subsystem.

Type.    This column lists the type (Standard or Service) of the local TPs configured to 
use the Application Subsystem.

Conversation Security Aliases.    This column lists the associated conversation 
security aliases configured to be used with the listed local TPs. 

Related Topics

Viewing the Local LU Summary 
Configuring a Local TP for the Attach Manager 



Creating a Local LU for the Application Subsystem        

Use the NetWare for SAA Administrator Local LU Information dialog book to create and 
configure a dependent or independent local LU for the NetWare for SAA Application 
Subsystem. Follow these steps to bring up the Local LU Information dialog book:
To create and configure an independent or dependent local LU, take the following steps:
1. If you have not already done so, create a Local LU configuration. This displays the local 

LU's Description page.
2. With the local LU's Description page displayed, select either Independent or Dependent 

for the Local LU Type field. 
An independent LU can engage in multiple and parallel concurrent sessions with 
partner LUs.    Multiple transaction programs (TPs) with multiple conversations can use 
the same independent LU.    Because an independent LU is not dependent on a 
connection to a host, it does not depend on a system services control point (SSCP) to 
activate a session.
A dependent LU can engage in a one LU-to-LU session at a time with a host, and it must
be activated and controlled by the host system services control point (SSCP) A 
dependent LU can communicate only with a host application, such as a Customer 
Information Control System (CICS).

For information on the remainder of the fields click one of the following topics:

Configuring an independent local LU

Configuring a dependent local LU

Related Topics

Configuring a Partner LU for the Application Subsystem 
Configuring a Conversation Mode for the Application Subsystem 
Configuring a Local TP for the Application Subsystem 
Configuring a Conversation Security Alias 
Peer Connection Configuration Task Summary 



Configuring an Independent Local LU for the Application Subsystem     

Use the NetWare for SAA Administrator Local LU Information dialog book to configure an 
independent Local LU for the NetWare for SAA Application Subsystem. 
To configure an independent local LU, take the following steps:
1. If you have not already done so, either create the local LU configuration you want, or 

locate and open an existing independent local LU configuration. This displays the local 
LU's Description page.

2. With the local LU's Description page displayed, edit as instructed in the following table 
and then click OK. 
To jump to instructions for a particular field, click here.

Field Instruction
Local LU type If you have just created this 

independent local LU configuration, 
select Independent.
You can specify the local LU type only
when when creating the local LU 
configuration.    Thereafter, you 
cannot edit this field.

Local LU name If you are configuring a newly-created
local LU, enter the name by which the
local LU is known throughout the SNA
network.    This name

contains a    maximum of eight
characters.

can include uppercase letters 
(A to Z).

can include numbers 0 to 9.

can include the following 
special characters:

@ # $

requires a letter as the initial 
character.

must be a unique name in the 
network.

Default LU Select Yes or No to to specify whether
this local LU is the default local LU for
the NetWare for SAA Application 



Subsystem.    You can configure only 
one local LU as the default.

Partner LU Information Select one or more partner LUs to 
associate with this local    LU.
You must assign at least one partner 
LU name to the configuration of a 
local LU.    

To assign a partner LU select a
partner LU name from the Available 
list box and click Add.

To deassign a partner LU, 
select a partner LU name from the 
Selected list box and click Delete.

To display more information on
a partner LU, select that LU and click 
Get Info.

Comments This field is optional.    Enter a 
comment of up to 35 characters 
providing user information about the 
LU.

Startup Status Select one of the following options to 
specify whether this independent 
local LU is to be enabled 
automatically when you start 
NetWare for SAA.    

Enabled
Select this option if you want the   
local LU enabled automatically.    
When a local LU is enabled, a 
logical link is defined between the
local LU and each of its configured
partner LUs.    This link can be 
activated when a transaction 
program (TP) initiates a 
conversation on a session 
allocated to the logical link. This is
the default.

Disabled
Select this option if you do not 
want the local LU activated 
automatically.    You can use the 
CSStatus or NetWare for SAA    



Services Manager utility to enable
a local LU while NetWare for SAA 
is running.

Related Topics

Configuring a Dependent Local LU for the Application Subsystem 
Configuring a Partner LU for the Application Subsystem 
Configuring a Conversation Mode for the Application Subsystem 
Configuring a Local TP for the Application Subsystem 
Configuring a Conversation Security Alias 
Peer Connection Configuration Task Summary 



Application Subsystem Independent LU Fields 
Click the field that you need instructions on.

Local LU type
Local LU name
Default LU

Partner LU Information
Comments
Startup status

Configuring a Dependent Local LU for the Application Subsystem     

Use the Local LU Information dialog book to configure a dependent local LU for the NetWare 
for SAA Application Subsystem. 
To configure a dependent local LU, take the following steps:
1. If you have not already done so, either create the dependent LU configuration you want, 

or locate and open an existing dependent local LU icon. This displays the local LU's 
Description page.

2. With the local LU's Description page displayed, edit as instructed in the following table 
and then click OK. 
To jump to instructions for a particular field, click here.

Field Instruction
Local LU type If you have just created this 

dependent local LU configuration, 
select Dependent.
You can specify the local LU type only
when when creating the local LU 
configuration.    Thereafter, you 
cannot edit this field.

Local LU name This field displays the VTAM name of 
the dependent local LU you select 
through the Current PU profile and 
Dependent LU address fields.    This is
the name of the local LU that is 
configured locally in the PU profile 
and remotely on the host in the VTAM
SYSGEN.
This is the name by which the local 
LU is known throught the SNA 
network.
You cannot edit this field.

Current PU profile If you have just created this 
dependent local LU configuration, 
select the Host PU profile that 



contains the local dependent LU of 
type APPC that you want to configure 
for the Application Subsystem.    After 
you select the Host PU profile, the 
Dependent LU address field is 
enabled.
You can specify the current PU profile 
only when when creating the local LU 
configuration.    Thereafter, you 
cannot edit this field.

Dependent LU address If you have just created this 
dependent local LU configuration, 
select the address and name of the 
local dependent LU of type APPC that 
you want to configure for the 
Application Subsystem.
Only LUs of type APPC in the specified
Host PU profile are listed for 
selection.
You can specify the dependent LU 
address only when when creating the 
local LU configuration.    Thereafter, 
you cannot edit this field.
After you select the LU address in this
field the name of the associated LU is
displayed in the Local LU name field.
 

Default LU Select Yes or No to to specify whether
this local LU is the default local LU for
the Application Subsystem.    You can 
configure only one local LU as 
default.

Partner LU Information Select one or more partner LUs to 
associate with this local    LU.
The partner LU name must match the
name of the application defined in 
the VTAM APPL definition on the host 
that the local LU connects to.

To assign a partner LU, select 
a partner LU name from the Available
list box and click Add.

To deassign a partner LU, 
select a partner LU name from the 
Selected list box and click Delete.



To display more information on
a partner LU, select that LU and click 
Get Information.

Comments This field is optional.    Enter a 
comment of up to 35 characters 
providing user information about the 
LU.

Startup Status Select one of the following options to 
specify whether this dependent local 
LU is to be enabled automatically 
when you start NetWare for SAA.    

Enabled
Select this option if you want the   
local LU enabled automatically.    
When a local LU is enabled, a 
logical link is defined between the
local LU and each of its configured
partner LUs.    This link can be 
activated when a transaction 
program (TP) initiates a 
conversation on a session 
allocated to the logical link. This is
the default.

Disabled
Select this option if you do not 
want the local LU activated 
automatically.    You can use the 
CSStatus or NetWare for SAA    
Services Manager utility to enable
a local LU while NetWare for SAA 
is running.

Important: If you set the startup 
status of a dependent local LU to 
Enabled, be sure that the Startup 
Status of the Host PU profile that it 
defines is also Enabled.

Related Topics

Configuring an Independent Local LU for the Application Subsystem 
Configuring a Partner LU for the Application Subsystem 
Configuring a Conversation Mode for the Application Subsystem 
Configuring a Local TP for the Application Subsystem 



Configuring a Conversation Security Alias 
Peer Connection Configuration Task Summary 



Application Subsystem Dependent LU Configuration Fields
Click the field that you need instructions on.

Local LU type
Local LU name
Current PU profile
Dependent LU 
Address

Default LU
Partner LU Information
Comments
Startup status

Configuring a Partner LU     

Use the Partner LU Information dialog book to configure a partner LU for the NetWare for SAA
Application Subsystem. 
To configure a partner LU, take the following steps:
1. If you have not already done so, either create the partner LU    you want to configure, or 

locate and open an existing independent Partner LU configuration. This displays the 
partner LU's Description page.

2. With the partner LU's Description page displayed, edit as instructed in the following table
and then click OK. 
To jump to instructions for a particular field, click here.

Field Instruction
Partner LU name This is the name of a    partner LU that

you want to associate with a local LU. 
You can specify the partner LU name 
only when creating the partner LU 
configuration.    Thereafter, you 
cannot edit this field.

To specify an explicit partner 
LU name, enter a network-unique LU 
name of from one to eight characters,
including uppercase alphabetic 
characters A to Z, numbers 0 to 9, 
and the following special characters: 

@ # $ 
The first character must be 
nonnumeric.

To specify an explicit partner 
LU name for a dependent local LU, 
enter an LU name that exactly 
matches the name of the application 
defined in the VTAM APPL definition 
on the host that the local LU connects



to.

To specify an implicit mode 
name, enter an asterisk ( * ) as the 
first character of the mode name.

Following the asterisk, you can 
use any naming convention that 
is meaningful to you locally.    
Following the asterisk you can 
enter up to seven characters, 
including uppercase alphabetic 
characters A to Z, numbers 0 to 9,
and the following special 
characters: 
@ # $ 

For more information on partner LUs, 
see the NetWare for SAA 2.0 
Administration Guide for Mainframes 
and Peer Nodes. 

SNA network ID Specify the eight-character network 
ID of the SNA network that the node 
containing the partner LU belongs to. 
By default, this field shows the value 
that you specified for the SNA 
network ID field of the NWSAA Node 
Information dialog book. 
In most cases, you will not need to 
change this value. However, if the 
node that contains the partner LU is 
on a different SNA network from the 
one on which the NetWare for SAA 
server resides, you can change the 
default value to specify the partner 
node's SNA network ID.

Immediate link 
activation

This field is displayed for explicit 
partner LUs only. 

Select this check box to 
indicate that this link is to be 
immediately activated when the local
LU is enabled if either of the following
conditions is met:

The startup status of the 
associated local LU is enabled.    In 
this case, the link is immediately 
started without operator intervention 
when you load NetWare for SAA.



When selected, this field 
overrides the Terminate peer link if 
no active APPC sessions field set in 
the Data Link Adapter Information 
dialog book.    If both fields are 
selected, the link stays up until you 
detach the local LU.

The local LU is enabled 
through the CSStatus or NetWare for 
SAA Services Manager utility.

Note: If your adapter station role 
is configured as Negotiable  ,   
NetWare for SAA will initiate link 
establishment when it is loaded 
by issuing an exchange 
identification (XID). 

Clear this check box to 
indicate that the link between this 
partner LU and the local LU is to be 
activated when a session is allocated 
for this LU. 

Note: If your adapter station role 
is configured as Negotiable, when 
NetWare for SAA is loaded, it will 
not initiate link establishment. 
Instead, it will wait to receive the 
exchange identification (XID) from
the partner node. 

Conversation security 
support

This field is displayed for explicit 
partner LUs only. 
This field indicates whether NetWare 
for SAA will support conversation 
security for remote TPs that use this 
partner LU to start a conversation 
with a local TP running on a local 
NetWare for SAA client.

Select this check box to direct 
NetWare for SAA to support 
conversation security validation for 
conversations that are remotely 
started by TPs using this partner LU. 

If you select this check box, the 
partner LU can either send 
conversation security or not. The 
response depends on whether the
local TP that the partner TP 
attempts to remotely start a 



conversation with requires 
conversation security. 
When you select this check box,    
NetWare for SAA Administrator 
displays the Conversation security
already verified field.

Clear this check box to direct 
NetWare for SAA not to provide 
conversation security validation for 
conversations that are remotely 
initiated by this partner LU. 

Clearing this check box restricts 
the partner LU to remotely 
initiating conversations with local 
TPs that do not require 
conversation security. 
Clear this check box only if you 
want to prohibit any partner TP 
that uses this partner LU from 
remotely starting a conversation 
with any local TP that requires 
conversation security.
You determine whether you want 
to require conversation security 
for a local TP when you configure 
the local TP to use the Attach 
Manager. 
If you clear this check box and the
partner LU sends security 
information (conversation user ID 
and password) in the function 
management header 5 (FMH-5) 
Attach message, NetWare for SAA
rejects the allocation request. 

Conversation security 
already verified

This check box appears only if the 
Conversation Security support 
checkbox is selected.

Select this checkbox to direct 
NetWare for SAA to accept already 
verified conversation security 
passwords for incoming allocation 
requests from this partner LU.

Clear this checkbox to deny 
this partner LU the ability to verify 
the password associated with a 
security user ID when conversation 



security is required. 
If you select this check box, you 
grant the partner LU permission 
to verify the conversation security
password itself, instead of 
requiring the partner LU to send it
along with the conversation 
security user ID. 
In this case, you allow a partner 
LU to pass a user ID but not the 
password in the security field of 
an Attach message. 
Selecting this check box does not 
require that the partner LU verify 
the password. If you select this 
checkbox and the partner LU 
sends a user ID and its associated
password, NetWare for SAA 
checks both values against the 
local TP that the partner LU is 
attempting to remotely start, if 
that local TP requires 
conversation security. 
If the partner LU verifies the 
password itself, NetWare for SAA 
checks only the user ID. 

Mode Information Select a conversation mode to 
associate with this local    LU.

To assign a mode, select a 
mode name from the Available list 
box and click Add.

To deassign a conversation 
mode, select a mode name from the 
Selected list box and click Delete.

To display more information on
a conversation mode, select that LU 
and click Get Information.
A mode describes the transmission 
characteristics for a session between 
two LUs. After you configure a partner
LU, the Mode Information box allows 
you to view and assign the names of 
modes defining the sessions that can 
be used for this local LU and partner 
LU pair. 



Logical adapter name Select the name of the data link 
adapter to be used for 
communication between the 
associated partner LU and local LU.
NetWare for SAA Administrator 
displays additional fields appropriate 
to the type of adapter you select.

802.2 remote node 
address

This field is displayed when the 
partner LU is configured for either a 
token ring or Ethernet adapter. 
Enter the IEEE 802.2 remote node 
address for the node where the 
partner LU resides. This value 
corresponds to the medium access 
control (MAC) address that is 
assigned to the partner node's 
adapter. This is the adapter that is 
used for communication between the 
partner LU at the remote node and 
the local LU you associate it with. 
Refer to the configuration worksheets
for the remote node address value. 

802.2 service access 
point

This field is displayed when the 
partner LU is configured for either an 
Ethernet or token ring adapter. 
Enter the two-digit service access 
point (SAP) number on the remote 
token ring or Ethernet adapter to be 
used for this connection. The SAP 
must be a multiple of 4, starting at 04
hex, and must be one of the SAP 
values lower than E0.
The default value is 04.
Refer to the configuration worksheets
for the remote SAP value.

802.2 local service 
access point

This field is displayed when the 
partner LU is configured for either an 
Ethernet or a token ring adapter. 
Enter the two-digit service access 
point (SAP) number on the local token
ring or Ethernet adapter to be used 
for this connection. Refer to the 
configuration worksheets for the local
SAP value.
Check the 802.2 adapter 



configuration to determine how many
local SAPs are configured for the 
adapter to be used for the 
connection.
The SAP that you specify must be one
of the SAPs configured for the 
adapter to be used. For an adapter 
that you configure with multiple local 
SAPs, NetWare for SAA generates the 
local SAPs starting at 04 in 
increments of 4. 
For example, if you configure an 
adapter to have two local SAPs, 
NetWare for SAA will generate these 
SAPs at 04 hex and 08 hex. In this 
case, you must specify one of these 
values for this field. 
The SAP must be a multiple of 4, 
starting at 04 hex, and must be lower
than E0.
The default value is 04.

Local station address 
for multipoint link

This field is displayed only when the 
partner LU is configured for a 
multipoint SDLC link that you want to 
use for communication between this 
partner LU and its associated local 
LU. Specify a two-digit hexadecimal 
value between 01 and FE, inclusive. 
The default value is C1 hex. 
Each point on a multipoint SDLC link 
connection acts as a separate link 
station through which data can be 
sent and received. The value you 
specify in this field is the station 
address on the SDLC multipoint link 
for the local node that is used for 
communication between this partner 
LU and any local LUs associated with 
this partner LU. 
Refer to the configuration worksheets
for the SDLC control unit address 
value. 

QLLC call support 
layer target    name

This field is displayed only when the 
partner LU is configured for a 
QLLC/X.25 adapter. 
Specify the call support layer (CSL) 
target name as configured in the CSL 



database. This name serves as the 
key to the CSL X.25 database record. 
This name contains the destination 
address and the X.25 parameters for 
the virtual circuit to be used for the 
connection between this partner LU 
and any local LUs with which you 
associate it. The CSL target name 
refers to a specific entry in the CSL 
database. Your X.25 package 
provides a utility to configure the CSL
database.
If you are using NetWare 
MultiProtocol Router Plus™ 2.1 or 3.0,
or NetWare Link/X.25TM 2.1 or 3.0, 
the QLLC call support layer target 
name field must match the Call 
Destination field in the INETCFG 
utility's Internetworking Configuration
> WAN Call Directory > Configured 
WAN Call Destinations menu.

Custom data link 
target name

This field is displayed only when the 
partner LU is configured for a custom 
data link adapter.
Use this field to specify information 
that the custom data link may use to 
establish connectionsfor example, an 
address key. This field can contain up 
to 16 characters.
See your custom data link 
documentation for details as to how it
is implemented. 

Related Topics

Configuring an Independent Local LU for the Application Subsystem 
Configuring a Dependent Local LU for the Application Subsystem 
Configuring a Conversation Mode for the Application Subsystem 
Configuring a Local TP for the Application Subsystem 
Configuring a Conversation Security Alias 
Peer Connection Configuration Task Summary 



Application Subsystem Partner LU Fields
Click the field that you need instructions on.

Partner LU name
SNA network ID
Immediate link 
activation
Conversation 
security support
Conversation 
security already 
verified
Mode Information

Logical adapter name
802.2 remote node 
address
802.2 service access 
point
802.2 local service 
access point
Local station address for 
multipoint link
QLLC call support layer 
target name
Custom data link target 
name

Configuring a Conversation Mode for the Application Subsystem     

Use the Mode Information dialog book to configure a conversation mode for the NetWare for 
SAA Application Subsystem. 
To configure an conversation mode, take the following steps:
1. If you have not already done so, either create the conversation mode you want to 

configure, or locate and open an existing conversation mode configuration. This displays 
the Mode Information Description page.

2. With the Mode Information Description page displayed, edit as instructed in the following
table and then click OK. 
To jump to instructions for a particular field, click here.

Field Instruction
Mode name This field identifies a conversation 

mode used by a partner LU and local 
LU combination to communicate 
through the Application Subsystem.

To specify an explicit mode 
name, enter a mode name from one 
to eight characters, including 
uppercase alphabetic characters A to 
Z, numbers 0 to 9, and the following 
special characters: 

@ # $ 
The first character must be 
nonnumeric.



To specify an explicit mode 
name for a dependent local LU, enter 
a mode name that matches a mode 
configured in the mode table for the 
partner LU on the host that the local 
LU connects to.    The mode table is 
named in the VTAM APPL statement 
that defiens the partner LU in the 
VTAM SYSGEN.

To specify an implicit mode 
name, enter an asterisk ( * ) as the 
first character of the mode name.

Following the asterisk, you can 
use any naming convention that 
is meaningful to you locally.    
Following the asterisk you can 
specify up to seven special 
characters: 
@ # $

Note: If you change the name of an 
existing mode, communicate the 
changes to network administrators 
and programmers at remote nodes 
where partner LUs reside that use the
mode whose name you have 
changed.
For more information on modes, see 
the NetWare for SAA 2.0 
Administration Guide for Mainframes 
and Peer Nodes. 

Number of sessions Enter the maximum number of LU-to-
LU sessions that can be active for this
partner LU in this mode. The default 
value for this field is 4. The upper 
limit for the number of sessions is 
255.
NetWare for SAA automatically 
adjusts the maximum number of LU-
to-LU sessions to 1 for any mode that
is associated with a partner LU of a 
dependent local LU. This adjustment 
does not occur for modes assigned to
partner LUs of independent local LUs. 
Therefore, you can assign the same 
partner LUs and modes to both 
independent and dependent local 
LUs. 
This number must be greater than or 



equal to the number of sessions that 
you configure for minimum 
contention winners.

Minimum contention 
winners

Specify the minimum number of 
sessions for which the local LU is to 
be the contention winner. 
This number must not exceed the 
value that you configure for the 
number of sessions field. 
When two transaction programs (TPs)
at each end of an established session
both try to start a conversation on 
the session at the same time, a 
contention situation occurs. The 
value that you specify for this field is 
the initial minimum number of 
contention winner sessions for this 
LU. 
However, because both the local and 
partner LUs can engage in an 
exchange to resolve the number of 
contention winner sessions that each 
gets to their mutual agreement 
during what is known as the CNOS 
negotiation process, the number that 
you configure might not be the 
specific number that is used. The 
local LU is guaranteed the minimum 
number of contention winner 
sessions that is determined by the 
outcome of the CNOS negotiation 
process. 
For more information on the 
minimum contention winners field, 
see the NetWare for SAA 2.0 
Administration Guide for Mainframes 
and Peer Nodes. 

Number of 
autoactivated sessions

Specify the maximum number of 
sessions for contention winners that 
the local LU can automatically 
activate to create the initial session 
pool. The default value is 0. 
When a local LU is enabled either by 
explicit operator action or by 
including the LU in the startup 
resources, NetWare for SAA 
automatically starts any sessions that
are configured as autoactivated 
rather than starting the session in 



response to an allocation request 
from a TP.
Only sessions that are configured as 
contention winners can be 
automatically activated. Therefore, 
you must set this value to a number 
that is less than or equal to the 
number that you specified for the 
Minimum contention winners field. 
Automatically activating some 
sessions when the local LU is started 
can improve performance because 
TPs that issue session allocation 
requests will not have to wait for a 
session to be established to start 
their conversations. However, 
starting too many unused sessions 
makes valuable system resources 
unavailable for other use. 
For more information on 
autoactivated sessions, see the 
NetWare for SAA 2.0 Administration 
Guide for Mainframes and Peer 
Nodes. 

Maximum RU size Specify a number within the range of 
256 and 4096 bytes to be used as the
largest request unit (RU) that can be 
transmitted across sessions 
characterized by this mode. The 
default value is 1024 bytes, or 1\
x110011KB.
The maximum RU size determines 
the amount of data that the local or 
remote LU will place in one RU before
building another.
The nominal sizes for the RUs are set 
at both the local and partner nodes. 
The LUs negotiate to determine the 
actual maximum RU size during 
session establishment.
Although you can specify an RU size 
as small as 16 bytes, a value less 
than 256 does not benefit NetWare 
for SAA. Avoid specifying a value that
is less than 256 bytes unless the 
partner LU gains some efficiency from
the lower value. 
For more information on maximum 
RU size, see the NetWare for SAA 2.0 
Administration Guide for Mainframes 



and Peer Nodes.    

Receive pacing count: Specify a number within the range of 
0 and 63 to be used as the receive 
pacing window size for incoming 
request or response units (RUs) on 
sessions of this mode. The default 
value is 7.
The receive pacing count specifies 
the maximum number of RUs that the
local LU can receive on a session 
before it sends a response 
acknowledgment to the session 
partner. This value allows the local LU
to control the pace of incoming data 
on the session. 
Although configuring a session for a 
large receive pacing window can 
produce optimal performance, you 
might need to protect the local LU 
from overload. To do so, configure a 
value that allows the local LU to 
prohibit the partner LU from sending 
additional data until enough space is 
released to receive it.
For more information on receive 
pacing count, see the NetWare for 
SAA 2.0 Administration Guide for 
Mainframes and Peer Nodes. 

Related Topics

Configuring an Independent Local LU for the Application Subsystem 
Configuring a Dependent Local LU for the Application Subsystem 
Configuring a Partner LU for the Application Subsystem 
Configuring a Local TP for the Application Subsystem 
Configuring a Conversation Security Alias 
Peer Connection Configuration Task Summary 



Conversation Mode Fields
Click the field that you need instructions on.

Mode name
Number of 
sessions
Minimum 
contention winners

Number of autoactivated
sessions
Maximum RU size
Receive pacing count

Configuring a Local TP to the Attach Manager
Use the Transaction Program Information dialog book to configure a local transaction 
program (TP) for the Attach Manager module of the NetWare for SAA Application Subsystem.
To configure a local TP, take the following steps:
1. If you have not already done so, either create the local TP resource you want to 

configure, or locate and open an existing local TP configuration. This displays the 
Transaction Program Description page.

2. With the Transaction Program Description page displayed, edit as instructed in the 
following table and then click OK. 
To jump to instructions for a particular field, click here.

Field Instruction
Transaction program 
type

Select the type of TP you are 
configuring. Options include:

Standard.      A standard TP is 
an application-specific TP.    Most TPS 
fall within this category.

Service.    SNA service TPS are 
specialized TPs that provide common 
network and system service to other 
programs or users.    Some examples 
of types of service TPs are Distributed
Data Management (DDM) and SNA 
Distribution Services (SNADS).

Local TP name Enter the name of the local TP that 
you want to configure to accept 
incoming conversation allocation 
requests.    A partner TP can then 
attempt to remotely start a 
conversation with this local TP.
This value must match the TP name 
that is specified for this local CPI-C TP
in the Attach Manager record on the 
client where the application program 
that contains the CPI-C TP resides.



To specify a    local TP name for
a standard TP,    enter a TP name of 
from 1 to 64 characters, using any 
characters from the SNA type AE 
character set.    This set includes 
uppercase and lowercase alphabetic 
characters A to Z, numbers 0 to 9, 
and the following special characters: 

@ # $ 

To specify a local TP for a 
service TP, enter a two-digit 
hexadecimal number with a value 
between 00 and 3F (excluding 0E and
0F).

Optionally, you can append one to
three additional characters from 
the SNA type AE character set 
immediately after the 
hexadecimal byte. This set 
includes uppercase and lowercase
alphabetic characters A to Z, 
numbers 0 to 9, and the following 
special characters: 
@ # $ 

For more information on configuring 
an Attach Manager record on a client,
see the NetWare for SAA 2.0 API 
Configuration Guide for DOS and 
NetWare Clients or NetWare for SAA 
2.0 API Configuration Guide for MS 
Windows Clients . 

Sync level Specify the synchronization level that
the local and remote TPs can use for 
a conversation between them. Select 
from the following options:

Confirm. 
Select Confirm to allow the TPs to 
perform confirmation processing 
on this conversation to 
synchronize their processing. The 
TPs can issue verbs and recognize
returned parameters relating to 
confirmation. This is the default. 

None. 
Select None to prevent the TPs 
from performing confirmation 



processing on this conversation. 
The programs do not issue verbs 
and do not recognize returned 
parameters relating to the 
synchronization function.

Conversation type Specify the type of conversation for 
the local TP and its partner TP that 
initiates the conversation.    Select 
from the following options:

Basic 
If you configure this local TP to 
hold basic conversations, the 
partner TP that initiates the 
conversation must specify Basic 
as the conversation type. 

Mapped 
If you configure this local TP to 
hold mapped conversations, the 
partner TP that initiates the 
conversation must specify 
Mapped as the conversation type.

Either 
If you select Either, this local TP 
can accept incoming conversation
allocation requests from a partner
TP that initiates either a basic or 
mapped conversation. To provide 
the greatest flexibility, select this 
option. This is the default.

Conversation security Select Yes or No to enable or disable 
conversation security. The default is 
No.

No. 
Specify No to indicate that no 
conversation security is 
associated with this local TP. To 
remotely start a conversation with
this local TP in this case, a partner
TP does not need to specify a user
ID and password. Moreover, if the 
partner TP provides a 
conversation-level security user 
ID and password in its attempt to 
remotely start a conversation with



the local TP, and the local TP does
not require conversation security, 
NetWare for SAA will reject the 
partner TP's request. 

Yes. 
Specify Yes to require 
conversation security validation of
any partner TP that attempts to 
remotely start a conversation with
this local TP. 
Conversation security consists of 
a user ID and password that the 
partner LU must pass if a TP that 
uses the partner LU attempts to 
remotely start a conversation with
this local TP. NetWare for SAA 
checks this user ID and password 
against a conversation security 
list that you configure for this 
local TP. 
If you specify Yes for this field, 
NetWare for SAA Administrator 
displays the Conversation security
aliases box that lets you create a 
conversation security list for this 
local TP. 

Conversation security 
aliases

This box appears is the Conversation 
security field is set to Yes.
Select a conversation security alias to
add to the list of conversation 
security aliases associated with this 
local    TP.    

To assign a conversation 
security alias, select a conversation 
security alias from the Available list 
box and click Add.

To deassign a conversation 
security alias, select a conversation 
security alias from the Selected list 
box and click Delete.

To display more information on
a conversation security alias, select 
that LU and click Get Information.
A conversation security alias 
represents a conversation security 



user ID and password pair. 
NetWare for SAA uses the list of 
selected conversation security aliases
to control access to the local TP when
a partner TP attempts to remotely 
start this local TP.
If conversation security is required for
this local TP, the partner TP that 
attempts to remotely start a 
conversation with this local TP must 
provide a user ID and, if appropriate, 
a password that matches a pair of 
values for one of the aliases 
belonging to this list.
Once you create an alias, you can 
associate that alias with one or more 
local TPs. Using a conversation 
security alias provides a convenient 
way to assign the same user ID and 
password pair to more than one local 
TP.

Related Topics

Configuring an Independent Local LU for the Application Subsystem 
Configuring a Dependent Local LU for the Application Subsystem 
Configuring a Partner LU for the Application Subsystem 
Configuring a Conversation Mode for the Application Subsystem 
Configuring a Conversation Security Alias 
Peer Connection Configuration Task Summary 



Local TP Fields
Click the field that you need instructions on.

Transaction 
program type
Local TP name
Sync level

Conversation type
Conversation security
Conversation security 
aliases

Configuring a Conversation Security Alias     

Use the Conversation Security Alias Information dialog book to configure a conversation 
security alias for the Attach Manager module of the NetWare for SAA Application Subsystem. 
These aliases can be assigned to local TPs that require user security IDs and passwords 
before responding to initiation from a partner TP. 
To configure an conversation security alias, take the following steps:
1. If you have not already done so, either create the conversation security alias you want to

configure, or locate and open an existing conversation security alias. This displays the 
Conversation Security Alias Information Description page.

2. With the Conversation Security Alias Information Description page displayed, edit as 
instructed in the following table and then click OK. 

Field Instruction
Conversation security 
alias

This is the security alias that you can 
assign to network users wishing to 
start conversations with the 
associated local TP(s).    
You can specify the conversation 
security alias name only when when 
creating an alias configuration.    
Thereafter, you cannot edit this field.

You associate the conversation 
security alias with a local TP through 
the Local TP Information dialog book. 
When a partner TP attempts to 
remotely start a local TP for which 
conversation security information is 
required, NetWare for SAA checks the
aliases associated with the local TP 
for one that contains a user ID and 
password pair that matches the user 
ID and password that the partner TP 
provides. The alias name is local to 
NetWare for SAA. The partner TP 
passes the specific security user ID 
and password, not the alias that 
represents these values locally. 



Security user ID Enter the security user ID required to 
access this TP and its resources. For 
the user ID, specify values from the 
type AE character set that are up to 
10 characters long, including the 
following alphanumeric and special 
characters: uppercase A to Z, 
lowercase a to z, 0 to 9, at sign ( @ ), 
period ( . ), and dollar sign ( $ ).

Security password Enter the security password for the 
security user ID required to access 
this TP. For the password, specify 
values from the type AE character set
that are up to 10 characters long, 
including the following alphanumeric 
and special characters: uppercase A 
to Z, lowercase a to z, 0 to 9, at sign (
@ ), number sign ( # ), period ( . ), 
and dollar sign ( $ ). 

Related Topics

Configuring an Independent Local LU for the Application Subsystem 
Configuring a Dependent Local LU for the Application Subsystem 
Configuring a Partner LU for the Application Subsystem 
Configuring a Conversation Mode for the Application Subsystem 
Configuring a Local TP for the Application Subsystem 
Peer Connection Configuration Task Summary 





 #
802.2



A
Advanced Program-to-Program Communication (APPC)
Advanced Program-to-Program Communications for Personal Computers (APPC/PC)
Alerts
APPC 
APPC/PC
Application programming interface (API) 
application subsystem 
Application Subsystem (for CPI-C TPs)
AS/400 
Attach Manager 
Audit trail 



B
Balanced protocol 
Block ID 



C
Call support layer (CSL) target name (for a downstream PU) 
Call support layer (CSL) target name (for a Host PU profile) 
Client Access/400
Collection point server 
Common Programming Interface for Communications (CPI-C) 
Communication Executive
Context 
Control point name 
Control unit address 
Conversation 
Conversation security
Conversation security alias
CPI-C 
Critical server 
CSCON 
CSL target name (for a downstream PU)
CSL target name (for a Host PU profile)
CSStatus 
Custom data link 



D
Data link adapter 
Dedicated LU 
Default Peer PU profile 
Dependent LU 
Dial-up line 
Directory tree 
Downstream LU 
Downstream PU 
Downstream PU name 



E
End point server 
Ethernet 
Event log 



F
There are no glossary entries for this letter.



G
There are no glossary entries for this letter.



H
HostPrint
Host PU profile 
Hot Standby
Hot Standby server
HPCONSOL 



I
Implicit mode 
Implicit partner LU 
Independent LU 
Internetwork Packet Exchange (IPX) protocol 
Internetwork Packet Exchange/Sequenced Packet Exchange (IPX/SPX) protocol
IPX/SPX



J
There are no glossary entries for this letter.



K
There are no glossary terms for this letter. 



L
Local LU 
Local SAP
Local service access point (SAP) 
Local station address 
Logical adapter name (for 802.2, SDLC, or custom) 
Logical adapter name (for QLLC) 
Logical adapter number 
Logical unit (LU) 
Logical unit (LU) 
LU6.2
LU pool 
LU type 



M
MAC address
Mapped LU 
Maximum frame size 
Maximum print line (MPL) 
Maximum print position (MPP)
Medium access control (MAC) address 
Mode 
Model 
Model number 
MPL 
MPP 
Multipoint local station address
Multipoint SDLC link 



N
Negotiable 
NetView 
NetView alerts 
NetView management 
NetWare Communication Services security 
NetWare Directory Services 
NetWare for SAA 
NetWare for SAA Administrator 
NetWare for SAA Services Manager 
NetWare HostPrint 
NetWare HostPrint Control (HPCONSOL) Utility 
NetWare Loadable Module (NLM) 
NetWare for SAA LU6.2
NetWare TN3270 
NLM
Node ID 
Nonreturn to zero (NRZ) 
Nonreturn to zero inverted (NRZI) 
Nonswitched line 
NRZ
NRZI



O
Offline test



P
Partner LU 
Partner LU adapter number 
Partner TP
Partner transaction program (TP) 
Peer PU profile 
Peripheral node control point (PNCP) 
Physical unit (PU) 
Physical unit ID (PU ID) 
PNCP
Pooled LU 
PU 
PU ID 
PU profile 
PU type 2.0 
PU type 2.1 
Public LU 



Q 
QLLC 
Qualified Logical Link Control (QLLC) 



R
Remote node address 
Remote SAP (for a downstream PU)
Remote SAP (for a host)
Remote service access point (SAP) (for a downstream PU)
Remote service access point (SAP) (for a host) 
Remote station 
Request-to-send (RTS) signal
RTS signal 
Run commands 
RUNCMDs



S
SAA
SAP
SDLC 
Secondary
Serial number 
Service access point (SAP) 
Session
SNA
SNA network ID 
SSCP
Switched line 
Synchronous Data Link Control (SDLC) 
System services control point (SSCP) 
Systems Application Architecture (SAA) 
Systems Network Architecture (SNA) 



T
TCP/IP
tn3270 
Token ring
TP 
Trace 
Trace facility 
Transaction program (TP) 
Transmission Control Protocol/Internet Protocol (TCP/IP) 



U
Upstream 



V
VTAM LU name 



W
There are no glossary entries for this letter.



X
There are no glossary entries for this letter.



Y
There are no glossary entries for this letter.



Z
There are no glossary entries for this letter.



802.2
One of a set of communications standards that define physical and electrical network 
connections. The 802.2 standard specifies the data link layer for use with 802.3 
networksthick, thin, twisted pair, and fiber optic Ethernet networksand with 802.5 
networkstwisted pair or fiber optic token ring networks. 



Alerts
A message that is sent from NetWare for SAA servers to IBM NetView.



Advanced Program-to-Program Communication (APPC)
An SNA facility that is used for peer-to-peer interprogram communication. APPC is an 
implementation of the LU6.2 architecture. APPC software enables high-speed communication
between transaction programs (TPs) on different computers, and from portables and 
workstations to midrange and host computers. 
NetWare for SAA uses the term APPC to include Common Programming Interface for 
Communications (CPI-C), which is a style of APPC application programming interface (API).



Advanced Program-to-Program Communication for Personal Computers (APPC/PC)
An implementation of the Advanced Program-to-Program Communication (APPC) protocol 
that runs on personal computers.



Application programming interface (API)
A set of functions, verbs, or procedures that an application program can call to gain access 
to the services of a protocol implementation. NetWare for SAA 2.0 includes three APIsCPI-C, 
Advanced Program-to-Program Communication for Personal Computers (APPC/PC), and LUx. 
An application program uses the facilities of a single API. For example, an application 
program can call the CPI-C API functions to use NetWare for SAA LU6.2 services. 



application subsystem
One or more programs whose primary function is to provide services for NetWare LU6.2 and 
transaction programs (TPs). The application subsystem logs errors, manages incoming 
conversations, loads transactions programs, and provides additional services to NetWare for 
SAA. See also Application Subsystem.



Application Subsystem
The particular set of programs included with NetWare for SAA 2.0 to provide services for 
Common Programming Interface for Communications (CPI-C) transaction programs (TPs).    In
contrast, Advanced Program-to-Program Communication for Personal Computers (APPC/PC) 
TPs must provide their own application subsystems.



AS/400
Application System/400. A family of IBM midrange computers.



Attach Manager
A component of NetWare for SAA 2.0 that handles incoming conversation allocation requests
for local transaction programs (TPs) from partner TPs. The Attach Manager takes its name 
from an SNA message, called an Attach message, that flows between a pair of LUs and is 
generated when a TP issues one of several verbs. 



Audit trail log
Information about when a user logs in and logs out, and when a user starts and stops 
sessions. This information is stored in a text file on the NetWare for SAA server.



Balanced protocol
A protocol that allows either side of a data link to initiate a data transfer operation without 
requiring permission from the destination link. A balanced protocol is sometimes referred to 
as a full-duplex (FDX) protocol.



Block ID
A three-digit hexadecimal number specific to an IBM product.    This number is identical to 
the IDBLK value assigned to the PU in the host definition, that is part of the node ID assigned
durng NetWare for SAA configuration.    The block ID for 3274 nodes is 017 hex.



Call support layer (CSL) target name
A name that refers to an entry in the call support layer (CSL) database. The CSL target name
contains the destination address and the X.25 parameters for the virtual circuit that the 
NetWare for SAA server uses to connect to the host system.
Your X.25 package provides a utility to configure the target name.
For more information, see the NetWare for SAA 2.0 Administration Guide for Mainframes and 
Peer Nodes.



Call support layer (CSL) target name (for a downstream PU)
A name referring to an entry in the CSL database that describes a virtual circuit connecting 
your NetWare for SAA server to the downstream PU. Your X.25 package provides a utility to 
configure the target name. 
For more information, see the NetWare for SAA 2.0 Administration Guide for Mainframes and 
Peer Nodes.



Client Access/400
An IBM licensed program consisting of many programs working together to provide a variety 
of AS/400 system functions on your personal computer.



Collection point server
A server that forwards NetView alerts to a NetWare for SAA NetView host or an OS/2 NetView
host.
NetWare for SAA servers are the only servers that can be configured as collection point 
servers. A collection point server does not depend on any intermediate servers for the 
NetView connections. A collection point server can, however, forward alerts and commands 
for end point servers.



Common Programming Interface for Communications (CPI-C) 
A style of API that can be used for requesting LU6.2 communication services. The CPI-C 
interface is standard across all platforms and provides application programs that use it with 
greater portability than APPC, another LU6.2 API. 



Communication Executive
A set of NLM™ applications that provide tracing, security, connectivity, network 
management, and other services to the network. The Communication Executive is the 
foundation for the communication service modules, including NetWare® for SAA*.



Communication Services Configuration (CSCON) Utility
A DOS-based, menu-driven utility that lets you configure NetWare for SAA as discussed in 
the NetWare for SAA 2.0 Administration Guide for Mainframes and Peer Nodes.



Context
The position of a user or group in the NetWare 4.1 Directory tree.



Control point name
The name of the PU2.1 control point (CP) that the NetWare for SAA server is emulating.
NetWare for SAA specifies that the downstream physical unit (PU) name is the same as the 
control point (CP) name for that downstream PU.
A control point is a logical entity providing services that a network needs to manage the 
physical resources under its control and to establish and control the interconnections that 
are necessary to allow network users to communicate. 



Control unit address
A value that corresponds to the ADDR field in the Network Control Program (NCP) 
customization file on the mainframe host. The Synchronous Data Link Control (SDLC) control 
unit address is sometimes referred to as the physical unit (PU) address.



Conversation
The exchange of SNA data between two LUs over a session. The term conversation normally 
applies only to the communication between two transaction programs (TPs) that occurs 
across session between two LU6.2 LUs. Well-defined rules govern how conversations 
between TPs start and stop, which TP "speaks" first, and how data is exchanged. 



Conversation security
A type of security that allows a local transaction program (TP) to require a security user ID 
and password from a partner TP requesting a remote conversation. NetWare for SAA 
validates the security information before it allows the TP initiating the conversation to 
access the local TP and its resources.



Conversation security alias
A name associated with a conversation security user ID and password. The conversation 
security alias is assigned in place of the user ID and password to a local transaction program
(TP) that makes outgoing conversation allocation requests.



Critical server
The NetWare for SAA server that a Hot Standby server monitors and can provide backup 
support for.



CStatus
A DOS-based, menu-driven utility that lets you administer NetWare for SAA as discussed in 
the NetWare for SAA 2.0 Administration Guide for Mainframes and Peer Nodes.



Custom data link
An upstream system connection type that allows products developed by third parties to be 
incorporated into the NetWare for SAA configuration. 



Data link adapter
An add-in adapter for personal computers that can provide direct or remote connections 
from a NetWare server to a remote node.



Dedicated LU
A logical unit (LU) reserved for a particular user or device to ensure that the LU is always 
available to that user or device. Typically, dedicated LUs are created for printers or for 
people on the network who have tasks that require constant and reliable access to the host.



Default Peer PU profile
The physical unit (PU) profile that defines the PU2.1 node and its link connections for 
independent LUs. You can configure only one Default Peer PU profile for a NetWare for SAA 
2.0 server. By default, this profile is used by all transaction programs (TPs) that require an 
independent LU6.2 session. Compare Peer PU profile.



Dependent LU
An LU that is dependent upon a connection to a host and that must be activated and 
controlled by that host's system services control point (SSCP) in order to engage in a 
session.



Dial-up line
A communications circuit users establish by dialing in to or out from a LAN over a 
commercial telephone system.



Directory tree
A hierarchical structure of objects in the NetWare Directory Services™ (NDS™) distributed 
name service. The Directory tree includes container objects that are used to organize the 
network. The structure of the Directory tree can be based on a logical organization of 
objects, and not necessarily on their physical location.



Downstream LU
A logical unit (LU) available on a downstream PU.



Downstream PU
A physical unit (PU) that implements an SNA type 2.0 or 2.1 peripheral node and connects to
a NetWare for SAA server to access a host or SNA boundary function node through NetWare 
for SAA.
NetWare for SAA Administrator lets you define any of the following as downstream PUs for 
NetWare for SAA:

An OS/2 Communications Manager system

A 317x cluster controller

Another NetWare for SAA server or any other device that can connect into IBM SNA 
environments as a node type 2.0 or 2.1



Downstream PU name
A name that identifies the downstream physical unit (PU).
Rather than having one name for the downstream PU and another for the downstream PU's 
control point (CP), NetWare for SAA specifies that the downstream PU name is also the 
control point (CP) name for that downstream PU.



End point server
A server that sends alerts over the NetWare LAN to the collection point server specified in 
the Collection point server name field. That collection point server then forwards the alerts 
to NetView.
Command response messages from an end point server follow the same path as alert 
messages.



Ethernet
A network cable and access protocol scheme originally developed by DEC*, Intel* 
Corporation, and Xerox* Corporation, but now marketed primarily by DEC and 3Com* 
Corporation.



Event log
A file containing information about server event alerts (such as a token ring beaconing 
message). This database file is named by you on the server. The default size of the event log
is 100 KB.



Hot Standby
The NetWare for SAA feature you use to ensure that configured links to a host can continue 
to function if a critical server goes down.



Hot Standby server
A NetWare for SAA server configured to monitor and provide backup support for critical 
servers.



Host PU profile
 A stored configuration, or set of characteristics, that represents the NetWare for SAA 
phusical unit (PU) emulation for the connection to the host.    You create a Host PU profile for 
each host connection you want to establish. 
A Host PU profile 

Includes PU emulation information about the host to which NetWare for SAA is to 
establish connections 

Provides relevant data link adapter information 

Defines defaults for logical unit (LU) attributes



Implicit mode
A NetWare for SAA feature that allows you to configure a mode name beginning with an 
asterisk ( * ) for the partner LU of a local LU when you do not know the actual mode that the 
partner LU will specify. Use of an implicit mode allows NetWare for SAA 2.0 to accept an 
incoming session allocation request from a partner LU that specifies a mode not explicitly 
configured for it on the NetWare for SAA server.



Implicit partner LU
A NetWare for SAA feature that allows you to specify addressing and security information for 
a potential partner LU without explicitly specifying the name of the partner LU that can 
remotely attempt to establish a session with the local LU. 



Independent LU
An LU that is not dependent upon a connection to a host. It allows communication between a
NetWare for SAA server and any node running APPC, whether it is a host such as an AS/400 
minicomputer or another server running NetWare for SAA.



Internetwork Packet Exchange™ (IPX™) protocol
A protocol that allows the exchange of message packets on an internetwork. With IPX, 
applications running on a NetWare workstation can use the NetWare network drivers to 
communicate directly with other workstations, servers, or devices on the internetwork. IPX is
based on Xerox Corporation's Internetwork Packet protocol. See also Sequenced Packet 
Exchange protocol.



Internetwork Packet Exchange/Sequenced Packet Exchange™ (IPX/SPX™) protocol
A protocol shared between the IBM and Macintosh environments.



Local LU
An LU configured for APPC. A local LU is created on the NetWare® for SAA* server to 
accommodate LU6.2 sessions between local transaction programs (TPs) running on NetWare 
for SAA clients, and their assigned partner LUs on the host.



Local service access point (SAP)
The SAP configured on the 802.2 adapter installed on the current NetWare for SAA server.
NetWare for SAA generates this two-digit hexadecimal number starting at 04 hex in 
increments of 4.



Local station address
An address that corresponds to the ADDR field in the Network Control Program (NCP) 
customization file on the mainframe host.



Logical adapter name
A name that identifies a data link adapter. This name associates the Host PU profiles and 
downstream PUs with the appropriate adapter. The logical adapter name also binds the 
device driver, the port number, and the local medium access control (MAC) address.
The logical adapter name has the following characteristics:

The name must be unique for the NetWare for SAA server.

The maximum length of the name is 17 characters.

The name can include any printable characters (that is, alphabetic, numeric, or 
special characters).

Spaces are not allowed in the name.

Alphabetic characters must be all uppercase.



Logical adapter name (for QLLC)
A name that identifies a QLLC data link adapter. This name associates the Host PU profiles 
and downstream PUs with the appropriate adapter. The logical adapter name also binds the 
device driver, the port number, and the local medium access control (MAC) address.
The logical adapter name has the following characteristics:

The name must be unique for the NetWare for SAA server.

The maximum length of the name is 17 characters.

The name can include any printable characters (that is, alphabetic, numeric, or 
special characters).

Spaces are not allowed in the name.

Alphabetic characters must be all uppercase.
If you are using a NetWare MultiProtocol Router Plus™ 3.0 or NetWare Link/X.25™ 3.0 driver 
for the X.25 driver, the QLLC logical adapter name must match the Interface Name field in 
the INETCFG utility's Internetworking Configuration > Network Interface menu.
If you are using NetWare MultiProtocol Router Plus 2.1 or NetWare Link/X.25 2.1 for the X.25 
driver, the QLLC logical adapter name must match the Board Name field in the INETCFG 
utility Internetworking Configuration > Configure LAN and WAN Boards menu.



Logical adapter number
The unique number that NetWare for SAA uses to identify adapters for both dependent and 
independent sessions.
The Logical adapter number field defines the value that a local TP must present to NetWare 
for SAA in order for NetWare for SAA to identify the adapter and create the connection 
between the local TP and the partner LU in the remote node. The Logical adapter number 
field corresponds to the ATTACH_LU verb's PARTNER_LU_ADAPTER_NUMBER parameter. 
Note: LU6.2 transaction programs (TPs) that do not use the Application Subsystem must 
provide the partner LU adapter number to define their communication path with a partner 
LU. 



Logical unit (LU)
A user port into a SNA network. Typically, an LU services an attached device such as a 3278 
terminal or an application. Any LU can communicate with the system services control point 
(SSCP). LU types 0, 1, 2, 3, 4, and 7 can communicate with host applications. LU types 6.0, 
6.1, and 6.2 only can communicate with other LUs of the same type.



LU pool
A collection of logical units (LUs) typically shared by an organizational group. For example, 
you might assign a block of 10 LUs to the accounting department or 20 LUs to the 
engineering department.
An LU pool can include LUs from the same Host PU profile or LUs from different Host PU 
profiles.



LU types
Logical node types defined in SNA architecture. NetWare for SAA supports the following four 
logical unit (LU) types:

LU Type Description
Printer (LU type 1 or 3) Supports printer sessions. Type 1 LUs use 

SNA character string (SCS) data. Type 3 LUs 
are used for 3270 data stream printers.

Display (LU type 2) Supports display sessions. Such LUs use a 
3270 display terminal data stream.

APPC (LU type 6.2) Supports APPC sessions with a host. Such 
LUs use the general data stream (GDS) data
format.

LUx (LU type x) Supports user-defined (LU type 0), display 
(LU type 2), and printer (LU type 1 or 3) 
sessions. Type 0 sessions are for user-
specified data streams and devices that are 
not defined by IBM.



LU type 6.2
An LU for IBM* APPC. LU6.2 implements the Advanced Program-to-Program Communication 
for the Personal Computer (APPC/PC) peer-to-peer networking scheme under SNA.



Mapped LU
A NetWare for SAA server's dependent LU assigned to a downstream PU. The server LU is 
mapped to an LU on the downstream PU. Mapped LUs from different Host PU profiles can be 
assigned to LUs on a single downstream PU.



Maximum print line (MPL)
Another term for lines per page. It is a numeric value that represents the height of the print 
page.



Maximum print position (MPP)
Another term for characters per line. It is a numeric value that represents the width in 
characters of the print line.



Medium access control (MAC) address
The physical address of the logical data link adapter on the downstream physical unit (PU).
In 802.2 terminology, the MAC address is equivalent to the remote node address.



Maximum frame size
A value that specifies the maximum number of bytes to be included in frames sent to the 
host.
The maximum frame size is 9 bytes plus any multiple (from 1 to 16) of 256. Thus, the range 
of frame sizes is from 265 (256 + 9) to 4105 (4096 + 9). 
The following table lists the recommended frame sizes (in bytes) for different link types:

Link Type Recommended Frame Size
Ethernet (802.2) 
Token ring (4 MB/s) 
(802.2)
Token ring (16 MB/s) 
(802.2)
SDLC
QLLC

1289 bytes
2042 bytes
4105 bytes
1033 bytes
1033 bytes

Maximum frame size for Ethernet or token ring (802.2) links
The maximum frame size is 9 bytes plus any multiple (from 1 to 16) of 256. Thus, the range 
of frame sizes is from 265 (256 + 9) to 4105 (4096 + 9). 
The following table lists the recommended frame sizes (in bytes) for different link types:

Link Type Recommended Frame Size
Ethernet
Token ring (4 MB/s) 
Token ring (16 MB/s)

1289 bytes
2042 bytes
4105 bytes

Maximum frame size for SDLC links
The maximum frame size is 9 bytes plus any multiple (from 1 to 16) of 256. Thus, the range 
of frame sizes is from 265 (256 + 9) to 4105 (4096 + 9). 
For SDLC links, the recommended maximum frame size is 1033 bytes.



Maximum frame size for QLLC links
The maximum frame size is 9 bytes plus any multiple (from 1 to 16) of 256. Thus, the range 
of frame sizes is from 265 (256 + 9) to 4105 (4096 + 9). 
For QLLC links, the recommended maximum frame size is 1033 bytes.



Mode
A set of parameters that defines the characteristics, or network properties, of a session 
between two LUs. Each single session or group of parallel sessions has a mode name that 
identifies these characteristics. The network properties grouped under a single mode name 
include, for example, the maximum response/request unit (RU) size and the receive pacing 
window size. 



Model
NetWare for SAA supports configuration for 3270 terminal models 2, 3, 4, and 5. Each model 
number represents a different size of presentation space or size of displayable information. 
The numbers enclosed in parentheses in the Model field refer to the numbers of rows and 
columns in each display.
For more information on the model number and on screen size considerations, see the 
NetWare for SAA 2.0 Planning Guide for Mainframes and Peer Nodes.



Model number
When sending alerts to NetView, the Communication Executive includes the model number 
of the communications server for informational purposes. The Model Number of Server 
Machine field has been defined by IBM and is based upon the IBM model number scheme.



Multipoint local station address
A two-digit hexadecimal address that corresponds to the ADDR field in the Network Control 
Program (NCP) customization file on the mainframe host.



Multipoint SDLC link
A link on which NetWare for SAA can support up to two SDLC drops through a single SDLC 
adapter. These drops can be any combination of Host PU profiles (which emulate host links) 
or peer-to-peer links on the NetWare for SAA server.
The remote node views each Host PU profile and peer-to-peer link on a NetWare for SAA 
server as a secondary station. The network administrator must assign a station address for 
each Application Subsystem partner LU or PU profile configured for SDLC.
Furthermore, transaction programs (TPs) that do not use the services of the Application 
Subsystem can define additional drops with the ATTACH_LU verb. The drops defined in this 
way always function as peer-to-peer links.
In an SDLC multipoint configuration, the remote node must be the primary station. It 
communicates with multiple secondary stations. The secondary stations can communicate 
with the remote node, but not with other secondary stations on the same SDLC link.



Negotiable
An option that defines either a primary or secondary link station role after negotiation to 
NetWare for SAA. If both nodes are negotiable, the node with the greater node ID becomes 
the primary node, and the other node is designated as secondary. If both nodes have the 
same node ID, the two nodes negotiate to determine the node that is to function as the 
primary node.



NetView
An IBM network management product.



NetView alerts
Messages that are sent from NetWare for SAA to IBM NetView. NetView alerts notify the 
NetView operator of conditions or events on the NetWare for SAA server or downstream PUs 
that may require the operator's attention. NetWare for SAA translates selected NetWare 
server error and status messages into alerts.



NetView management
A feature that permits the Communication Executive to send alerts to the IBM NetView 
facility or a system center NET/MASTER* facility using network management vector 
transport (NMVT).
NetView management does not work with IBM Client Access/400.



NetWare Directory Services™
A distributed name service that provides global access to all network resources regardless of
where they are physically located. Users log in to a multiserver network and view the entire 
network as a single information system.



NetWare for SAA
A communication service that provides communication between NetWare LANs and IBM* 
SAA environments.



NetWare for SAA Administrator
The Novell application used to configure NetWare for SAA in a Microsoft Windows 
environment. See also Communication Services Configuration utility.



NetWare for SAA LU6.2
Novell's implementation of the architecture describing the logical unit (LU) type that 
provides for program-to-program communication in an SNA environment. NetWare for SAA 
LU6.2 supports APPC, enabling transaction programs (TPs) on different computers to 
exchange data from portables and workstations to midrange and mainframe hosts. The 
NetWare for SAA LU6.2 protocol stack is split between client and server.



NetWare for SAA Services Manager
A Microsoft Windows application that enables you to monitor and manage multiple NetWare 
for SAA servers on a NetWare LAN or wide area network (WAN) that routes IPX/SPX™ 
protocols. Capabilities include monitoring and controlling NetWare for SAA links and 
dependent and independent logical units (LUs), providing real-time fault management, 
collecting and displaying trend analysis data, and viewing and setting Hot Standby options. 
NetWare for SAA Services Manager runs with the NetWare Management System™ (NMS™) 
product and can be started from an NMS map or the NMS menu bar. 



NetWare Communication Services security
A feature that verifies whether users must be valid NetWare users with permission to use the
session they have requested. 
On a NetWare 4™ server, if security is set to OFF, a GUEST user must exist in the same 
organizational context in which NetWare for SAA is installed.



NetWare HostPrint
A NetWare Loadable Module™ (NLM™) that provides IBM 3270 LU type 1 and type 3 printer 
sessions through the NetWare for SAA server.



NetWare HostPrint Control (HPCONSOL) Utility
A utility that provides information on print sessions. From this utility you can modify certain 
settings for future NetWare HostPrint jobs.



NetWare Loadable Module (NLM)
A program that provides communication services for NetWare and can be loaded onto a 
server without affecting current server operations.



NetWare TN3270
An NLM application included with NetWare for SAA that enables workstations on a TCP/IP 
network to use NetWare for SAA to establish host sessions.



Node ID
A combination of the block ID and the PU ID.
The block ID is a three-digit hexadecimal number specific to an IBM product. The block ID 
matches the IDBLK value in the host definition.
The PU ID is a binary value that, together with the block ID, uniquely identifies a specific 
station within an SNA network.



Nonreturn to zero (NRZ)
A method of encoding information that causes the signal to remain in the same state when 
only 1s (ones) are present. More information can be conveyed in the same time period than 
with a conventional return-to-zero system.
Check your VTAM or Network Control Program (NCP) for the NRZI parameter. If the 
parameter is NRZI=No, select NRZ.



Nonreturn to zero inverted (NRZI)
A method of encoding information that causes the signal to change (positive to negative, or 
negative to positive) each time there is a binary 0 in the data stream. SDLC uses this 
encoding method to ensure a signal change every six bits and guarantee bit 
synchronization, regardless of message length.
Check your VTAM or Network Control Program (NCP) for the NRZI parameter. If the 
parameter is NRZI=Yes, select NRZI.



Nonswitched line
A dedicated leased line.



Offline test
A test in which NetWare for SAA simulates a host connection and sends screen data between
the NetWare for SAA server and the workstation. No active host link or data link adapter is 
required to run a Host PU profile under offline test mode. You can define and run multiple 
Host PU profiles with offline test mode enabled.
A dependent logical unit (LU) in a Host PU profile set to offline test mode can be mapped to a
downstream LU.
This test operates only with type 2 (display session) LUs.
NetWare for SAA includes a Host PU profile named SAA_TEST that is configured to run the 
offline test.



Partner LU
The remote logical unit (LU) of a pair of LUs that hold a session. The LU that initiates the 
session is known as the local LU, whereas the LU at the other end of the session is known as 
the partner LU. 



Partner LU adapter number
A unique value that NetWare for SAA uses to identify the adapter and create a connection 
between a local transaction program (TP) and a partner logical unit (LU) on a remote node.



Partner transaction program (TP)
One of two transaction programs (TPs) at either end of a session that engage in a 
conversation across the session. The terms local and remote are used to differentiate 
between different ends of a conversation and the TP at each end. If a TP is referred to as 
local, its partner TP is said to be the remote TP.



Peer PU profile
The PU profile that defines the PU2.1 node and its link connections for independent LUs.    
Through the NetWare for SAA Administrator you can configure a Default Peer PU profile for a 
NetWare for SAA 2.0 server, or, for backward compatibility with NetWare for SAA 1.3 PU2.1 
profiles. You can define additional Peer PU profiles with unique control point (CP) names and 
specific adapters. 



Peripheral node control point (PNCP)
A logical entity on an Advanced Peer-to-Peer Networking (APPN) or low-entry networking 
(LEN) peripheral node that manages the node's resources. 



Physical unit (PU)
A physical node in a SNA network that supports one or more logical units (LUs).



Physical unit ID (PU ID)
A unique, five-character SNA node ID that together with the block ID identifies a station in an
SNA network. This is the same ID that is assigned to that SNA node on the host.



Pooled LU
A logical unit (LU) assigned to an LU pool, which is a collection of LUs shared by a group of 
users granted access to that pool.



Public LU
A logical unit (LU) that typically has no restrictions and can be used by anyone.



PU ID
A binary value that, together with the block ID, uniquely identifies a specific station within 
an SNA network.



PU profile
A stored configuration, or set of characteristics, that represents the NetWare for SAA 
physical unit (PU) emulation for host or peer nodes.    You create a PU profile for each 
connection you want to establish.    
A PU profile includes information about the PU that NetWare for SAA is to emulate, provides 
relevant data link adapter information to establish the connection, and defines defaults of 
the LUs associated with the PU.    



PU type 2.0
A peripheral node, specifically an IBM 3174 or 3274 cluster controller (or equivalent). A PU 
type 2.0 is not capable of establishing LU-LU sessions without the help of a system services 
control point (SSCP). A PU type 2.0 can communicate only with a PU type 4 or type 5.



PU type 2.1
A peripheral node that incorporates the characteristics of physical unit (PU) type 2.0 with the
additional capability to support one or more LU type 6.2 nodes. A PU type 2.1 can 
communicate with a PU type 4 or 5, or with another PU type 2.1. The major difference 
between a PU type 2.0 and a PU type 2.1 is the latter's ability to support sessions between 
LUs without the control and support of a system services control point (SSCP). A PU type 2.1 
can reside in any programmable device. 



Qualified Logical Link Control (QLLC)
A link-control protocol that is code-independent and transparent to the bit pattern being 
handled. 



Remote node address (for a host)
The address of an 802.2 adapter on a host. This address corresponds to one of the values 
listed in the following table:

Device Corresponding Value
317x controller (token 
ring)

Question 900

317x controller 
(Ethernet)

Line 91

37x5 front end 
processor

LOCADD parameter

937x computer MACCADDR parameter in the PORT 
statement

AS/400 computer ADPTADR parameter
OS/2 computer Destination address

Remote node address (for a downstream PU)
The address of the 802.2 adapter on the downstream physical unit (PU). This address 
corresponds to one of the values listed in the following table:

Device Corresponding Value
317x controller (token 
ring)

Question 900

317x controller 
(Ethernet)

Line 91

AS/400 computer ADPTADR parameter
OS/2 computer Destination address

Remote service access point (SAP) (for a host)
The SAP configured on the 802.2 adapter on the host. This two-digit hexadecimal number 
must be a multiple of 4 and cannot exceed E0 hex.
A SAP is a virtual port on the 802.2 data link adapter.



Remote service access point (SAP) (for a downstream PU)
A SAP configured on the 802.2 adapter installed on the downstream physical unit (PU). This 
is a two-digit hexadecimal number.
A SAP is a virtual port on the 802.2 data link adapter.



Remote station
A host or another SNA node to which the adapter establishes a data link.
The remote station is responsible for ensuring that it does not send more data per packet 
than the local station can receive at one time.



Request-to-send (RTS) signal
The SDLC protocol uses the request-to-send (RTS) signal to prepare a modem for 
transmitting the data.
Holding the RTS signal high all the time provides faster turnaround time between the 
communications server and the remote node.



Run commands
Messages that you send from IBM NetView to a NetWare for SAA server through the NetView 
Network Communications Control Facility (NCCF). NetWare for SAA and NMA for NetView 
translate each NetView command into a NetWare command. After translation, the NetWare 
command is forwarded to the server component that normally executes the command.



Secondary
An option specifying that NetWare for SAA assumes a secondary link station role. A 
secondary link station can exchange data only with a link station whose role is configured as 
primary or negotiable.



Serial number
The serial number of the server.    When sending alerts to NetView, the Communication 
Executive includes this number for informational purposes. The Serial Number of Server 
Machine field has been defined by IBM and is based upon the IBM serial number scheme. 



Service access point (SAP)
A virtual port on a data link adapter installed on a NetWare for SAA server.
NetWare for SAA generates the local SAPs starting at 04 hex in increments of 4. The 
maximum number of local SAPs is 32.



Session
In SNA, a logical connection between two network-addressable units (NAUs)PUs, LUs, or 
system services control points (SSCPs).



SNA network ID
The ID of the entire SNA network.
SNA is a network architecture developed by IBM. It is defined in terms of its functions, 
formats, and protocols. SNA specifies how computer equipment connects and 
communicates. The SNA model includes the application, presentation, data flow control, 
transmission control, path control, data link, and physical functional layers.



Switched line
A standard telephone line usually.



Synchronous Data Link Control (SDLC)
A link-control protocol developed by IBM. It is code-independent and transparent to the bit 
pattern being handled. SDLC uses a single format for both data and control information, 
which combines several control functions in a single transmission, independent of path 
control.



System services control point (SSCP)
The central point of control for an SNA domain. The SSCP is VTAM software that resides on a 
host and monitors and controls network resources. Communications sessions that require an
SSCP's intervention are said to be dependent sessions (or dependent LUs). The SSCP 
converts network names to network addresses.



Systems Application Architecture (SAA)
An application architecture used to develop application programs for the IBM SNA 
environment. Through such conventions as the Common User Access* (CUA*) architecture 
guidelines, Common Programming Interface (CPI) definitions, and Common Communications 
Support (CCS) protocols and conventions, SAA provides a basic structure for developing 
applications that are consistent across systems. 



Systems Network Architecture (SNA)
A network architecture developed by IBM. It is defined in terms of its functions, formats, and 
protocols. SNA specifies how computer equipment connects and communicates. The SNA 
model includes the application, presentation, data flow control, transmission control, path 
control, data link, and physical functional layers.



tn3270
A type of terminal emulation supported by TELNET, a protocol that defines how terminals 
make connections over TCP/IP networks. 
The NetWare TN3270 NLM is included with NetWare for SAA to enable workstations on a 
TCP/IP network to use NetWare for SAA to establish host sessions.



Token ring network
A LAN access mechanism and topology in which a supervisory frame or token is 
passed from station to station in sequential order. To gain access to the network, 
stations must wait for the token to arrive before transmitting data. In a token ring, 
the next logical station receiving the token is the next physical station on the ring.



Trace facility
A feature that lets you start and stop traces using the CSStatus utility or the NetWare for 
SAA Services Manager. A trace is a record of SNA communication data that can be read to 
diagnose communication problems.
Thw trace facility does not track independent LU6.2 sessions. See the NetWare for SAA 2.0 
Administration Guide for Mainframes and Peer Nodes or the NetWare for SAA Services 
Manager Guide for information on using the trace facility.



Trace
A record of SNA communication data that can be read to diagnose a communication 
problem.



Transaction program (TP)
A part of an application program that uses NetWare for SAA LU6.2 communication services 
to communicate with another TP, known as a partner TP, on another system. A single 
application program can contain many TPs. A TP might require services from more than one 
system and in such cases is executed on each system. A TP can initiate or respond 



Transmission Control Protocol/Internet Protocol (TCP/IP)
An industry-standard set of networking protocols that defines rules and formats for the 
transmission and receipt of information. TCP/IP's connection-oriented protocols provide for 
communication independent of any given network organization or computer hardware, 
allowing dissimilar nodes to communicate in a heterogenous environment. These protocols 
also ensure error recovery and the reliable delivery of data. TCP/IP implements a packet-
switched network, over which information is transmitted in small segments called packets 
that are reassembled into files at the destination.



Upstream
The direction of data flow from a dependent logical unit (LU) residing in an SNA node type 
2.0 or 2.1 peripheral node toward an LU residing in a VTAM* SNA node type 5 host.



VTAM LU name
A name that can be used to identify a specific logical unit (LU). This name is optional for LUs 
of type 1 (printer), 2 (display), or 3 (printer). But the name is required for type 6.2 LUs.
NetWare for SAA generates a default VTAM LU name that includes

A six-character prefix, which consists of the first six characters of the physical unit 
(PU) profile name.

A two-character hex number corresponding to the LU address.





What Is NetWare for SAA Administrator?
NetWare for SAA Administrator is a Windows* utility that lets you configure NetWare for SAA.
Use NetWare for SAA Administrator to

Create, edit, or delete resources for NetWare for SAA

Help set up Host, Peer, AS/400, or TN3270 connections

Assign resources to users and limit who has access to them

Configure a NetWare for SAA server to monitor other NetWare for SAA servers and 
provide backup support for those servers



NetWare for SAA Administrator Concepts
To use NetWare for SAA Administrator effectively, you must understand the following 
concepts:

Concept Explanation
NetWare TN3270 
and TCP/IP 
support

NetWare for SAA Administrator allows you to 
support for tn3270 connections.    For details, 
click here.

AS/400* peer 
connections 
support

NetWare for SAA Administrator allows you to 
support peer connections to AS/400 Systems.    
For details, click here.    

Data link adapter
definitions

Data link adapter definitions and    PU profiles 
provide NetWare for SAA with connection 
information.    For details, click here.

Host Connections Host connections are connections between the 
NetWare for SAA server and a mainframe host.  
For details, click here.    

Host PU profiles Host PU profiles define a dependent PU and its 
dependent LUs.    For details, click here.    

Peer Connections Peer connections are connections between to 
PU2.1 nodes.    For details, click here.

Peer PU profiles Peer PU profiles define an independent PU type 
2.1 node and its independent LUs.    For details, 
click here.

Dependent LU 
types

NetWare for SAA supports four of the LU types 
defined for SNA.      For details, click here.

Dependent LU 
categories

NetWare for SAA supports four categories of LU 
assignment: public, dedicated, pooled, and    
mapped (to a downstream LU).      For details, 
click here.

Independent LUs NetWare for SAA supports independent APPC 
LUs that can communicate with partner LUs on 
other PU2.1 nodes.    For details, click here.

Downstream PUs Downstream PUs access hosts through a 
NetWare for SAA server.    For details, click here.



User assignment NetWare for SAA Administrator lets you assign 
users to limit who can use resources you 
configure.    For details, click here.

Hot Standby 
service

The NetWare for SAA Hot Standby feature 
permits a NetWare for SAA server to monitor 
servers critical to the network and provide 
backup support for those servers.    For details, 
click here.

Application 
Subsystem

NetWare for SAA supplies a special Application 
Subsystem to support transaction programs 
(TPs) written to Novell's CPI-C application 
program interface (API).    NetWare for SAA 
Administrator allows you to configure the 
Application Subsystem to support various CPI-C
connections.      For details, click here.

AS/400 Connections    
NetWare for SAA Administrator allows you to configure peer connections between the 
NetWare for SAA server and an AS/400 system running IBM* Client Access/400* software.    
If you are running LU6.2 APPC programs between a NetWare for SAA server and an AS/400 
system, configure the NetWare for SAA server's AS/400 Node resource to support these peer 
connections.

Related Topic

Tasks Required for Configuring AS/400 Connections 



Role of Adapter Definitions and PU Profiles
You provide information about a NetWare for SAA server's connections through the Data link 
adapter definitions.
Each definition describes a logical data link adapter that supports either an APPC connection
or a connection between a NetWare for SAA server and a host or another SNA node on the 
network. 
You can configure NetWare for SAA to use one or more Ethernet, token ring, SDLC, QLLC, or 
customized connection adapters.



Host Connections
A Host connection is a connection from NetWare for SAA to a mainframe host.    In SNA terms
the NetWare for SAA server is an SNA peripheral node type 2.0 or 2.1 physical unit (PU).    As 
a peripheral node, the NetWare for SAA server supports a dependent logical unit (LU) 
session with the help of a host system services control point (SSCP).

Related Topic

Host Connection Confguration Task Summary 



Host PU Profiles    
A Host PU Profile defines a physical unit (PU)    and its dependent LUs.    
For each defined Host PU profile, NetWare for SAA attempts to emulate a PU2.1 peripheral 
node.    If the host defines a PU2.1 node, the NetWare for SAA emulation a    PU2.1 node 
supports both dependent and independent sesions.    If the host defines a PU2.0 node, 
NetWare for SAA emulates a PU2.0 node and suports only dependent sessions.
You can define multiple PU emulations within a NetWare for SAA server by creating and 
configuring multiple Host PU profiles.
A Host PU profile 

Includes information about the PU that NetWare for SAA is emulating in order to 
establish a host or other SNA node connection 

Provides relevant data link adapter information to establish the host connection

Defines default characteristics for each dependent LU

Related Topics

Host Connections 
Host Connection Confguration Task Summary 



Peer Connections
Peer connections are connections between two PU2.1 nodes.    A node type 2.1 can establish 
sessions with other type 2.1 nodes without the mediation of a system services control point 
(SSCP).    You can create peer connections with the Peer PU profile.
A peer connection can be made between the NetWare for SAA server and the following:    

Another NetWare for SAA server

An IBM OS/2 SNA Gateway

An AS/400 system using IBM Client Access/400    

A mainframe system through a 37xx communications controller or 317x cluster 
controller

Related Topics

Peer Connection Configuration Task Summary 
Peer PU Profiles 



Peer PU Profiles    
A Peer PU profile defines a PU2.1 node and its links for independent LUs.    NetWare for SAA 
supports peer connections to support APPC/CPI-C sessions between the NetWare for SAA 
server and other independent LU6.2 LUs.    NetWare for SAA Administrator allows you to 
configure two types of Peer PU profile data:

Default Peer PU Profile Settings
In most cases, you will use the Default Peer PU profile settings that you configured on the
NWSAA Node Information Description page, because the default peer PU profile provides 
the greatest flexibility for adapter selection.    For more information, click here.

Peer PU Profile
In some cases, you may want to configure additional Peer PU profiles: 

To present different server profiles

To support transaction programs (TPs) that specify incorrect or nonexistent adapter 
numbers

To modify earlier PU2.1 profiles (converted from NetWare for SAA 1.3)
For more information, click here

Related Topics

Peer Connections 
Peer Connections Configuration Task Summary



Default Peer PU Profile Settings
The Default Peer PU profile settings that you configure on the NWSAA Node Information 
Descripton page, present the NetWare for SAA server that the Default Peer PU profile resides
on as a single PU with the same control point name to all the partner nodes for which it is 
used. Only one Default Peer PU profile can exist on a NetWare for SAA server. 
When you load NetWare for SAA 2.0, a Default Peer PU profile is automatically in place.    
Only one Default Peer PU profile can reside on a NetWare for SAA server.
The Default Peer PU profile can support all the in-service data link adapters configured and 
installed on the NetWare for SAA server.
Because all the available data link adapters are supported by the Default Peer PU profile 
settings, a transaction program (TP) can establish conversations with multiple partners 
residing in different partner nodes accessed through different data link adapters.    By 
default, this profile is used by all TPs that require an independent LU6.2 session.
In most cases, you will use the Default Peer PU profile settings because they provide the 
greatest flexibility for adapter selection. However, in some few cases you might want to use 
a Peer PU profile. 

Related Topic

Configuring Default Peer PU Profile Settings 



Peer PU Profile Description    
Although you can have only one Default Peer PU profile configuration on a NetWare for SAA 
server, you may have reason to configure one or more additional Peer PU profiles on a 
server 

To present different server profiles
The Peer PU profile feature allows you to present two or more different profiles of the 
NetWare for SAA server to the same partner node. 
For example, you might want to balance the session load across two data links to the 
same partner node and present the NetWare for SAA server to that node using two 
separate control point names. For this purpose, you can configure one or more Peer PU 
profiles, each of which specifies the name of the NetWare for SAA server adapter to be 
used for the data link connection. 

To support TPs that specify incorrect adapter numbers
You might want to use a Peer PU profile to enable NetWare for SAA to tolerate an 
incorrect adapter number specification from the ATTACH_LU verb in a transaction 
program (TP) . The Peer PU profile configuration includes the logical adapter name, which
represents the adapter type and number. 
If the TP specifies the correct adapter type but an adapter number that does not exist, 
NetWare for SAA can take the correct adapter number from the Peer PU profile but not 
from the Default Peer PU profile. 
If you use the Default Peer PU profile settings, NetWare for SAA will attempt to select the 
correct adapter, but it cannot guarantee a correct selection because the Default Peer PU 
profile settings do not contain the adapter number. 

To modify earlier PU2.1 profiles
You can also use NetWare for SAA Administrator to modify PU2.1 profiles created for 
NetWare for SAA 1.3 that were converted for use with NetWare for SAA 2.0. When you 
install or upgrade NetWare for SAA 2.0, it automatically converts PU2.1 profiles created 
for NetWare for SAA 1.3 into NetWare for SAA 2.0 Peer PU profiles. 

Related Topics

Peer Connections
Peer Connection Configuration Task Summary 



Dependent LU Types
LUs defined through a Host PU profile are dependent LUs.    Dependent LUs are dependent 
upon connection to a VTAM host.    NetWare for SAA Administrator allows you to display and 
edit dependent LUs by browsing the Host PU profile that defines them.
NetWare for SAA Administrator supports four logical unit (LU) types. The supported 
dependent LU types include:

Dependent LU Type Description
Printer (LU type 1 or 3) Supports printer sessions. Type 1 LUs use 

SNA character string (SCS) data. Type 3 LUs 
are used for 3270 data stream printers.

Display (LU type 2) Supports display sessions. Such LUs use a 
3270 display terminal data stream.

APPC (LU type 6.2) Supports APPC sessions with a host. Such 
LUs use the general data stream (GDS) data
format. APPC LUs can be dependent or 
independent.    For more information 

LUx (LU type x) Supports user-defined (LU type 0), display 
(LU type 2), and printer (LU type 1 or 3) 
sessions. (Type 0 sessions are for user-
specified data streams and devices that are 
not defined by IBM requirements.)



Dependent LU Categories
LUs defined through a Host PU profile are dependent LUs.    Dependent LUs are dependent 
upon connection to a VTAM host.    NetWare for SAA Administrator allows you to display and 
edit dependent LUs by browsing the Host PU profile that defines them.
NetWare for SAA supports the following categories of Logical unit (LU)    assignment:

Dependent LU 
Category Explanation
Public LU A dependent LU that can be used by anyone.

Dedicated LU A dependent LU reserved for a particular user or 
device to ensure its constant availability to that user 
or device. Typically, dedicated LUs are created for 
printers or for people on the network who have tasks
that require constant and reliable access to the host.

Pooled LU A dependent LU assigned to an LU pool. You might 
assign a block of 10 LUs to the accounting 
department or 20 LUs to the engineering 
department.    Any user assigned to that pool can 
access any LU in the pool.

Mapped LU A dependent LU assigned to a downstream LU that 
resides on a downstream PU.
You assign a NetWare for SAA server's LUs to 
downstream PUs by mapping the LU to a 
downstream LU. Mapping an LU establishes a 
relationship between the mapped LU and the 
downstream LU. This relationship permits a 
downstream PU's users to access host sessions 
through the NetWare for SAA server.

Application 
Subsystem LU

A dependent APPC LU that is assigned to the 
NetWare for SAA 2.0 Application Subsystem. 
 

Related Topics

Changing an LU's Category 
Configuring a Dedicated LU 
Configuring a Mapped LU 
Configuring a Pooled LU 
Configuring a Public LU 



Independent LUs
An independent LU is an APPC LU of type 6.2 that you can create for APPC peer 
communication with independent LUs on other PU2.1 nodes.
NetWare for SAA Administrator allows you to create independent Local LUs assigned to the 
Application Subsystem. 



Role of Downstream PUs
A downstream PU is any PU that implements an SNA node type 2.0 or 2.1 and connects to a 
NetWare for SAA server to access a host    through NetWare for SAA.
NetWare for SAA Administrator lets you configure NetWare for SAA to define any of the 
following as downstream PUs:

OS/2* Communications Manager system

317x cluster controller

Another NetWare for SAA server or any other device that can connect into IBM SNA 
environments as a node type 2.0 or 2.1
When NetWare for SAA establishes host sessions for a downstream PU, the downstream PU 
accesses LUs available on a host through a NetWare for SAA server. The NetWare for SAA 
server is transparent to downstream PUs, so they detect only the host. Likewise, the 
downstream PUs are transparent to the host so it detects only the NetWare for SAA server.

When configured as a workstation, the OS/2 Communications Manager can use the 
assigned dependent LUs to maintain up to five communications sessions with the host.

When configured as an SNA gateway, the OS/2 Communications Manager can 
distribute up to 254 LUs to other workstations.
To permit this type of access, you create a downstream PU definition and assign or "map" 
LUs from the Host PU profiles on the NetWare for SAA server to downstream LUs on the 
downstream PU. The relationship thus established enables the downstream PU's users to 
access host sessions.

Related Topic

Before you assign LUs to a downstream PU 
Mapping LUs to Downstream LUs 



Hot Standby Service 
You can configure a NetWare for SAA server to provide Hot Standby service to other NetWare
for SAA servers on the network. Setting up Hot Standby service ensures that configured links
to a host can continue to function if a critical server goes down. 
NetWare for SAA servers that provide Hot Standby service are Hot Standby servers. NetWare
for SAA servers that receive Hot Standby service are critical servers.
When configuring a NetWare for SAA server to provide Hot Standby service, you set up a Hot
Standby configuration for each critical server you want monitored, specifying the Host PU 
profiles you want activated on the Hot Standby server if the critical server goes down.

Hot Standby Activation

The Host PU profiles assigned to Hot Standby are activated if any of the following events 
occur on the critical server that the profiles provide backup support for:

The critical server fails.

A network administrator unloads NetWare for SAA.

A network administrator issues the CSDOWN command, which unloads NetWare for 
SAA and the Communication Executive.

No Hot Standby Activation

Host PU profiles assigned to Hot Standby are not activated if a configured critical server is 
unavailable when NetWare for SAA is started on the Hot Standby server.
Note: After you configure a Host PU profile and assign it to Hot Standby on the Hot Standby 

server, you must unload and reload NetWare for SAA on the Hot Standby server for 
the assignment to take effect.

Related Topic

Configuring a Server for Hot Standby 



Limiting Access to LUs
NetWare for SAA lets you limit who can access the following:

Dedicated LUs.

Pooled LUs.

Mapped LUs assigned to a downstream PU that    is running OS/2 and is available on 
an Ethernet or token ring connection. You cannot limit access to the LUs assigned to 
downstream PUs available on a QLLC or custom connection.
You can assign users to dedicated LUs, LU pools, or downstream PUs. Users assigned to a 
dedicated LU can access that LU. Users assigned to an LU pool or downstream PU can access
any available LU in the pool or downstream PU.

Related Topic

Assigning Users to Resources 



Host Connection Configuration Task Summary
A host connection is a connection from NetWare for SAA to a mainframe host.    In SNA terms
the NetWare for SAA server is an SNA peripheral node type 2.0 or 2.1 physical unit (PU).    A 
peripheral node can support a dependent logical unit (LU) session only with the help a host 
system services control point (SSCP).
To configure for host connections, complete the following configuration sequence.
1. Plan your NetWare for SAA configuration as discussed in the NetWare for SAA 2.0 

Planning Guide for Mainframes and Peer Nodes.

2. Configure the Communication Executive.    
For details click here.

3. Configure the SNA network ID.    
For details, click here.

4. Configure the data link adapters for the NetWare for SAA server. 

For details on configuring Ethernet or token ring data link adapters, click here.

For details on configuring SDLC data link adapters, click here.

For details on configuring QLLC data link adapters, click here.

For details on configuring custom data link adapters, click here.

5. Configure the Host PU profiles you need.    
For details, click here.

6. (Optional) Assign LU resources to customize the LUs for your site--LU pools,
dedicated LUs, and downstream LUs. 

For details on assigning LUs to LU pools, click here.

For details on assigning LUs to dedicated LUs, click here.

For details on configuring a dedicated LU, click here.

For details on assigning LUs downstream, click here.
7. (Optional) Limit user access to your LU pools, dedicated LUs, and downstream 

LUs.

For details on assigning users on a NetWare 4.1 server, click here.

For details on assigning users on a NetWare 3.12 server, click here.

8. (Optional) Configure Hot Standby.    
This step is required only if you want to configure a NetWare for SAA server as a Hot 



Standby server.
For details, click here.

9. (Optional) Configure NetWare TN3270.     
This step is required only if you have NetWare users on a TCP/IP network accessing a 

host through NetWare for SAA.
For details, click here.

Related Topics

Host Connections 
Host PU Profiles 
Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 
Tasks You Sometimes Do 



Peer Connection Configuration Task Summary
Peer connections are connections between two PU2.1 nodes.    A node type 2.1 can establish 
sessions with other type 2.1 nodes without the mediation of a system services control point 
(SSCP).    You can create peer connections with the Peer PU profile.
A peer connection can be made between the NetWare for SAA server and the following:    

Another NetWare for SAA server An AS/400 system using IBM 
Client Access/400

An IBM OS/2 SNA Gateway A mainframe system through a 
37xx communications controller or 317x
cluster controller

To configure for peer connections, complete the following configuration sequence:
1. Plan your NetWare for SAA configuration as discussed in the NetWare for SAA 2.0 

Planning Guide for Mainframes and Peer Nodes.

2. Configure the Communication Executive.    
For details click here.

3. Configure the SNA network ID and the default peer PU profile settings.   

For details, click here.

4. Configure the data link adapters for the NetWare for SAA server.    

For details on configuring Ethernet or token ring data link adapters, click here.

For details on configuring SDLC data link adapters, click here.

For details on configuring QLLC data link adapters, click here.

5. If necessary, configure additional, adapter-specific peer PU profiles.  
For details, click here.

6. Configure the APPC LU node definition of the NetWare for SAA Application 

Subsystem.        

    

For details on configuring a dependent local LU for the Application Subsystem, click 
here.

For details on configuring an independent local LU for the Application Subsystem, 
click here.



For details on configuring a partner LU    for the Application Subsystem, click here.

For details on configuring a conversation mode for the Application Subsystem, click 
here.
7. If you want to enable local TPs for remote initiation from partner TPs, 

configure the Attach Manager components of the NetWare for SAA Application 

Subsystem.        

For details on configuring a    local transaction program (TP) for the Attach Manager 
module of the Application Subsystem, click here.

For details on configuring conversation security aliases for the Attach Manager 
module of the    Application Subsystem, click here.

Related Topics

Peer Connections 
Peer PU Profile Description 
Host Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 
Tasks You Sometimes Do 



AS/400 Systems Connections Configuration Task Summary
NetWare for SAA Administrator allows you to configure peer connections between the 
NetWare for SAA server and an AS/400 system running IBM Client Access/400 software.    If 
you are running LU6.2 APPC programs between a NetWare for SAA server and an AS/400 
system, configure for peer connections.
To configure AS/400 peer connections, carry out the following tasks:
1. Plan your NetWare for SAA configuration as discussed in the NetWare for SAA 2.0 

Planning Guide for AS/400.
2. Create line, controller, and device descriptions on the AS/400 system to 

accomodate NetWare for SAA    as discussed in the NetWare for SAA 2.0 Planning and 
Administration Guide for AS/400.

3. Customize the AUTOEXEC.NCF and STARTUP.NCF files on the NetWare server to 
accomodate NetWare for SAA    as discussed in the NetWare for SAA 2.0 Planning Guide 
for AS/400.

4. Configure the Communication Executive.    
Use the NetWare for SAA Administrator. For details click here.

5. Configure the SNA network ID and default Peer PU profile.    
Use the NetWare for SAA Administrator.    For details click here.

6. Configure the data link adapters for the NetWare for SAA server.    
Use the NetWare for SAA Administrator.

For details on configuring Ethernet or token ring data link adapters, click here.

For details on configuring SDLC data link adapters, click here.

For details on configuring QLLC data link adapters, click here.

For details on configuring custom data link adapters, click here.

7. Configure the AS/400 system information.    
Use the NetWare for SAA Administrator.    For details, click here.

8. Configure the AS/400 user information.  
Use the NetWare for SAA Administrator.    For details, click here.

9. Configure either the NetWare AS/400 Router for DOS or the NetSoft* 
NS/Router.

For details on these procedures--and on installing IBM Client Access/400 software for 
either DOS or Windows--see the NetWare for SAA 2.0 Planning and Administration Guide for 
AS/400.

Related Topics

AS/400 Connections 



Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
Tasks You Sometimes Do 



Tasks You Sometimes Do
The following NetWare for SAA configuration tasks are required under particular conditions. 
Perform only those tasks that are necessary for your network's specific needs.

Task Description
Edit Management 
options

If you want to change the default values for the 
NetWare for SAA server's network management 
functions, edit the Management Options page of 
the Communication Executive.
For details click here.

Edit tn3270 client 
support

If you want to configure host session support for 
tn3270 clients, edit the TN3270 page of the 
NWSAA Node.
For details click here.

Edit the LUs If you need to change the characteristics of the LUs
in a Host PU profile, edit the LUs.
When creating a Host PU profile, you define 
characteristics that apply to all the LUs associated 
with the Host PU profile. Although this set of 
characteristics might suffice, you will likely need to
edit individual LUs to match the configuration 
defined on the host.
For details on configuring a specific category of LU,
click the appropriate item in the following list:

Dedicated LU 
Mapped LU 
Pooled LU 
Public LU

Define the downstream
PU

If you want NetWare for SAA to provide users of a 
downstream PU access to the host, define that 
downstream PU. For details on this task, click here.
Then map LUs on a defined Host PU profile to the    
downstream LUs as described in the next item.

Map LUs downstream After defining a downstream PU, map LUs in a 
defined Host PU profile to the downstream LUs. For 
details on this task, click here.

Assign LUs to pools If you need to share certain LUs among a set of 
users or groups, assign those LUs to an LU pool. 
You can use either of the following methods:

Drag the LUs to the LU pool. For details on 
this task, click here.

Use a dialog box to add the LUs. For details 
on this task, click here.

Configure Hot Standby 
support

If you want the current server to monitor and 
provide backup support to critical servers with host



connections, configure the current server for Hot 
Standby. For details on this task, click here.

Assign users to 
resources

If you need to limit access to a dedicated LU, 
downstream PU, or LU pool, assign specific users to
that resource. For details on this task, click here.

Related Topics

Host Connection Configuration Task Summary 
Peer Connection Configuration Task Summary 
AS/400 Systems Connections Configuration Task Summary 



View Window
A view window provides a graphical listing of NetWare for SAA servers and resources. 
NetWare for SAA Administrator uses icons to represent servers and resources in view 
windows. For details on a specific element of view windows, click that element in the figure.

Related Topics

NWSAA Administrator Icons 
Commands 



Dialog Books
NetWare for SAA Administrator dialog books let you configure and assign resources. Any 
resource that can be configured on a NetWare for SAA server has its own dialog book. 
NetWare for SAA Administrator opens a resource's dialog book whenever you are creating or 
modifying that resource. A dialog book can consist of one or more configuration screens--or 
"pages." To edit a specific page, you select that page's icon in the page area.
For details on a specific element of a dialog book, click that element in the following figure.



NetWare TN3270
NetWare for SAA Administrator allows you to configure support for tn3270 connections. 
tn3270 is a type of terminal emulation supported by TELNET, a protocol that defines how 
terminals make connections over TCP/IP networks. Software for tn3270 clients is available 
commerically--Novells LAN WorkPlace® for DOS, for example--and as publicly available 
software, or freeware. For configuration information click here.
The NetWare TN3270 NLM is included with NetWare for SAA to enable workstations on a 
TCP/IP network to use NetWare for SAA to establish host sessions.
Each workstation must run tn3270 client software. Host sessions can be established when 
the NetWare for SAA server is running NetWare TN3270 and NetWare TCP/IP Transport. Users
on these workstations can use NetWare HostPrint™ and NetWare FLeX/IP™ software to 
receive printed output.



Application Subsystem
NetWare for SAA 2.0 provides an Application Subsystem for use by transaction programs 
(TPs) written to the NetWare for SAA CPI-C interface.    
Developers of CPI-C TPs do not need to include their own application subsystem along with 
their TPs.    Instead, NetWare for SAA Administrator allows you to configure the NetWare SAA 
Application Subsytem to define the local LU, the partner LU, the modes, and link media 
information.    
The NetWare for SAA Application Subsystem also includes an Attach Manager module that 
supports local TPs that accept conversations started by partner TPs.    NetWare for SAA 
Administrator allows you to configure local TPs for the Attach Manager and to specify 
conversation security aliases and passwords for these partner-initiated conversations.
The NetWare for SAA Application Subsystem is used to support conversations started by 
either a local TP or a partner TP.
To use the NetWare for SAA Application Subsystem for CPI-C TPs, you must configure this 
information on the NetWare for SAA server.    You must also configure related information on 
the clients running the CPI-C TPs.
The following components, which you must configure on the server, make up the Application
Subsystem information used by both locally initiated and remotely initiated conversations:

Component Function

Local LUs You must configure all local LUs to be 
used by any clients for peer connections
for the Application Subsystem.    

For details on configuring a 
dependent local LU, click here.

For details on configuring an 
independent local LU, click here.

Partner LUs For each local LU, you configure a set of 
partner LUs that can communicate with 
the local LU.    
For details on this task, click here.

Modes For each partner LU, you configure a set 
of modes that can be used to define the 
transmission and other characteristics 
for sessions between that partner LU 
and the local LU.    
For details on this task, click here.

Local TPs As part of the local transaction program 
configuration, you name and configure    
the local TP that will accept remotely 



initiated conversations.    
For details on this task, click here.

Conversation security
user ID and password

If you indicate that a local TP requires 
conversation that a local TP requires 
conversation security, you can configure
pairs of security user IDs and passwords
and assign them to the local TP 
configuration on the server.    To control 
access to the local TP, the server Attach 
Manager will check the security user ID 
and password a parnter TP provides 
against the list for the local TP.    
For details on this task, click here.



View window title bar
Indicates whether the view window is listing all the NetWare for SAA servers on the network 
or a single server. If the window lists a single server, the title bar includes the name of that 
server.



Left pane of a view window

Selecting a resource in the left pane displays its summary information.

Double-clicking the following resources expands and collapses them:

A NetWare for SAA server

The Host PU Profiles group or LU Pools group resource

Selecting a resource and then a menu command lets you do the following:

View or edit details of a resource

Delete a resource

Copy a PU profile

Assign users to a resource



Right pane of a view window

Double-clicking a resource in the right pane allows you to view or edit its detailed 
information.

Selecting a resource and then a menu command lets you do the following:

Delete a resource

Copy a PU profile

Assign users to a resource



Scroll bars
A view window includes scroll bars when NetWare for SAA Administrator displays more icons 
than those currently in view. For details on using scroll bars, see your Windows 
documentation.



Dialog book title bar
Names the dialog book and identifies the NetWare for SAA server associated with that dialog
book.



Page area
Displays the dialog book's different pages as you select page icons.



Page icon
Identifies the current page and, in a multiple-page dialog book, lets you select the page you 
want to display.
In a multiple-page dialog book, each page icon opens a different page. Dialog book pages 
are displayed one at a time. Click a page's icon to switch to that page in the dialog book. 
Because each page lets you perform a specific task, you only need go to those pages that let
you complete what you want to do.
Your current page is highlighted. NetWare for SAA Administrator turns down and darkens a 
page icon's upper right corner to indicate an unsaved modified page.



OK and Cancel command buttons
Issue a command.
A dialog book's OK and Cancel command buttons affect the entire dialog book, not just 
individual pages.

Click OK to save changes entered in any of the dialog book's pages. After you save 
your changes, NetWare for SAA Administrator closes the dialog book.

Note: Do not click OK until you are finished working with all of a dialog book's pages and
are ready to close that book. Otherwise, you will have to reopen the dialog book 
to work in the other pages.

Click Cancel to close the dialog book without saving changes made to any of that 
book's pages.

Note: If you decide to keep only some of your changes, do not click Cancel because you 
will lose all the changes you made, including those you want to keep. If you 
accidentally click Cancel, you must reopen the dialog book and reenter the 
changes you want to keep.



Table
Displays LU information.
Some resources that have multiple LUs assigned to them display their assigned LU 
information in tables.    You can change the table display as follows:

To sort the table items by another title, click the column title by which you want the 
table items sorted.

To change the width of a column, click the left or right border of the column title and 
drag it to display the width you want.

To    change the position of column within a table, click the column title and drag it to 
the position you want. 




